Universal Desktop Linux
v5
User Manual
Contents

1. About this document ............................................................................................................. 9
   1.1. Important Information .................................................................................................. 10
   1.2. Formatting and its Meanings ....................................................................................... 10
2. IGEL Universal Desktop Firmware ....................................................................................... 12
   2.1. Supported formats and codecs .................................................................................. 13
3. Quick Installation .................................................................................................................. 14
4. The IGEL Linux desktop ...................................................................................................... 15
   4.1. Application Launcher .................................................................................................. 16
       4.1.1. Information ........................................................................................................ 17
       4.1.2. Sessions ............................................................................................................. 17
       4.1.3. System ............................................................................................................... 17
       4.1.4. License .............................................................................................................. 18
       4.1.5. Network Information ......................................................................................... 18
       4.1.6. Shutting Down and Restarting a Device ............................................................. 18
5. Boot Procedure ..................................................................................................................... 19
   5.1. Boot Menu .................................................................................................................. 19
       5.1.1. Quiet Boot .......................................................................................................... 19
       5.1.2. Verbose Boot ..................................................................................................... 19
       5.1.3. Emergency Boot ............................................................................................... 19
       5.1.4. Failsafe Boot - CRC check .............................................................................. 20
       5.1.5. Reset to factory defaults ................................................................................... 20
   5.2. Network Integration ..................................................................................................... 21
   5.3. X-Server ..................................................................................................................... 21
6. Setup Application ................................................................................................................. 22
   6.1. Starting the Setup ...................................................................................................... 22
   6.2. Ending the Setup ....................................................................................................... 22
   6.3. Setup Areas .............................................................................................................. 23
   6.4. Enable setup pages for users .................................................................................... 24
   6.5. Quick setup ............................................................................................................... 25
   6.6. Setup Search ............................................................................................................. 25
7. Sessions ............................................................................................................................... 26
   7.1. Copy Session ............................................................................................................. 26
   7.2. Desktop Integration .................................................................................................... 27
   7.3. Citrix XenDesktop / XenApp ...................................................................................... 27
       7.3.1. Citrix Receiver Selection ................................................................................... 27
       7.3.2. Citrix Access Gateway ...................................................................................... 54
   7.4. RDP Global ............................................................................................................... 55
       7.4.1. Gateway ............................................................................................................ 55
       7.4.2. Local Logon ...................................................................................................... 56
7.5.1. Server ................................................................. 70
7.5.2. Window ............................................................... 71
7.5.3. Display, Keyboard and Mapping ................................. 72
7.5.4. Performance and Options ......................................... 72

7.6. Remote Desktop Web Access ........................................ 72
7.6.1. Configure Access to RD Connection ............................ 73
7.6.2. Connections ....................................................... 76
7.6.3. Authentication ..................................................... 76
7.6.4. Appearance ......................................................... 77
7.6.5. Logoff / Desktop Integration ...................................... 77

7.7. Horizon Client Global ................................................ 78
7.7.1. Server Options ..................................................... 78
7.7.2. Local Logon ......................................................... 79
7.7.3. USB redirection .................................................... 80
7.7.4. Multimedia ......................................................... 81
7.7.5. Performance ........................................................ 82
7.7.6. Smartcard .......................................................... 82

7.8. Horizon Client session ............................................... 82
7.8.1. Connection settings ............................................... 82
7.8.2. Window ............................................................. 83
7.8.3. Mouse and keyboard ............................................. 84
7.8.4. Mapping ........................................................... 84
7.8.5. Performance ........................................................ 84
7.8.6. Options ............................................................. 85
7.8.7. Multimedia ........................................................ 85
7.8.8. Proxy ................................................................. 85

7.9. Workspace Client and AppPortal ................................. 86

7.10. Appliance Mode ....................................................... 87
7.10.1. VMware Horizon ................................................ 87
7.10.2. Citrix XenDesktop ............................................... 88
7.10.3. Citrix Self-Service .............................................. 88
7.10.4. RHEV/Spice .................................................... 89
7.10.5. Imprivata ......................................................... 89
7.10.6. RDP Multipoint Server ........................................ 90
7.10.7. Caradigm ........................................................ 90
7.10.8. XDMCP ........................................................................................................... 92
7.11. Caradigm ............................................................................................................. 92
  7.11.1. Verbindung ...................................................................................................... 94
  7.11.2. Optionen ......................................................................................................... 95
  7.11.3. Desktop Integration ........................................................................................ 96
7.12. Leostream ............................................................................................................ 97
7.13. AppliDis ............................................................................................................. 98
7.15. NoMachine NX ................................................................................................. 99
7.16. X Session .......................................................................................................... 99
7.17. Parallels Client Global ........................................................................................ 99
  7.17.1. Keyboard ....................................................................................................... 99
7.18. Parallels Client.................................................................................................... 100
  7.18.1. Connection ..................................................................................................... 101
  7.18.2. Local Resources ............................................................................................ 102
  7.18.3. Experience ..................................................................................................... 103
  7.18.4. Network ......................................................................................................... 104
  7.18.5. Advanced ...................................................................................................... 105
7.19. PowerTerm WebConnect .................................................................................... 106
7.20. PowerTerm Terminal Emulation ........................................................................ 106
  7.20.1. PowerTerm selection ...................................................................................... 107
7.21. IBM iSeries Access ............................................................................................ 108
7.22. IBM iAccess Client .............................................................................................. 108
7.23. ThinLinc .............................................................................................................. 108
  7.23.1. ThinLinc Global ............................................................................................ 109
  7.23.2. ThinLinc Sessions ......................................................................................... 111
7.24. SSH Session ....................................................................................................... 115
7.25. VNC Viewer ...................................................................................................... 116
7.26. VERDE session .................................................................................................. 116
7.27. Browser .............................................................................................................. 116
  7.27.1. Browser Global ............................................................................................. 116
  7.27.2. Browser Sessions .......................................................................................... 126
  7.27.3. Browser Plug-ins ......................................................................................... 134
7.28. Media Player ...................................................................................................... 135
  7.28.1. Media Player Global ...................................................................................... 136
  7.28.2. Media Player Sessions .................................................................................. 138
7.29. Java Web Start Session ....................................................................................... 138
  7.29.1. Java Web Start ............................................................................................... 139
7.30. VoIP Client ......................................................................................................... 140
  7.30.1. User Account ................................................................................................. 142
  7.30.2. Audio ............................................................................................................. 142
  7.30.3. SIP .................................................................................................................. 143
8. Accessories ........................................................................ 146

8.1. ICA Connection Center .................................................. 146
8.2. Local Terminal .............................................................. 146
8.3. Change Smartcard Password ......................................... 146
8.4. Setup ........................................................................ 146
8.5. User Page Permissions .................................................. 147
8.6. Display switch .............................................................. 147
  8.6.1. Options .................................................................. 149
  8.6.2. Using "Display Switch" function ............................... 150

8.7. Application Launcher ...................................................... 152
8.8. Sound Preferences ........................................................ 154
  8.8.1. Options .................................................................. 155
  8.8.2. Using "Audio Settings" Function ............................... 157
8.9. System Log Viewer ........................................................ 157
8.10. UMS Registration ........................................................ 158
8.11. Touchscreen Calibration .............................................. 159
8.12. Task Manager ............................................................. 159
  8.12.1. Using the Task Manager ....................................... 160

8.13. Screenshot Tool ........................................................... 161
  8.13.1. Taking a screenshot ............................................... 162

8.14. On-Screen Keyboard ...................................................... 163
8.15. Bluetooth Tool ............................................................ 164
8.16. Java Control Panel ........................................................ 165
8.17. Monitor Calibration ...................................................... 166

8.18. Commands .................................................................. 166
8.19. Network Tools .............................................................. 166
  8.19.1. Device Information ................................................ 166
  8.19.2. Ping ................................................................... 167
  8.19.3. Netstat ................................................................. 167
  8.19.4. Traceroute ............................................................ 167
  8.19.5. Look-up ............................................................... 168

8.20. System Information ....................................................... 168
8.21. Disk Utility ................................................................. 168

8.22. Safely Remove Hardware ........................................... 169
  8.22.1. Using "Safely Remove Hardware" Function ................. 170

8.23. Firmware Update ......................................................... 170
8.24. Smartcard Personalization ........................................... 171
8.25. Identify Monitors ........................................................ 171
8.26. Upgrade License

8.27. Webcam Information

8.28. Image viewer

9. User Interface

9.1. Display

9.1.1. Power Options

9.1.2. Access control

9.1.3. Gamma correction

9.1.4. Options

9.1.5. Universal MultiDisplay

9.2. Desktop

9.2.1. Background

9.2.2. Taskbar

9.2.3. Taskbar background

9.2.4. Taskbar items

9.2.5. Pager

9.2.6. Start menu

9.2.7. In-Session Control Bar

9.3. Language

9.4. Screen Saver and Screen Lock

9.4.1. Options

9.4.2. Taskbar

9.4.3. Screensaver

9.5. Input

9.5.1. Keyboard

9.5.2. Additional keyboard layouts

9.5.3. Mouse

9.5.4. Touchscreen

9.5.5. Touchpad

9.5.6. SCIM Input Methods Platform

9.5.7. Signature Pad

9.6. Hotkeys

9.6.1. Commands

9.7. Font Services

9.7.1. XC Font Service

9.7.2. NFS Font Service

10. Network

10.1. Mobile Broadband Network

10.2. LAN Interfaces

10.2.1. Individual Interface

10.2.2. Wireless

10.3. DHCP Options
10.4. Virtual Private Network - VPN ................................................................. 214
  10.4.1. PPTP ................................................................................................. 215
  10.4.2. OpenVPN ......................................................................................... 215
  10.4.3. NCP ................................................................................................. 216
  10.4.4. genucard ......................................................................................... 216
10.5. Simple Certificate Enrollment Protocol - SCEP ........................................ 219
  10.5.1. Certificate ......................................................................................... 220
  10.5.2. Certification Authority ................................................................. 220
  10.5.3. SCEP .............................................................................................. 220
  10.5.4. Checking the Client Certificate .................................................. 221
  10.5.5. Example ......................................................................................... 221
10.6. Routing ............................................................................................... 221
10.7. Hosts 222
10.8. Network Drives .................................................................................. 222
  10.8.1. NFS ............................................................................................... 222
  10.8.2. Windows Drive - SMB .............................................................. 223
10.9. Proxy 225

11. Devices ................................................................................................... 226
  11.1. Printers .............................................................................................. 226
    11.1.1. CUPS - Common UNIX Printing System .................................... 226
    11.1.2. LPD - Line Printer Daemon ...................................................... 228
    11.1.3. TCP/IP ......................................................................................... 228
    11.1.4. ThinPrint .................................................................................... 229
  11.2. USB Storage Devices ........................................................................ 230
    11.2.1. Hotplug storage devices .......................................................... 230
    11.2.2. Automount Devices .................................................................. 231
  11.3. Bluetooth ......................................................................................... 232
  11.4. USB access control .......................................................................... 232

12. Security ................................................................................................... 234
  12.1. Password ......................................................................................... 234
  12.2. Login Options .................................................................................. 235
    12.2.1. IGEL Smartcard ........................................................................ 235
    12.2.2. AD/Kerberos ............................................................................. 238
  12.3. AD/Kerberos Configuration .............................................................. 238
    12.3.1. Realm 1-4 .................................................................................. 239
    12.3.2. Domain-Realm Mapping ......................................................... 239
  12.4. Smartcard ........................................................................................ 240
    12.4.1. Services ..................................................................................... 240
    12.4.2. Middleware .............................................................................. 241

13. System Settings ...................................................................................... 242
  13.1. Time and Date .................................................................................. 242
13.2. Update 243
13.3. Buddy Update ........................................................................................................... 244
13.4. Remote management .................................................................................................. 244
  13.4.1. Legacy 'setup.ini' transfer .................................................................................. 245
  13.4.2. Logging .............................................................................................................. 246
13.5. Remote Access ........................................................................................................... 246
  13.5.1. RSH Access ....................................................................................................... 246
  13.5.2. SSH Access ....................................................................................................... 247
  13.5.3. Shadowing ........................................................................................................ 248
  13.5.4. Secure Terminal ............................................................................................... 249
13.6. Power Options .......................................................................................................... 249
  13.6.1. System ............................................................................................................... 249
  13.6.2. Battery ............................................................................................................... 250
  13.6.3. Display ............................................................................................................. 251
  13.6.4. Shutdown ......................................................................................................... 252
13.7. Firmware Customization ......................................................................................... 252
  13.7.1. Custom partition ............................................................................................. 253
  13.7.2. Custom Application ......................................................................................... 257
  13.7.3. Custom Commands ......................................................................................... 257
  13.7.4. Corporate design ............................................................................................ 260
  13.7.5. Environment variables ..................................................................................... 263
  13.7.6. Features ........................................................................................................... 264
13.8. IGEL System Registry .............................................................................................. 265

Index ............................................................................................................................... 266
1. About this document

All illustrations and descriptions in this manual relate to the current version of the IGEL Linux firmware; this manual is subdivided into the following sections:

- **Quick installation** (page 14): Setting up the thin client for the first time
- **Boot procedure** (page 19): Boot menu, network integration, X-Server
- **Application Launcher** (page 16): Important system data such as the firmware version, list of applications, licensed services, system tools
- **Setup application** (page 22): Setting up sessions and system configuration
- **Sessions** (page 26): Creating and configuring application sessions
- **Accessories** (page 146): Session accessories, card readers, sound control, Java Manager, network tools
- **User interface** (page 175): Language, screen, entry options, font services
- **Network** (page 203): Interfaces, protocols, authentication, drives
- **Devices** (page 226): Hardware, printers, storage devices, interfaces
- **Security** (page 234): Password, logging on, AD/Kerberos configuration
- **System** (page 242): System setting options
- **Firmware configuration** (page 252): Customer-specific partition, applications, commands, start screen, environment variables, features
- **IGEL Smartcard** (page 235): Company keys, saving a user/password/session, testing a card
1.1. Important Information

Please note some important information before reading this documentation.

Copyright

This publication is protected under international copyright laws. All rights reserved. With the exception of documentation kept by the purchaser for backup purposes, no part of this manual – including the products and software described in it – may be reproduced, manipulated, transmitted, transcribed, copied, stored in a data retrieval system or translated in any form or by any means without the express written permission of IGEL Technology GmbH.

Copyright © 2018 IGEL Technology GmbH. All rights reserved.

Trademarks

IGEL is a registered trademark of IGEL Technology GmbH.

Any other names or products mentioned in this manual may be registered trademarks of the associated companies or protected by copyright through these companies. They are mentioned solely for explanatory or identification purposes, and to the advantage of the owner.

Disclaimer

The specifications and information contained in this manual are intended for information use only, are subject to change at any time without notice and should not be construed as constituting a commitment or obligation on the part of IGEL Technology GmbH. IGEL Technology GmbH assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual, including any pertaining to the products and software described in it. IGEL Technology GmbH makes no representations or warranties with respect to the contents thereof and specifically disclaims any implied warranties of merchantability or fitness for any particular purpose.

IGEL Support and Knowledge Base

If you have any questions regarding an IGEL product and are already an IGEL customer, please contact your dedicated sales partner first.

If you are currently testing IGEL products or your sales partner is unable to provide the help you need, please fill in the support form after logging on at the members-area (https://www.igel.com/submit-a-ticket/).

We will then contact you as soon as possible. It will make things easier for our support staff if you provide us with all the information that is available. Please see also our notes regarding support and service information (https://3azz0d2jmbqo38r1lx8kfjm1-wpengine.netdna-ssl.com/wp-content/uploads/2017/01/Support_service_EN.pdf).

Please visit our IGEL Knowledge Base http://edocs.igel.com/ to find additional How Tos documentation as well as FAQ.

1.2. Formatting and its Meanings

The following formatting is used in the document for the given purposes:
Proprietary names | Proprietary names of products, firms etc.
---|---
GUI text | Elements of text from the user interface
Menu > Path | Menu paths in systems and programs
Input | Program code or system inputs
**Keyboard** | Commands that are entered using the keyboard
☑ | Checked checkbox
☐ | Unchecked checkbox
Version 5.03.100 | Firmware version

Reference to other parts of the manual or other eDocs articles.

Note regarding operation

Warning: Important note which must be observed

What is new in 5.13.100?
You will find the release notes for IGEL Linux version 5.13.100 as a text file next to the installation programs on our download server and in our knowledge base.

- XDMCP sessions are now assigned to the appliance mode; see *XDMCP* (page 92).
- For Horizon Client the seamless window mode is available; see *Connection Settings* (page 82).
- For Fabulatech redirection in Citrix sessions or RDP sessions, it is possible to configure if and how a device is removed from the local system; see *Fabulatech USB Redirection* (page 40) (Citrix) or *Fabulatech USB Redirection* (RDP).
2. IGEL Universal Desktop Firmware

IGEL thin clients comprise the latest hardware and an embedded operating system. Depending on the product, this operating system may be based on IGEL Linux or Microsoft Windows Embedded Standard.

The firmware included with every IGEL Universal Desktop product is multifunctional and contains a wide range of protocols allowing access to server-based services. The IGEL Universal Desktop firmware is available on the basis of two possible operating systems.

Depending on the operating system, the following options are available:

<table>
<thead>
<tr>
<th>Options</th>
<th>IGEL Linux</th>
<th>Windows Embedded Standard 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ericom Powerterm terminal emulation</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>IGEL Shared Workplace</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>IGEL Universal MultiDisplay</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Codec package</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Management software: Universal Management Suite

For optimum management of your IGEL thin clients, the IGEL Universal Management Suite (UMS) is available on our download page (http://myigel.biz/index.php?dir=IGEL_UNIVERSAL_MANAGEMENT_SUITE/).

With the IGEL Universal Management Suite, you can configure thin clients in the same way as in the devices’ local setup.
2.1. Supported formats and codecs

IGEL Linux supports the following multimedia formats and codecs out of the box:

- Ogg/Vorbis
- Ogg/Theora
- WAV
- FLAC

The following codecs are licensed via the separately available Multimedia Codec Pack:

<table>
<thead>
<tr>
<th>Supported formats:</th>
<th>Supported codecs:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVI</td>
<td>MP3</td>
</tr>
<tr>
<td>MPEG</td>
<td>AAC</td>
</tr>
<tr>
<td>ASF (restricted under Linux)</td>
<td>WMA stereo</td>
</tr>
<tr>
<td>WMA</td>
<td>WMV 7/8/9</td>
</tr>
<tr>
<td>WMV (restricted under Linux)</td>
<td>MPEG 1/2</td>
</tr>
<tr>
<td>MP3</td>
<td>MPEG4</td>
</tr>
<tr>
<td>OGG</td>
<td>H.264</td>
</tr>
</tbody>
</table>

- AC3 is not licensed.

- IGEL Zero Clients (IZ series) have the Multimedia Codec Pack installed by default.
3. Quick Installation

To install the thin client in your network environment, proceed as follows:

1. Connect the thin client as follows to the necessary devices and the network:
   - Monitor (VGA, DVI, DisplayPort)
   - AT-compatible keyboard with PS/2 or USB connection
   - USB mouse
   - LAN via RJ45 plug connection

2. Connect the thin client to the power supply.

3. Start the thin client and wait until the graphical user interface has loaded.

4. Click on in the taskbar.

5. Specify the system language and keyboard layout under User Interface > Language.

6. Specify the resolution and the number of screens under User Interface > Display.

7. If you would like to specify the IP address manually, enter it in the Network > LAN Interfaces section.

8. Click on OK to confirm your changes.

   The device will restart if necessary and will use the new settings thereafter.

A handy tool tip is available for virtually every setting. If you would like to know more about a setting or option, move your mouse pointer over it and wait for a moment. You can configure the behavior of tool tips under User Interface > Desktop. Further information can be found under Desktop (page 182).
4. **The IGEL Linux desktop**

You can operate the thin client via the taskbar and the IGEL menu.

![IGEL Linux desktop](image)

*Figure 1: IGEL Linux desktop*

The following items can be found in the taskbar at the bottom edge of the screen:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td><img src="icon" alt="icon" /></td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Quick Start Panel</td>
</tr>
<tr>
<td><img src="icon" alt="icon" /></td>
<td>Application Launcher: Opens a dialog window with start symbols for sessions.</td>
</tr>
<tr>
<td><img src="icon" alt="icon" /></td>
<td>Setup: Opens the IGEL setup.</td>
</tr>
<tr>
<td><img src="icon" alt="icon" /></td>
<td>Symbol for sessions: Launches a session.</td>
</tr>
</tbody>
</table>
The IGEL menu offers the following areas and functions:

- **Sessions**: Allows you to launch sessions
- **System**: Allows you to launch system programs
- **About**: Shows all relevant system information
- **Search window**: Allows you to find sessions and functions in the start menu
- **Power button**: Allows you to shut down the thin client
- **Refresh button**: Allows you to restart the thin client

### 4.1. Application Launcher

To launch the Application Launcher, proceed as follows:

➢ Click on ![Application Launcher](image) in the Quick Start Panel or in the start menu.

The sub-areas of the Launcher provide access to:

- **Applications**
- **System**
- **License**
- **Information regarding the system**
- **Network information**
4.1.1. Information

On the About page, you will find the following data:

- Product: Information regarding the installed firmware
- Network: Computer name, hardware address and IP address of the thin client
- Hardware: Device type, CPU model etc.
- Licensed Features: All firmware features for which a license is available

4.1.2. Sessions

All sessions created are shown in a list of applications if they are enabled for the main session page.

➢ To open an application, double-click on it or click on Execute.
   Alternatively, you can launch sessions via icons on the desktop, in the Quick Start Panel or from the start menu and context menu.
   Applications can also be launched automatically and a key combination (hotkey) can be defined.

The available options for launching a session can be defined under Desktop Integration in the session configuration.

4.1.3. System

Under System, you can execute various tools including the firmware updating tool with the pre-set update information.

The following tools are available:

- Disk Utility: Shows information regarding connected USB drives.
- Display Switch: Switches between a number of screens.
- Firmware Update: Carries out the update with the settings configured during the setup.
- Identify Monitors: Shows the monitor’s number and manufacturer details.
- Network Tools: Provides detailed information on the network connection and offers a number of problem analysis tools such as Ping or Traceroute.
- Safely Remove Hardware: Removes external storage devices without a risk of losing data.
- Screenshot Tool: Takes photos of the screen content.
- Setup: Launches the IGEL Setup.
- Smartcard Personalization: Allows access data and sessions which are to be available to a smartcard user to be written to an IGEL smartcard.
- System Information: Shows information regarding hardware, the network and connected devices.
- System Log Viewer: Shows system log files "live" and allows you to add your own logs.
- Taskmanager: Manages all processes.
- Touchscreen Calibration: Allows a connected touchscreen monitor to be calibrated.
- UMS Registering: Logs the thin client on to a UMS server (access data for the server are required).
- Upgrade License: Reads a new license file from the USB stick and modifies the functions of the firmware accordingly.
- Webcam Information: Shows data relating to a connected webcam and allows the camera to be tested.
4.1.4. License

You will find the following here:

- The licenses for the components used in the UD system
- Information on the provision of source code, e.g. under GPL

4.1.5. Network Information

The Network information tool allows you to read out data from your local network connections and check the availability of a UMS server:

![Network information tool](image)

Figure 2: Network information

4.1.6. Shutting Down and Restarting a Device

Within the Application Launcher you will find two buttons for Reboot and Shutdown. Both actions can be disabled for the user and will then be available to the administrator only.

You can change the default action when shutting down the device using the button on the screen or the on/off button on the device itself in the setup under System > Power Options > Shutdown.
5. **Boot Procedure**

The quick installation procedure is complete.

➢ Restart the system in order to start the boot procedure.

5.1. **Boot Menu**

➢ During the boot procedure, press the **ESC** key in the Secondstage Loader when the Loading Kernel message is shown on the screen.

A menu with four boot options as well as an option for resetting the thin client to the default factory settings will appear:

- Quiet Boot (page 19): Normal boot
- Verbose Boot (page 19): Boot with system messages
- Emergency Boot (page 19): Setup only
- Failsafe Boot: (page 20) With CRC check
- Reset to Factory Defaults (page 20): Resets the thin client to the default factory settings

5.1.1. **Quiet Boot**

Quiet Boot is the default boot mode. In this mode, all kernel messages are disabled and the graphical user interface is started.

5.1.2. **Verbose Boot**

Unlike in Quiet Boot mode, the boot messages are shown in Verbose Boot mode. A diagnostics shell is also available. This can be used to execute common commands (such as `ifconfig` etc.) when searching for and rectifying faults.

➢ Enter `init 3` to close this shell.

The boot procedure will then resume.

5.1.3. **Emergency Boot**

Emergency Boot is a setup with default parameters.

If you select Emergency Boot, the Secondstage Loader looks for a bootable system in the flash memory and then resumes the boot procedure as in the other boot modes.

Essentially speaking, the X-Server is started without network drivers and with a resolution of 1024 x 768 - 60 Hz during an Emergency Boot. The Setup menu is then opened directly.

This option is useful if, for example, you have selected an excessively high screen resolution or a wrong mouse type and these settings can no longer be changed in the normal setup.
5.1.4. Failsafe Boot - CRC check

During a Failsafe Boot, a check of the file system is carried out first. The thin client then starts in Verbose Mode.

5.1.5. Reset to factory defaults

If you select Reset to factory defaults, all personal settings on the thin client (including your password and the sessions you have configured) will be lost.

A warning message will appear on the screen before the procedure is carried out. If the device is protected by an administrator password, you will be prompted to enter this password.

Do you know the password?

1. Confirm the warning message.
2. Enter the password. You have three attempts.

Do you not know the password?

1. Confirm the warning message.
2. When you are prompted to enter the password, press the Enter key three times.
3. Press \[c\].
   The Terminal Key will appear.
4. Contact us using the IGEL Service RMA form (https://support.igel.com/overview.html).
5. Enter the Terminal Key shown, the firmware version and your contact details.

Our service department will send you a so-called Reset to Factory Defaults Key specially for your device. To ensure that the process is as straightforward and yet as secure as possible, each key is valid for just one device.

See also the Resetting a Thin Client with Unknown Administrator Password FAQs (http://edocs.igel.com/index.htm#10203461.htm).
5.2. Network Integration

Once the kernel has been loaded, the network can be configured.

There are three possible ways of integrating the terminal into the network environment.

Depending on the terminal settings, choose between

- DHCP,
- BOOTP,
- manually configured IP address.

The network interface can be stopped and restarted on the Linux Console (accessible via 

```
/ etc/ init. d/ network stop
/ etc/ init. d/ network start
```

5.3. X-Server

The final step in the boot procedure involves starting the X-Server and the local window manager.
6. **Setup Application**

With the help of the setup, you can change the system configuration and session settings.

Any changes you have made in UMS take precedence and may no longer be modifiable. A lock symbol before a setting indicates that it cannot be changed.

6.1. **Starting the Setup**

You can open the setup in the following ways:

- Double-click on Setup in the Application Launcher
- or click on Execute.
- Double-click on Setup on the desktop (if available based on the settings).
- Select Setup in the desktop context menu (if available based on the settings).
- Select System > Setup in the start menu.
- Click on Setup in the Quick Start Panel.
- Launch the setup using the keyboard command `Ctrl+Alt+B` or
  in the Appliance Mode using `Ctrl+Alt+F2`.

You can configure how the setup can be launched under Accessories. The options described above as well as combinations thereof are available.

6.2. **Ending the Setup**

In order to end the setup again, you have the following options:

- Click on Apply if you have finished configuring a setup area and would like to save your settings without closing the setup program.
- Click on Cancel if you have not made any changes and would like to abort the setup.
- Click on OK to save your changes and exit the setup.
6.3. Setup Areas

The setup application comprises the following main areas:

- **Sessions**: Allows you to configure application sessions such as ICA, RDP, PowerTerm, browser and others.
- **Accessories**: Allows you to configure various local tools - setup pages for the local shell (Terminal), sound mixer, screen keyboard (for touchscreen monitors), options for the Application Launcher and the setup application itself.
- **User interface**: Allows you to configure display settings, entry devices, hotkey commands etc.
- **Network**: Allows you to configure all network settings for LAN/WLAN interfaces and the dial-up connections.
- **Devices**: Allows you to configure various devices.
- **Security**: Allows you to set the administrator/user passwords and user authorizations etc.
- **System**: Allows you to set various basic system parameters including the date and time, information regarding the firmware update, remote management etc.

➢ Click on one of the areas to open up the relevant sub-structure. The tree structure allows you to switch between the setup options.

Three navigation buttons are available. The buttons allow you to move back and forth between the setup pages you have visited or reach the next level up within the structure.

You will find a more detailed description of the individual setup options elsewhere. This is merely a brief overview.
6.4. Enable setup pages for users

If a password was set up for the administrator, the IGEL Setup can only be opened with administrator rights, i.e. after entering the password (see Password (page 234)). However, individual areas of the setup can be enabled for the user, e.g. to allow them to change the system language or configure a left-handed mouse.

To enable setup pages for the user, proceed as follows:

1. Under Security > Password, enable the password for the administrator and the setup user.

   If users are to be allowed to edit parts of the setup even without a password, create a quick setup session, the password for the setup user will not be enabled in this case.

2. Under Accessories > Setup > User Page Permissions, enable those areas to which the user is to have access.

   - A check in the checkbox indicates that the node is visible in the setup.
   - A green symbol (open lock) indicates that the user is able to edit the parameters on this setup page.

![Configure the pages which should be visible to the setup user](image)

   If you enable a setup page on the lower levels, the node points required for access will automatically be marked as visible (but blocked for editing purposes).
6.5. Quick setup

To create a quick setup session, proceed as follows:

1. Under Setup > Security > Password, enable the password for the administrator.

   - If users are to be allowed to edit parts of the setup only with a password, enable the password for the setup user too.

2. Under Setup > Accessories > Quick Setup, define the name and the options for bringing up the quick setup.

3. Under Setup > Accessories > Quick Setup > User Page Permissions, enable those areas to which the user is to have access.

   - You can set up a hotkey in order to launch quick setup in the appliance mode. You will find instructions for setting up the hotkey under Desktop Integration (page 27).

6.6. Setup Search

The Search function enables you to find parameter fields or parameter values within the setup.

1. To start a search, click on the button below the tree structure.

2. Enter the text to be searched for and the search details.

3. Select one of the hits.

4. Click on Show result and you will be taken to the relevant setup page.

   The parameter or value found will be highlighted as shown below.

![Figure 5: Setup search](image-url)
7. Sessions

Application sessions can be created and configured in the Sessions sub-structure of the IGEL setup application. The Session Overview provides an overview of all available session types and existing sessions.

Click on Add... to create a new session.

Disabled functions are not shown in the drop-down list.

A number of session functions require the optional Multimedia Codec Pack. This applies in particular to the playback and redirecting of multimedia content. Details can be found in the IGEL Linux Features that Require the Multimedia Codec Pack FAQs (http://edocs.igel.com/index.htm#10200858.htm).

7.1. Copy Session

You can copy a session in the setup. The copy of the session has all the properties of the original session and is located in the same folder as the original session.

To copy a session, proceed as follows:

1. In the setup, open the menu path Sessions > [Session Type] > [Session Type] Sessions.
   
   Example: Sessions > RDP > RDP Sessions
   
   The existing sessions are shown.

2. Highlight the session that you want to copy.

3. In the [Session Type] Sessions area, click . Alternative: Open the context menu of the session by right-click and select Copy.

A copy of the session will be created.
7.2. Desktop Integration

For each session, there is a desktop integration configuration page on which the following actions can be performed:

- Determining the appearance of the session on the local desktop.
- Setting up the name of the session.

![Warning]

The session name must not contain any of these characters:

\ / : * ? " < > | [ ] { } ( )

- Selecting the session launch options (autostart, restart).
- Enabling hotkey use.
- Setting a password for launching the session (administrator, user, setup user).

7.3. Citrix XenDesktop / XenApp

Menu path: Setup > Sessions > Citrix XenDesktop / XenApp

7.3.1. Citrix Receiver Selection

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix Receiver Selection

Select which of the installed Citrix Receiver versions is to be used for Citrix sessions:

- Default (13.3.2)
- 12.1.8
- 13.3.2
- 13.4.2

An FAQ document (http://edocs.igel.com/index.htm#10201030.htm) provides an overview of the features in the different versions.
HDX / ICA Global

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global

This section describes the procedure for configuring the global Citrix settings. This configuration applies for all Citrix sessions.

Most of these properties can be changed separately for each session, e.g.:

- Color depth
- Resolution
- Server IP
- Server name

Please note that a number of configuration options depend on the version of the Citrix Receiver selected. A comparison of functions can be found in the FAQs: Citrix Receiver Feature Matrix (http://edocs.igel.com/index.htm#10201030.htm).

Citrix Receiver 13.0.x and 13.1.x (Linux) supports HTTPS connections only, while the default setting for the Citrix server is HTTP – a connection attempt will thus fail. HTTPS must be enabled on the Citrix server and you must ensure that a valid root certificate for the certification authority (CA) is installed on the thin client. A How-To document regarding distribution of the certificates is available in the IGEL Knowledge Base: Deploying Trusted Root Certificates (http://edocs.igel.com/index.htm#10200413.htm).

Citrix Receiver 13.1 supports Kerberos passthrough authentication for Legacy-ICA sessions only, not for Storefront!

Users can only change an expired password if this option is enabled on the Citrix server too. See Warning message when changing password (http://edocs.igel.com/index.htm#10201032.htm) FAQ.

Server Location

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Server Location

In this area, you can specify the master ICA browser. The Citrix ICA client is connected to the network. It allows you to bring up a list of all Citrix servers and all published applications which are accessible via the network and use the selected browsing protocol.

The address of the first Citrix server to reply then functions as the master ICA browser.
You can specify a separate address list for each network protocol. This can be TCP/IP, TCP/IP + HTTP or SSL/TLS + HTTPS.

- **TCP/IP** - If your network configuration uses routers or gateways, or if additional network traffic owing to transmissions is to be avoided, you can specify special server addresses for the Citrix servers from which the list of available servers and/or published applications is to be requested. You can add a number of addresses to the address list so that the clients can establish a connection and function even if one or more servers are not available.

- **TCP/IP + HTTP** - You can also call up information from the available Citrix servers and published applications via a firewall. To do this, you use the protocol TCP/IP + HTTP as the server location. The "TCP/IP + HTTP" server location supports the auto-locate function.

- **SSL/TLS + HTTPS** - Secure Sockets Layer (SSL) and Transport Layer Security (TLS) encryption offer server authentication and data stream encryption. They also allow you to check the integrity of messages. If you try to establish a non-SSL/TLS connection to an SSL/TLS server, you will not be connected. A Connection Failed message will be shown.

### Local Logon

**Menu path:** Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Local Logon

In this area, you can specify settings for logging on to the ICA client.

- **Use Kerberos passthrough authentication for all ICA sessions:** This option enables single sign-on for all ICA sessions if Log on to the thin client with AD/Kerberos is configured.

  The server too must be configured for passthrough authentication. When launching ICA sessions, it is then no longer necessary to enter a user name and password again as the local logon data (domain logon) are transferred for session logon purposes. Use the local logon module if problems with load balancing occur. The user’s logon information is transferred when connecting to the metaframe master browser.

  - **Use local login window:** If this option is enabled, you will need to enter the password again when logging on.
  - **Relaunch mode:** The logon module is automatically restarted after being closed.
  - **Type:** Here, you can pre-populate the user name and domain in the logon window and choose between the settings from the last logon and the session setup.
  - **Preset login information:** The logon window is pre-populated with the user name and domain.
  - **Show domain:** Shows the domain entry in the logon window.
  - **Set client name as user name:** This setting may help to resolve reconnection problems during load balancing.
  - **Enable Smartcard Logon:** Only specific smartcard types are supported. You will find a list of compatible types in the Smartcard sub-section of the setup.
  - **Domains:** Allows you to add domains which are to be available. If you enter a number of domains, these will be shown in the Domains drop-down area in the logon module.
Window

Menu path: Setup > Sessions > Citrix XenDesktop / XenApp > HDX / ICA Global > Window

The following settings are configured under Window:

For Legacy ICA Sessions Only:

• Default number of colors: Specifies the standard color depth - the default setting is a color depth of 256 colors.
• Approximate colors: Given the differences between the color palettes used by the ICA client and the "thin client" desktop, the screen may flash annoyingly if you switch between windows on a pseudo-color screen. The ICA client's color adaptation scheme prevents this flashing as it uses the colors from the local desktop palette in order to display the ICA window session. If Approximate Colors is enabled, flashing when switching between windows is avoided.
• Default Horizontal Resolution: Horizontal resolution in pixels
• Default Vertical Resolution: Vertical resolution in pixels
• Font smoothing: Enables font smoothing - in the event of performance problems, font smoothing should be switched off as it requires additional computing power.

For All Citrix Sessions:

• Multi Monitor: Configure whether the full-screen mode is to be extended across all monitors.
• XenApp/StoreFront Start Monitor: Start session window on the selected monitor.
• Embed Systray Icons into Window Manager taskbar: Inserts an application icon into the local taskbar
• Control Bar for Citrix Sessions: Enable a control bar for minimizing or quitting a full screen session.

Keyboard

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Keyboard

On the Keyboard page, you can define alternative key combinations for hotkeys commonly used during ICA sessions. In MS Windows for example, the key combination \texttt{Alt+F4} closes the current window. This key combination works in ICA sessions too. All key combinations with \texttt{Alt} which are not used by the X Window Manager function in the familiar way during an ICA session.

The following settings can be configured:

• Keyboard Layout: default is pre-populated but you can also select a country-specific layout. Default means that the local keyboard setting will be used in ICA too.
• Input language: The default preset uses the local keyboard setting in ICA too. Otherwise, the set layout will be enabled in ICA sessions.
• Mapping Ctrl+Alt+End to Ctrl+Alt+Del for Citrix sessions: The user can use the familiar combination \texttt{Ctrl+Alt+End} to change the password instead of \texttt{Ctrl+Alt+Del} when the corresponding prompt message appears.
• Keyboard Mapping File: You can choose between two alternatives.
  - generic: Sends language-independent scancodes from the keyboard to the computer.
  - linux: Sends language-specific scancodes.

The key alternatives are restricted to \texttt{Ctrl}+\texttt{Shift}+\texttt{Key} by default. However, you can change the settings by clicking on the hotkey modifier drop-down field and/or hotkey symbol for the relevant key combination.

• Possible keys: \texttt{F1} – \texttt{F12, Plus, Minus, Tab}
• Possible modifiers: \texttt{Shift, Ctrl, Alt, Alt+Shift, Ctrl+Shift}
Mapping

**Menu path: Setup > Sessions > Citrix XenDesktop / XenApp > HDX / ICA Global > Mapping**

Locally connected devices such as printers or USB storage devices can be made available in ICA sessions.

**Drive Mapping**

**Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Drive Mapping**

Through drive mapping, each directory mounted on the thin client (including CD-ROMs and disk drives) is made available to you during ICA sessions on Citrix servers.

In this area, you can specify which drives and paths are mapped during the logon. This applies for all ICA sessions.

![Drive Mapping](image)

Figure 7: Drive mapping

The Activate Drive Mapping option allows you to temporarily enable/disable drive mapping. This offers the advantage that stored settings can be enabled or disabled without being lost.

Local (USB) devices which are to be used for drive mapping purposes must first be set up as devices.

To set up drive mappings, proceed as follows:

1. Click on Add to bring up the mapping window.
2. Select a Drive to map from the list under which the local device or the folder is to be mapped.
   - If the drive letter you have selected is no longer available on the Citrix server, the specified directory or local drive will be given the next free letter during the logon.
3. Give the Local Drive Path to which the mapping is to refer.
   - If you map a locally connected device, use the pre-defined path names available in the drop-down field. The directories in question are those on which the devices are mounted by default during the boot procedure (e.g. /autofs/floppy for an integrated disk drive).
4. Specify the access authorizations for the mapping.
   
   For each mapping, you have the option of granting read access or write access. You can also select the Ask option to query the read/write access rights when each ICA session is accessed for the first time.

   The drive mappings and access data defined here are then valid for all ICA connections.

Serial Connections - COM Ports

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > COM Ports

Enable Com Port Mapping in order to perform bidirectional mapping between serial devices connected to the thin client (e.g. scanners, serial printers) and the serial ports of the Citrix server.

As a result, programs running on the server can exchange data with the local devices.

➢ Click on Add under Serial Devices.
➢ From the drop-down list, select the serial connector to which a device is connected or click on Detect Devices... to select an available device.

| /dev/ttyS0    | Denotes the local serial connection COM1 |
| /dev/ttyS1    | Denotes the local serial connection COM2 |
| COM3 and COM4 | Denote possible expansion cards installed in the PCI/ISA slot, e.g. an internal modem |
| USB COM1 to USB COM4 | Denote serial connections to USB-to-serial adapters. |

Your selection will be mapped to the virtual COM1 connection. A second device will be mapped to the virtual COM2 connection and so on.

If you would like signature pads, you must enable them beforehand under User Interface > Signature Pads (page 199).

Printers

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Printer

You can set up a printer for ICA sessions here.

- Enable Client Printer Mapping: With this function, the locally connected thin client printer is made available for your ICA sessions, provided that it was not disabled on the server side.
- Set another default printer:
  - Allows you to specify a default printer for the client which differs from the one defined in the printer setup.
- Default Printer: Print queues used on the thin client to specify the default printer for the session. **lp** is the locally configured default printer.
• Default Printer Driver: Windows driver name for the printer which is automatically set up. Enter one of the universal drivers or your own driver name here.
  
  Possible values:
  - Metaframe XP PS Universal Driver
  - Metaframe XP PCL5c Universal Driver
  - Metaframe XP PCL4 Universal Driver
  - Citrix PCL4 Universal Driver (old)
  - User entry

  The printers must be set up on the Devices > Printers > CUPS > Printers page and must be enabled there for mapping in ICA sessions, see ICA sessions (page 45).

Because the thin client merely places incoming print jobs in a queue, you need to install the printer on the server.

**Device Support**

**Menu path:** Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Device Support

In this area, you can enable virtual ICA channels for communicating with various devices connected to the thin client.

- CenterTools DriveLock channel: The virtual DriveLock channel is implemented on the thin client. The channel must also be installed on the Citrix XenApp server.
  
  DriveLock can read hardware data from local USB devices and transfer these data to the XenApp server with the help of the Virtual ICA Channel Extension. When using whitelists, rules based on the hardware properties of the connected drive (e.g. manufacturer details, model and serial number) are taken into account.

  Important information regarding DriveLock can be found in the Using DriveLock with IGEL Thin Clients (http://edocs.igel.com/#10202104.htm) FAQ.

- A virtual channel for DriveLock is enabled.
- No virtual channel for DriveLock is enabled. (default)

- Cherry Channel for reading German eGK-KVK with ST-1503 / G87-1504

- A virtual channel for reading the German health card (eGK) with Cherry reading devices is enabled.
- No virtual channel for reading the eGK with Cherry reading devices is enabled. (default)

- DigitalPersona Finger Print Channel

- A virtual channel for DigitalPersona fingerprint readers is enabled.
- No virtual channel for DigitalPersona fingerprint readers is enabled. (default)

- Diktamen Channel for Dictation

- A virtual channel for Diktamen is enabled.
- No virtual channel for Diktamen is enabled. (default)
• Grundig MMC channel for dictation with Grundig devices
  - A virtual channel for communication with Grundig devices is enabled.
  - No virtual channel for communication with Grundig devices is enabled. (default)

• Nuance channel for dictation: Virtual audio channel for dictation devices. Dictation microphones from Grundig, Philips and Olympus are supported.
  - This channel is only responsible for audio transmission. The channel for dictation device operating elements is manufacturer-specific and must be enabled separately.
  - The Nuance audio channel is enabled.
  - The Nuance audio channel is not enabled. (default)

• Old Olympus Channel for Dictation with Olympus Devices
  - A virtual channel for communication with Olympus devices (old) is enabled.
  - No virtual channel for communication with Olympus devices (old) is enabled. (default)

• Olycom channel for dictation with Olympus devices
  - A virtual channel for communication with Olympus devices is enabled.
  - No virtual channel for communication with Olympus devices is enabled. (default)

• Legacy Philips SpeechMike Control Channel for Dictation (G5)
  - A virtual control channel for Philips SpeechMike devices (G5) is enabled.
  - No virtual control channel for Philips SpeechMike devices (G5) is enabled.

• Legacy Philips SpeechMike Audio Channel for Dictation (G5)
  - A virtual audio channel for Philips SpeechMike devices (G5) is enabled.
  - No virtual audio channel for Philips SpeechMike devices (G5) is activated.

• Legacy Philips SpeechMike Mixer Channel for Dictation (G5)
  - A virtual mixer channel for Philips SpeechMike devices (G5) is enabled.
  - No virtual mixer channel for Philips SpeechMike devices (G5) is enabled.

• signotec signature pad channel
  - A virtual channel for communication with signotec signature pads is enabled.
  - No virtual channel for communication with signotec signature pads is enabled. (default)

• StepOver signature pad channel
  - A virtual channel for communication with StepOver signature pads is enabled.
  - No virtual channel for communication with StepOver signature pads is enabled. (default)

• Legacy Philips Speech Digital Pocket Memo Channel for dictation (G5)
  - A virtual channel for communication with Philips Digital Pocket Memo devices (G5) is enabled.
  - No virtual channel for communication with Philips Digital Pocket Memo (G5) is enabled. (default)
• DPM server drive (G5): Via this drive, the Philips Pocket Memo dictation device (G5) makes the voice recordings available to the server. (default: P)

  The dictation device is automatically assigned to the selected drive letter. Ensure that no other Hotplug storage device is assigned to this drive letter.

  ➔ Further information can be found under Storage Hotplug and Drive Mapping.

• Philips Speech channel for dictation (G12)
  ✔ A virtual channel for communication with Philips dictation devices (G12) is enabled.
  ☐ No virtual channel for communication with Philips dictation devices (G12) is enabled. (default)

• DPM server drive (G12): Via this drive, the Philips PocketMemo dictation device makes the voice recordings available to the server. (default: P)

  The dictation device is automatically assigned to the selected drive letter. Ensure that no other Hotplug storage device is assigned to this drive letter.

  ➔ Further information can be found under Storage Hotplug and Drive Mapping.

• SpeechAir server drive (G12): Via this drive, the Philips SpeechAir dictation device makes the voice recordings available to the server (default: S)

  The dictation device is automatically assigned to the selected drive letter. Ensure that no other Hotplug storage device is assigned to this drive letter.

  ➔ Further information can be found under Storage Hotplug and Drive Mapping.

• Softpro SPVC Signature Pad Channel
  ✔ A virtual SPVC channel for signature pads is enabled.
  ☐ No virtual SPVC channel for signature pads is enabled.

  DriveLock
  Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Device Support

  The virtual CenterTools DriveLock channel (ICA protocol) is included in the UDLX itself and must be installed on the Citrix XenApp server.

  DriveLock can read hardware data from local USB devices and transfer these data with the help of the Virtual ICA Channel Extension to the XenApp server. When using whitelists, rules based on the hardware properties of the connected drive (e.g. manufacturer details, model and serial number) are taken into account.

Requirements

The following steps are important in order to be able to define the access rights for drives via the DriveLock server configuration:

➢ Enable the USB devices via drive mapping so that they are available as drives within your terminal session.

➢ Check the settings under Sessions > ICA > ICA Global > Mapping > Drive Mapping. They should correspond to the DriveLock settings.
➢ Disable Citrix USB redirection, because this will otherwise prevent drives being recognized by DriveLock.

➢ Check the settings under Devices > Storage Devices > Storage Hotplug because they can influence the USB devices in the Citrix session.

➢ Install and enable the DriveLock channel in the Universal Desktop setup under Sessions > ICA > ICA Global > Mapping > Drive Support.

➢ See also this document from CenterTools which describes the configuration of DriveLock on the server side in more detail: How to use CenterTools DriveLock with IGEL Thin Clients (http://edocs.igel.com/PDF/How to use DriveLock with Igel Thin-Clients.pdf) (PDF).

DigitalPersona authentication
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Device Support

By integrating DigitalPersona fingerprint readers into the thin client system and using the associated server software, users of IGEL thin clients can identify themselves through their fingerprints when using virtual applications on a Citrix XenApp server. All x86-based IGEL thin clients with the IGEL Linux operating system support the handling of logon data via the DigitalPersona Pro Enterprise Software (Version v5.3 and v5.4).

When used in conjunction with the DigitalPersona U.are.U 4500 fingerprint readers which are connected to IGEL thin clients via USB, the software provides a secure and quick means of authentication on virtual desktops.

➢ In order to be able to use fingerprint readers in Citrix sessions, enable the relevant virtual channel in Device Support.

Softpro SPVC Channel
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Device Support

➢ Enable the Softpro SPVC Signature Pad Channel in order to use Softpro/Kofax pads in Citrix sessions.

You will find detailed information regarding the configuration of signature pads in the How-To documents for StepOver Pads (http://edocs.igel.com/index.htm#10202852.htm) and Softpro/Kofax pads (http://edocs.igel.com/index.htm#10202863.htm).

Nuance channel for dictation
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Device Support

➢ Enable the Nuance Channel for Dictation in order to use dictation solutions from the manufacturer Nuance in Citrix sessions.

Diktamen Channel for Dictation
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Device Support

With the Diktamen channel, you can use dictation solutions from Diktamen in Citrix sessions.

To enable the Diktamen channel, proceed as follows:

1. Ensure that multimedia redirection for Citrix sessions is enabled. Further information can be found under Multimedia Redirection (page 43).
2. Enable the option Diktamen Channel for Dictation.
Firewall

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Firewall

In this area, you can configure the following firewall settings:

Use alternate address: Define a proxy or secure gateway server as an alternate address for connections via a firewall. Note the tool tips regarding the individual configuration parameters.

SOCKS / Secure proxy: Select the default proxy settings here or define the settings yourself.

Proxy type: If you use Secure (HTTPS), SSL/TLS or 128-bit encryption must be enabled in order for a secure connection to be established.

Secure Gateway (relay mode): If you would like to use a Citrix Secure Gateway in relay mode, you must give the full domain name – the IP address is not sufficient in this case.

After enabling the alternative address, add the server to the address list under Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Server Location.

Options

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Options

In this area, you can set up additional options to optimize the system's general behavior and its performance.

- Use Server Redraw
  - ✓ The Citrix server is responsible for refreshing the screen contents.
  - □ Do not use Server Redraw. (default)

- Disable Windows Alert Sounds
  - ✓ Switches off the Windows warning sounds.
  - □ The warning sounds remain enabled. (default)

- Allow Backing Store
  - ✓ The X-Server temporarily stores hidden window content.
  - □ Window content is not stored. (default)

- Deferred screen update mode
  - ✓ Enables delayed updates from the local video buffer on the screen. The local video buffer is used if the seamless Windows mode or HDX latency reduction is used.
  - □ No delayed update. (default)

- Cache Size in KB: (default: 1024)
- Minimum Bitmap Size in Bytes: The minimum size of the bitmap files that are to be stored in the cache (default: 1024).

- Persistent Cache Path: The directory in which the files are to be stored locally. (default: $ICAROOT/cache)

Do not make the cache too big as otherwise you run the risk of the thin client having too little storage space for its own system and other applications. You may have no alternative but to equip your thin client with additional RAM.
• Scrolling control: Depending on the speed of your network or the response time of your server, there may be a delay between your letting go of the mouse button on a scroll bar and the scrolling actually stopping (e.g. when using Excel). Changing this value may help (default: 100)

• Audio Bandwidth Limit in StoreFront sessions
  - High
  - Medium
  - Low

  Higher quality requires more network and computing resources.

• Enable Auto Reconnect
  ✔ Automatically attempt to reconnect if the connection is terminated. (default)
  ☐ Do not attempt to reconnect.

• Maximum Retries: (default: 3)

• Delay in seconds before reconnecting: (default: 30)

• Allow Kerberos passthrough authentication in StoreFront sessions
  ✔ Kerberos passthrough authentication is allowed. (default)
  ☐ Kerberos passthrough authentication is not allowed.

  This point refers to Citrix XenApp in Version 6.5 and older.

• CGP Address
  - use the server address
  - Text input
  - disabled

• Multi-Stream ICA
  ✔ Support Multi-Stream ICA (Citrix Receiver 13.5 or newer). (default)
  ☐ Do not support Multi-Stream ICA.

• HDX Adaptive Transport over EDT
  Possible options:
  - UDP without fallback to TCP
  - TCP only - UDP disabled
  - UDP with fallback to TCP
Native USB Redirection

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Native USB Redirection

Redirection for USB devices can be allowed or denied during a Citrix session on the basis of rules. Sub-rules for specific devices or device classes are also possible. The use of rules is described under USB Access Control (page 232).

- **Enable native USB redirection**
  - Native USB redirection is enabled for all Citrix sessions.

  | Enable either native USB redirection or Fabulatech USB redirection, but not both together. |

- **Disable USB redirection if you use DriveLock. Further information can be found in the Using DriveLock with IGEL Thin Clients (http://edocs.igel.com/#10202104.htm) FAQ.**
  - Native USB redirection is deactivated for all Citrix sessions. (Default)

- **Default rule:** This rule will apply if no special rule was configured for a class or a device.
  - **Deny**
  - **Allow**

Class Rules

Class rules apply to USB device classes and subclasses.

Managing class rules:

- **Create a new entry**
- **Remove the selected entry**
- **Edit the selected entry**
- **Copy the selected entry**

Class rule properties:

- **Rule:**
  - **Allow:** Devices that have the properties defined in this rule are redirected by the native USB redirection.
  - **Deny:** Devices that have the properties defined here are not redirected.

- **Class ID:** Selection list of device classes
- **Subclass ID:** Selection list of device subclasses
- **Name:** Short description of the rule; the text appears in the Setup. Example: "Allow scanner"
Device rules

A device rule applies to a specific device that is identified by its USB vendor ID and USB product ID.

Managing device rules:

- Create a new entry
- Remove the selected entry
- Edit the selected entry
- Copy the selected entry

Device rule properties:

- Rule:
  - Allow: Devices that have properties defined in this rule are redirected by the native USB redirection.
  - Deny: Devices that have properties defined here are not redirected.
- Vendor ID: Hexadecimal manufacturer number
- Product ID: Hexadecimal device number
- Name: Short description of the rule; the text appears in the Setup. Example: "Allow scanner"

Fabulatech USB Redirection

Menu path: Setup > Sitzungen > Citrix XenDesktop/XenApp > HDX/ICA Global > Fabulatech USB-Redirection

Redirection for USB devices can be allowed or denied during a Citrix session on the basis of rules. Sub-rules for specific devices or device classes are also possible. The use of rules is described under USB Access Control.

More detailed information about the function can be found on the Fabulatech partner site: http://www.usb-over-network.com/partners/igel/.

- Fabulatech USB Redirection

  Fabulatech USB redirection is enabled for all Citrix sessions.

  Enable either native USB redirection or Fabulatech USB redirection, but not both together.

  Disable USB redirection if you use DriveLock. Further information can be found in the Using DriveLock with IGEL Thin Clients (http://edocs.igel.com/#10202104.htm) FAQ.

  Ensure that no other Hotplug storage device (USB stick) is connected if a session is started with Fabulatech USB redirection. Otherwise the Hotplug storage device will not be safely removed when the session starts, and this could lead to data loss. Please be aware that in IGEL Linux 10.02.x or higher, any USB storage device that may be connected to the thin client is automatically unsafely removed upon activation of Fabulatech USB redirection.

  Fabulatech USB redirection is disabled for all Citrix sessions. (Standard)
• Default rule: This rule will apply if no special rule was configured for a class or a device.
  - Deny
  - Allow

Class Rules

Class rules apply to USB device classes and subclasses.

Managing class rules:

• Create a new entry
• Remove the selected entry
• Edit the selected entry
• Copy the selected entry

Class rule properties:

• Rule
  - Allow: Devices that have the properties defined here are redirected by the Fabulatech USB redirection.
  - Prohibit: Devices that have the properties defined here are not redirected.

• Class ID: Selection list of device classes
• Subclass ID: Selection list of device subclasses
• Name: Short description of the rule; the text appears in the Setup. Example: "Allow scanner"
• Override serial: Optional; alternative serial number that should appear in the session instead of the serial number delivered by the device
• Override name: Optional; alternative device name that should appear in the session instead of the device name delivered by the device
• Postpone
  - The USB device is only removed from the system (thin client) when the session starts. (Default)
  - The USB device is no longer shown immediately after the system is booted. (Default)
    This setting is only effective if the Takeaway parameter is enabled.

• Takeaway
  - The USB device may be removed from the system (thin client).
  - The device may not be removed. (Default)

• No Reset
  - The device will not be automatically reset after the connection with the session has been terminated.
  - The device will be reset after the connection with the session has been terminated. (Default)
Device rules

A device rule applies to a specific device that is identified by its USB vendor ID and USB product ID.

Managing device rules:

- Create a new entry
- Remove the selected entry
- Edit the selected entry
- Copy the selected entry

Device rule properties:

- Rule
  - Allow: Devices that have the properties defined here are redirected by the Fabulatech USB redirection.
  - Prohibit: Devices that have the properties defined here are not redirected.
- Vendor ID: Hexadecimal manufacturer number
- Product ID: Hexadecimal device number
- Name: Short description of the rule; the text appears in the Setup. Example: "Allow scanner"
- Override serial: Optional; alternative serial number that should appear in the session instead of the serial number delivered by the device
- Override name: Optional; alternative device name that should appear in the session instead of the device name delivered by the device
- Postpone
  - The USB device is only removed from the system (thin client) when the session starts. (Default)
  - The USB device is no longer shown immediately after the system is booted. (Default)
    - This setting is only effective if the Takeaway parameter is enabled.
- Takeaway
  - The USB device may be removed from the system (thin client).
  - The device may not be removed. (Default)
- No Reset
  - The device will not be automatically reset after the connection with the session has been terminated.
  - The device will be reset after the connection with the session has been terminated. (Default)
HDX Multimedia Redirection

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > HDX Multimedia

Citrix HDX multimedia acceleration improves playback via Media Player within an ICA session on the remote desktop and allows isosynchronous transmissions, e.g. of webcams within the session.

See Supported formats and codecs (page 13).

To improve multimedia playback on the remote desktop, proceed as follows:

1. To take advantage of improved playback, ensure that the necessary codecs are installed on the remote desktop page.
2. Enable multimedia redirection on the thin client.
3. Create the session.
4. Begin playback on the remote desktop.

From IGEL Linux 5.06.100, hardware acceleration for multimedia playback is available on certain devices. You will find more detailed information in an FAQ document on the topic (http://edocs.igel.com/#10201440.htm).

HDX Flash

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > HDX Flash

Depending on the performance of the thin client, Citrix HDX Mediastream Redirection for Flash allows smoother playback of Flash content than is possible within the Citrix session itself.

An installed Flash Player browser plug-in is needed in order to enable flash redirection.

Install the plug-in under Sessions > Browser > Plug-Ins > Flashplayer.

Codec

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Codec

This setup page can only be seen if you have selected a Citrix Receiver version which is higher than 12.x.

- **Graphical Codec**: Decoding method for the transferred screen content
  - Automatic: Automatically selects the appropriate codec according to the performance of the hardware.
  - H.264 Deep Compression Codec: Guarantees high image quality, but results in high CPU load if the device does not have hardware acceleration for this purpose.
  - JPEG: Is less CPU intensive, although the image quality is slightly reduced.
Additional parameters for H.264 Deep Compression Codec

These parameters are relevant if Automatic or H.264 Deep Compression Codec is selected.

- **Accelerated H.264 Deep Compression Codec (No Text Tracking, No Small Frames Feature)**
  - Enables hardware-accelerated decoding with H.264, which reduces the burden on the CPU.
  - Uses the software implementation of H.264 and results in a greater CPU load.

*For more information, read the Setting up Citrix Sessions with Hardware-Accelerated H.264 Deep Compression Codec ([http://edocs.igel.com/10205128.htm](http://edocs.igel.com/10205128.htm)) How-To.*

The following options are only available for the software implementation of H.264:
- Text Tracking: Loss-free depiction of texts
- Small Frames Feature: Pixel-perfect depiction of lines etc.

Additional parameters for JPEG

These parameters are relevant if JPEG is selected.

- **JPEG Direct-to-screen decoding**
  - Decodes image tiles directly without using a bitmap cache.
- **JPEG Batch Decoding**
  - Enables batch processing and deferred XSync.

Unified Communications

Menüpfad: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Unified Communications

Here, you can change settings relevant for Unified Communications.

- **Enable HDX Realtime Media Engine:** Defines whether the HDX Realtime Media Engine is used.
  - The HDX Realtime Media Engine is active.
  - The HDX Realtime Media Engine is not active. (Default)

Cisco Jabber

Menüpfad: Setup > Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Unified Communications > Cisco Jabber
Legacy ICA Sessions

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions

You can set up your own ICA sessions here.
The global ICA session settings can be changed in the individual sessions.

⚠️ The primary source of further information relating to Citrix connections should always be the relevant Citrix documentation. This manual merely gives general configuration tips.

Server

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > ICA Session > Server

In this area, you can overwrite the following server connection details and thus the default settings:

- **Browser protocol:** The protocol that is to be used when searching for servers and published applications.
- **Do not use default server location:** Lifts the default server requirement – for each protocol separately.
- **Server:** Click on Search to send a transmission signal which queries all available servers and published applications.

By selecting the server, the user is connected to the entire desktop as if logging on at the server itself. As a result, all applications, rights and settings contained in the user’s profile (local server profile) are available.

If you select a published application, the session is opened in a window which contains just one application. The session is ended if you close this application.

You can also manually enter the IP address or the host name of the server in the Server field.

- **Application:** If you have entered the server manually, you can specify a published application here. These fields are automatically filled in if you have selected one of the recognized published applications.

- **Working directory:** Details of the path name of the work directory for the application
Logon

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > ICA Session > Logon

In this area, you can define session-specific logon options.

- **Use Kerberos passthrough authentication**: Enables single sign-on for this ICA session if Log on to the thin client with AD/Kerberos is configured. The server too must be configured for passthrough authentication. When launching the ICA session, there is no need to enter a user name and password again.

- **Use passthrough authentication**: Enables single sign-on for this ICA session if Log on to the thin client with AD/Kerberos is configured. The fact that the user name and password are temporarily stored when logging on to the thin client means that there is no need to enter them again when launching a session.

- **User, password, domain**: Specifies a user name, password and domain for the ICA session. These details are automatically forwarded to the server and no longer need to be entered on the logon screen.

- **Do not show password protection window before logon**: This option switches the Windows splash screen on and off. This option must be disabled when logging on to Windows using a smartcard.

Window

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > Window

The following settings are configured under Window settings:

- **Number of colors**: The color depth is set as a global default. You can change it for this session.

- **Use default settings for color table**: The color table is preset on a global basis. You can approximate it for this session.

- **Full-screen mode**: By disabling the full-screen mode, you can choose between the global default setting and a session-specific setting.

- **Start monitor**: Specifies which monitor in an environment with several monitors is to be used for the session.

- **Enable seamless mode**: The seamless mode can only be used with published applications or with a specified start program for the server connection.

- **Font smoothing**: Font smoothing is preset on a global basis. You can change it for this session.
Firewall

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > [Session Name] > Firewall

In this area, you can configure the following firewall settings:

- **Use alternative address:** Define a proxy or secure gateway server as an alternative address for connections via a firewall. Note the tool tips regarding the individual configuration parameters.
- **SOCKS / secure proxy:** Select the default proxy settings here or define the settings yourself.
- **Proxy type:** If you use Secure (HTTPS), SSL/TLS or 128-bit encryption must be enabled in order for a secure connection to be established.
- **Secure Gateway (relay mode):** If you would like to use a Citrix Secure Gateway in relay mode, you must give the full domain name – the IP address is not sufficient in this case.

After enabling the alternative address, add the server to the address list under Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > ICA Session > Server.

Reconnect

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > ICA Session > Reconnect

In this area, you can specify that ICA sessions automatically reconnect if they were terminated by wireless devices owing to highly fluctuating network latency or area restrictions.

- Enable Use default Auto Reconnect settings in order to apply the settings configured under HDX / ICA Global in the event of reconnection.

- Alternatively, enable Auto Reconnect and you will have the option of specifying the maximum number of attempts and the time delay before a reconnection attempt.
Options

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Legacy ICA Sessions > ICA Session > Options

Under Options, you can optimize performance and system behavior within the ICA session.

Compression

Reduces the quantity of data transmitted via the ICA session. This in turn reduces network traffic to the detriment of CPU performance.
- Enable compression if you connect your server(s) via WAN.
- Disable this option if you use a relatively low-performance server and only work in one LAN.

Caching image data

Enables caching in the cache memory (configured in the global ICA settings) for each session. This makes sense if you use a number of ICA sessions but only one or two sessions are critical with regards to network bandwidth or are used heavily during the day. In this case, you should reserve the cache memory for these sessions.

Encryption method

Encryption increases the security of your ICA connection. Basic encryption is enabled by default. You should therefore ensure that the Citrix server supports RC5 encryption before you select a higher degree of encryption.

Audio transmission

Transfers system sounds and audio outputs from applications to the thin client. These are then output via the speakers connected. The higher the level of audio quality you select, the more bandwidth is needed for transferring audio data.

Mouse click feedback

The mouse pointer immediately turns into an hourglass symbol, thus providing visual feedback in response to a mouse click.

Local text echo

Displays the text entered more quickly and avoids latencies in the network. Select a mode from the drop-down list:
- Select On for slower connections (connection via WAN) in order to reduce the delay between the user entering text and the text being displayed on the screen.
- For faster connections (connection via LAN), select Off.
- Select Automatic if you are not sure how fast the connection is.
Desktop integration

Menu path: Setup > Sessions > Citrix XenDesktop / XenApp > Legacy ICA Sessions > [Session name] > Desktop Integration

➢ Give the name of the session that you would like to integrate into the desktop.
➢ From the Launch Options, specify how the session is to be made accessible.
➢ As an option, specify a hotkey for starting the session.
➢ Enable Autostart to start this session immediately after the system starts. Specify by how many seconds the session start is to be delayed when Autostart is used.
➢ Enable Restart to restart this session after the connection is terminated.

Citrix StoreFront / Web Interface

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface

Most of the settings were already configured under HDX ICA Global and Legacy ICA Sessions (page 45).
➢ Select the start options for the Citrix XenApp session, see Desktop Integration (page 27).

Server

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Server

In this area, you can configure session-specific server connections.

➢ Under Citrix server type, specify the connection type to which the client is to connect.

You can set up up to 5 Citrix master browsers per domain. If the first browser is not available, the second will be queried and so on. Please note that multiple farms can be searched. You can therefore specify addresses for a number of server farms.

➢ Under Server location, specify connections to Citrix Stores. Give the server name or the server IP here.

➢ Add Domains.

➢ Select the Handling of domain in login window:
  - Normal
  - Unchanged
  - Hidden

If you select Hidden, the first entry in the domain list will be used to log on.
Logon

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Logon

In this area, you can define session-specific logon options.

➢ Choose an Authentication Type. Depending on the Receiver version, the following types may be available:

- **Password authentication**
- **Kerberos passthrough authentication** (Web Interface only, not StoreFront)
  
  Uses local logon data for listing and launching applications. The option enables single sign-on for XenApp if logon with AD/Kerberos is configured on the thin client.
- **Smartcard authentication** (StoreFront only, not Web Interface)
- **Citrix authentication mechanism** (instead of IGEL), without smartcard
- **Citrix authentication mechanism** (instead of IGEL), with smartcard

If you have set an authentication type with smartcard, select the type of card on the Smartcard page.

Additional options include the following:

- **Use passthrough authentication**: Uses temporarily saved logon data for listing and launching applications.
- **Auto logon**: Uses the logon data preset on this page when connecting to the server.
- **Remember user name and domain**: Saves the user name and domain from the last logon.
- **Synchronize Citrix password with screen lock**: Synchronizes the screen lock password with that of the Citrix application.
- **Relaunch Citrix logon after logoff**: Automatically shows the Logon dialog again after logging off.

➢ Give a list of applications which will be launched automatically after a connection to the server has been established.

To select an application for automatic launching, proceed as follows:

1. **Click on** in the Launch following applications automatically after server connection is established area.
2. **In the Add dialog**, enter the name of the application.
3. **Click on Next**.

   You can also enter part of the name followed by an asterisk (*).

   After a successful logon, the associated desktop icon for each available application will be placed on the thin client desktop. All applications whose name matches one of the names given in the Start following applications automatically after server connection is established area will then be launched.
Options
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Options
In this area, you can specify settings which differ from the global settings for Citrix StoreFront / Web Interface.

- Use server settings for all options: If this option is enabled, the server settings will be carried over to the client.
- Client Audio If this option is enabled, sound will be transmitted.
- Overwrite local Client Audio with server setting: If this option is enabled, the server audio settings will be carried over to the client.
- Audio Bandwidth Limit: Select between High, Medium and Low - Higher quality requires more network and computing resources.
- Color Depth: Choose between Server setting, Global setting, 16, 256, 32 thousand,16 million and Automatic.
- Window size: Choose between Seamless|Desktop, Server setting, Global setting, Different sizes in pixels, Work area and Full screen.
- Restrict full-screen sessions to workarea
- Handling of keyboard shortcuts: Choose between Server setting, Translated, Direct in full-screen desktops only and Direct.

Appearance
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Appearance
You can configure how Citrix XenDesktop/XenApp applications are displayed.
With the display filter, you can select which applications can be launched in the start menu, in the Application Launcher and on the desktop. You can make a separate selection for the Quick Start Panel.
You can change the following settings:

- Show applications in start menu: If this option is enabled, Citrix applications will be shown in the start menu.
- Show in start menu: Specifies whether all applications are shown in the start menu or whether the server settings are observed.
- Resize icons for the start menu: If this option is enabled, the size of the symbols for the start menu will automatically be adjusted.

  Automatic scaling can prolong the logon procedure.

- Apply display filter to start menu entries: If this option is enabled, only the applications selected in the display filter will be shown in the start menu.
- Show applications in the Application Launcher: If this option is enabled, the applications will be shown in the Application Launcher.
- Apply display filter to Application Launcher entries: If this option is enabled, only the applications selected in the display filter will be shown in the Application Launcher.
- Show applications on desktop: If this option is enabled, the applications will be shown on the desktop.
- Keep folder structure on desktop: If this option is enabled, Citrix sessions will be shown on the desktop in their directory structure.
- Show desktop shortcuts: Specifies whether all applications are shown in the Desktop Launcher or whether the server settings are observed.
- Apply display filter to desktop icons: If this option is enabled, desktop icons will be created only for the applications selected in the display filter.
To select an application in the display filter, proceed as follows:

1. In the Display filter: Show only the following applications area, click on.
   The Add dialog will open.
2. In the Add dialog, enter the name of the application that is to be shown.
3. Click on Ok.

To select an application that is to be shown in the Quick Start Panel, proceed as follows:

1. In the Show the following applications in the Quick Start Panel area, click on.
   The Add dialog will open.
2. In the Add dialog, enter the name of the application that is to be shown in the Quick Start Panel.
3. Click on Ok.

**Password Change**

**Menu path:** Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Password Change

In this area, you can specify how a connection is established in order to change a password.
- **Generic session:** Searches for servers/applications and subsequently establishes a connection
- **Predefined ICA session:** Selects a pre-defined ICA session according to session name
- **Citrix XenApp services site:** Allows you to change a password via the Citrix Web Interface itself
- **Use Kerberos to change the password:** If Kerberos authentication is set up on the XenApp Server, the password can also be changed via this route.

**Reconnect**

**Menu path:** Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Reconnect

In this area, you can select the required option when reconnecting to sessions.

You can establish a connection
- during the logon process and
- through using a reconnect session, e.g. on the desktop.

With the help of the reconnect procedure, you can launch active and terminated sessions, terminated sessions only or sessions on demand.

> An updating session reloads the XenApp session without terminating it.

**Log off**

**Menu path:** Setup > Sessions > Citrix XenDesktop/XenApp > Citrix StoreFront / Web Interface > Logoff

In this area, you can create a logoff session and specify the *desktop integration* (page 27) for it.
Desktop Integration

Menu path: Setup > Sessions > Citrix XenDesktop / XenApp > Citrix StoreFront / Web Interface > Desktop Integration

➢ Give the name of the session that you would like to integrate into the desktop.
➢ From the Launch options, specify how the session is to be made accessible.
➢ As an option, specify a hotkey for starting the session.
➢ Enable Autostart to start this session immediately after the system starts. Specify by how many seconds the session start is to be delayed when Autostart is used.

Citrix Self-Service

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix Self-Service

The Citrix Self-Service interface allows access to Citrix StoreFront or Web Interface services.

![Citrix Receiver](image)

Figure 8: Citrix Self-Service
For this session type, Version 13.1.4. or higher must be selected in the Citrix Receiver selection (page 27).

Server
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix Self-Service > Server

- Use IGEL setup for Citrix Self-Service configuration: If this option is enabled, the IGEL setup will be used for Self-Service configuration.

You can enter a number of servers below:

- Click to enter a new server.
- Click to remove a server.
- Click to edit a server.

In self-service, Citrix Receiver 13.2.1 collaborates correctly with XenApp/XenDesktop 7.x Stores only.

Options
Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix Self-Service > Options

- Display Mode: Select whether the Self-Service user interface is shown in a Window or in Full Screen.
  - When using Full Screen mode the IGEL-Desktop is not available.

- Multi User (StoreFront servers only): If this option is enabled, the user data on the client will be deleted after logging off or terminating Self-Service.
- Reconnect after logon: If this option is enabled, the Self-Service user interface will reconnect automatically after the launch.

Reconnect to apps after starting an application: If this option is enabled, the Self-Service user interface will attempt to reconnect to ongoing sessions if an application is launched or the store is reloaded.

7.3.2. Citrix Access Gateway

Menu path: Setup > Sessions > Citrix XenDesktop/XenApp > Citrix Access Gateway

With the Citrix Access Gateway (CAG) client, you can establish a VPN connection to a CAG default server. The VPN connection is an SSL tunnel. A certificate is transferred from the server to the client in the process.

Warning when attempting to connect

If the certificate is not trustworthy, a warning will be given when an attempt to establish a connection is made.

- In order to avoid the warning, the server certificate can be stored on the thin client in the /wfs/cagvpn/cagvpn-trusted-CAs.crt file.
- The warning can also be disabled in the CAG client configuration.
7.4. RDP Global

Menu path: Setup > Sessions > RDP > RDP Global

This section describes the procedure for configuring the global RDP settings. This configuration applies for all RDP sessions.

- The protocol version cannot be configured manually.
- The version used by the server is automatically recognized and used.

7.4.1. Gateway

Menu path: Setup > Sessions > RDP > RDP Global > Gateway

Via Microsoft Remote Desktop Gateway, you can access remote Windows systems.

The gateway translates between the internal Remote Desktop Protocol RDP and the external HTTPS connection.

Access to the Remote Desktop environment is provided via the browser. The browser establishes a secure connection to the gateway. From here, the connection query is forwarded to the target system. In the process, pre-defined Connection Access Policies and Resource Access Policies (CAP and RAP) for access control are evaluated.

Figure 9: Remote Desktop Gateway

To set up the RD Gateway, proceed as follows:

1. Enable Gateway Support under Sessions > RDP > RDP Global > Gateway.
2. Record the access data. Smartcard is not supported.

- RD Gateway requires Microsoft Windows Server 2008R2 or Server 2012 with various restrictions for each server version.
The following Windows Server editions can preferably be used as gateway servers:

- Server 2008R2 Standard (limited to 250 RD Gateway connections)
- Server 2008R2 Enterprise
- Server 2008R2 Datacenter
- Server 2012 Standard
- Server 2012 Datacenter
- Server 2012 Essential (restricted to the RD Gateway role)
- Server 2012R2 Standard
- Server 2012R2 Essential (restricted to the RD Gateway role)

RD Gateway is not supported in the IGEL RDP Legacy Mode.

7.4.2. Local Logon

Menu path: Setup > Sessions > RDP > RDP Global > Local Logon

Under Local logon, you can pre-populate user data. As a result, you can avoid users possibly having to log on a number of times.

You can also use Local logon to freely select the server in the logon window of an RDP session.

Enable Use local logon window to

- Pre-populate user data
- Freely select the server in the logon window of an RDP session.

The following presets can be configured:
Use local logon window

If this option is enabled, you will need to enter the password in the RDP logon window on the terminal side when logging on.

Preset logon information

The logon window is pre-populated with the user name and domain.

Type

Here, you can pre-populate the user name and domain in the logon window and choose between the settings from the last logon and the session setup.

Show domain

Shows the domain entry in the logon window.

Specify client name to user name

This setting may help to resolve reconnection problems during load balancing.

Relaunch mode

The RDP logon window is displayed in restart mode and cannot be closed.

Enable network authentication

Enables network authentication via NTLM. Smartcards are not supported here.

Domains

Allows you to add domains which are to be available. If you enter a number of domains, these will be shown in the Domains drop-down area in the logon module.

7.4.3. Window

Menu path: Setup > Sessions > RDP > RDP Global > Window

In this area, you can configure the window for RDP sessions.

You can change the following settings:

• Number of colors: Specifies the color depth.
  
  Possible values:
  - 256
  - Thousands
  - Millions

• Window size: Specifies the width and height of the window.
  - Full screen: The session is shown on the full screen. The thin client's taskbar is not visible.
  - Workarea: The session is shown on the full screen minus the area needed by the thin client's taskbar
  - Numeric details: The session is shown in the selected resolution or according to the selected percentage of the screen area.

• Desktop scale factor: Defines the desktop scaling as a percentage value.

  Desktop scaling is supported by Windows Server 2012 or higher and by Windows 8.1 or higher.

  Possible values:
  - auto: The resolution configured under Setup > User Interface > Display > Options Monitor DPI is used for the RDP session.
  - Numeric details: The display is magnified by the factor specified here. Value range: 100% - 500%
• Enable Display Control
  ☑ The window size can be changed during the session. (default)

  ![Icon]
  If the window size is to be changed during the session, at least Windows 8.1 or Windows Server 2012 R2 must be running on the server.

  ![Icon]
  It is not possible to change the window size during the session if the window size is set to full screen or work area.

• Control bar for RDP sessions
  ☑ A symbol bar for minimizing and closing a full-screen session will be shown.

  ![Icon]
  If the symbol bar is enabled, a session will be shown on one monitor only, even if Multi Monitor Fullscreen mode is set to Expand full screen session onto all monitors.

• Enable Internal Backing Store
  ☑ The window content will be saved in an internal buffer. In the event of an expose event, buffering ensures that the window content is obtained from the internal buffer rather than having to be retrieved from the server. This reduces the burden on the network.

• Multi monitor fullscreen mode: Stipulates whether the full-screen mode is to be extended to all monitors.
  Possible values:
  - Restrict fullscreen session onto one monitor
  - Display fullscreen session on all monitors
  - Expand fullscreen session across all monitors

7.4.4. Keyboard

Menu path: Setup > Sessions > RDP > RDP Global > Keyboard

Configure how the keyboard reacts within RDP sessions. The following options are available:

• Clipboard (enable or disable)
• PC keyboard scan codes (convert or send directly)
• Override local window manager keyboard shortcuts (forward or execute locally)

![Icon]
You can select the keyboard layout in the Session Configuration ("Display, Keyboard and Mapping"). Automatic is the default.
7.4.5. Mapping

Menu path: Setup > Sessions > RDP > RDP Global > Mapping

In this area, you can make available locally connected devices such as printers or USB storage devices in RDP sessions.

**Drive Mapping**

Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Drive Mapping

Through drive mapping, connected mass storage devices can be made available to the user. Specify which folders or drives are mapped during the logon.

Via Enable drive mapping, you can temporarily enable/disable drive mapping. This offers the advantage that stored settings can be enabled or disabled without being lost.

Local (USB) devices which are to be used for drive mapping purposes must first be set up as devices.

To set up drive mapping, proceed as follows:
1. Click on Add to bring up the mapping window.
2. Select a Drive to map from the list under which the local device or the folder is to be mapped.

If the drive letter you have selected is no longer available on the server, the specified directory or local drive will be given the next free letter during the logon.

3. Give the Local Drive Path to which the mapping is to refer.

If you map a locally connected device, use the pre-defined path names available in the drop-down field. The directories in question are those on which the devices are mounted by default during the boot procedure (e.g. /autofs/floppy for an integrated disk drive).
COM Ports
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > COM Ports
As with locally connected mass storage devices, you can also map the thin client’s local serial connections during an RDP session:
1. Click on Enable Com Port Mapping.
2. Add the required connection.

- If your device has an additional multiport PCI card, more than 2 connections may be available.
- If you would like signature pads, you must enable them beforehand under User Interface > Signature Pads (page 199).

Printers
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Printers
In this area, you can configure printer mapping.
With the Enable Client Printer mapping function, the locally connected thin client printer is made available in your RDP sessions, provided that it was not disabled on the server side.

- The printers must be set up on the Devices > Printers > CUPS > Printers page and must be enabled there for mapping in RDP sessions.

Because the thin client merely places incoming print jobs in a queue, you need to install the printer on the server.

Device Support
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Device Support
In this area, you can enable virtual RDP channels for communicating with various devices connected to the thin client. These can be card readers (smartcards), dictation machines or even USB storage devices. Channels of this type allow the device to communicate with the relevant server application. Requirements: Enable plugin support.

- When using CenterTools DriveLock, ensure that the use of USB devices is not universally restricted: Devices > USB Access Control.
DriveLock

Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Device Support > DriveLock

The virtual DriveLock channel (RDP) is included from UDLX Version 5.01.100 or higher and must be installed on the RDP server.

DriveLock can read hardware data from local USB devices and transfer these data to the server with the help of the Virtual RDP Channel Extension. When using whitelists, rules based on the hardware properties of the connected drive (e.g. manufacturer details, model and serial number) are taken into account.

Requirements for configuring DriveLock

The following steps are important in order to be able to define the access rights for drives via the DriveLock server configuration:

➢ Enable the USB devices via drive mapping so that they are available as drives within your terminal session.

➢ Check the settings under Sessions > RDP > RDP Global > Mapping > Drive Mapping. They should correspond to the DriveLock settings.

➢ Disable RDP-USB Redirection under Mapping > USB Redirection. This would otherwise prevent drive recognition by DriveLock.

➢ Check the settings under Devices > Storage Devices > Hotplug Storage because they can influence the USB devices in the RDP session.

➢ Install and enable the DriveLock channel under Sessions > RDP > RDP Global > Mapping > Device Support.

➢ In the Centertools download area, you will find a document which describes in greater detail the procedure for configuring DriveLock on the server side: How to Use Centertools DriveLock with IGEL Thin Clients (http://edocs.igel.com/PDF/How to use DriveLock with Igel Thin-Clients.pdf) (PDF)

Audio

Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Audio

In this area, you can configure the settings for local audio transmission.

➢ Enable Client Audio.

➢ Select the Audio Quality Mode and the Audio Compression.

➢ Enable Audio Capture.
7.4.6. **Performance**

Menu path: Setup > Sessions > RDP > RDP Global > Performance

In this area, you can configure settings in order to improve the performance of the RDP session.

➢ You can disable graphics functions which are not absolutely necessary.

| In low-bandwidth environments, you should use compression in order to reduce the network traffic. |
| Please note that the use of compression reduces the burden on the network but does use CPU power. |

Graphic settings which you can disable are:

- Desktop background
- Window contents when moving windows
- Menu and window animation
- Desktop themes
- Mouse pointer shadow
- Mouse pointer settings
- Font smoothing

---

**RemoteFX Support**

Menu path: Setup > Sessions > RDP > RDP Global > Performance > RemoteFX Support

With the Service Pack 1 for Windows Server 2008 R2, local system functions such as Windows Aero or 3D display can be made available in RDP sessions too.

In order to do this, the RemoteFX extension for RDP must be enabled. You can configure the relevant settings under RDP Global > Performance or in the corresponding session settings.

Figure 10: Windows Aero
Globally enabling Remote FX is not recommended as conventional RDP sessions may also be affected by this. With RemoteFX, all graphics effects available under Performance are enabled. This may slow down the session as a result. It is better to enable the function only for individual sessions which establish a connection to appropriately equipped servers.


In the IGEL Registry, you can configure the number of frames sent by the server without confirmation under the key rdp.winconnect.remotefx-ack. The default value is 1. A value of 2 or 3 can lead to improved performance in networks with high latency times.

### 7.4.7. Options

**Menu path:** Setup > Sessions > RDP > RDP Global > Options

In this area, you can configure the following settings:

- **Disable mouse movement events**
  - Instructs the client not to show "unnecessary" cursor movements in order to conserve power.

- **Inverted cursor color**
  - Black, White or Dotted are available to choose from.
  - You can also configure your own values `custom:<foreground color>,<background color>`.
  - The colors must be given in the ARGB8888 format, e.g. 0xFF000000.

- **Reset license**
  - If you have to remove the MS license from the device, enable this option and restart the device.

- **Reset confirmed server certificates**
  - Deletes all confirmed server certificates on the client.

- **RDP legacy mode**
  - Uses the local RDP client from IGEL Linux v4 - see note below.

- **Client Name**
  - Give a client name for terminal service identification - the default setting is the host name of the computer.

- **Custom client name**
  - If you have opted for a custom client name, you can enter the name here.
  - If the field remains empty, the MAC address of the client will be used automatically.

- **Force TLS-encrypted connections**
  - Only TLS-encrypted connections are allowed.

- **Verify server certificates**
  - Verify server certificate if the connection is TLS-encrypted.
Inform IGEL Support if problems occur with the current RDP client (IGEL Linux v5), even if they can be avoided by using the compatibility mode. The RDP legacy mode can be disabled in a later IGEL Linux version.

7.4.8. Native USB Redirection

Menu path: Setup > Sessions > RDP > RDP Global > Native USB Redirection

Redirection for USB devices can be allowed or denied during an RDP session on the basis of rules. Sub-rules for specific devices or device classes are also possible. The use of rules is described under USB Access Control (page 232).

- Enable native USB redirection
  - Native USB redirection is enabled for all RDP sessions.
  - Native USB redirection is deactivated for all RDP sessions. (Default)

- Default rule: This rule will apply if no special rule was configured for a class or a device.
  - Deny
  - Allow

Class Rules

Class rules apply to USB device classes and subclasses.

Managing class rules:

- Create a new entry
- Remove the selected entry
- Edit the selected entry
- Copy the selected entry

Class rule properties:

- Rule:
  - Allow: Devices that have the properties defined in this rule are redirected by the native USB redirection.
  - Deny: Devices that have the properties defined here are not redirected.
- Class ID: Selection list of device classes
- Subclass ID: Selection list of device subclasses
- Name: Short description of the rule; the text appears in the Setup. Example: "Allow scanner"
Device rules

A device rule applies to a specific device that is identified by its USB vendor ID and USB product ID.

Managing device rules:

- Create a new entry
- Remove the selected entry
- Edit the selected entry
- Copy the selected entry

Device rule properties:

- Rule:
  - **Allow**: Devices that have properties defined in this rule are redirected by the native USB redirection.
  - **Deny**: Devices that have properties defined here are not redirected.
- Vendor ID: Hexadecimal manufacturer number
- Product ID: Hexadecimal device number
- Name: Short description of the rule; the text appears in the Setup. Example: "Allow scanner"

7.4.9. Fabulatech USB Redirection

Menu path: Setup > Sitzungen > RDP > RDP Global > Fabulatech USB Redirection

Redirection for USB devices can be allowed or denied during a RDP session on the basis of rules. Sub-rules for specific devices or device classes are also possible. The use of rules is described under USB Access Control.

More detailed information about the function can be found on the Fabulatech partner site: http://www.usb-over-network.com/partners/igel/.

- Fabulatech USB Redirection
  - Fabulatech USB redirection is enabled for all RDP sessions.
    - Enable either native USB redirection or Fabulatech USB redirection, but not both together.

Disable USB redirection if you use DriveLock. Further information can be found in the Using DriveLock with IGEL Thin Clients (http://edocs.igel.com/#10202104.htm) FAQ.

Ensure that no other Hotplug storage device (USB stick) is connected if a session is started with Fabulatech USB redirection. Otherwise the Hotplug storage device will not be safely removed when the session starts, and this could lead to data loss. Please be aware that in IGEL Linux 10.02.x or higher, any USB storage device that may be connected to the thin client is automatically unsafely removed upon activation of Fabulatech USB redirection.

- Fabulatech USB redirection is disabled for all RDP sessions. (Standard)
• Default rule: This rule will apply if no special rule was configured for a class or a device.
  - Deny
  - Allow

Class Rules

Class rules apply to USB device classes and sub-classes.

Managing class rules:

- Create a new entry
- Remove the selected entry
- Edit the selected entry
- Copy the selected entry

Class rule properties:

- Rule
  - Allow: Devices that have the properties defined here are redirected by the Fabulatech USB redirection.
  - Prohibit: Devices that have the properties defined here are not redirected.
- Class ID: Selection list of device classes
- Subclass ID: Selection list of device subclasses
- Name: Short description of the rule; the text appears in the Setup. Example: "Allow scanner"
- Override serial: Optional; alternative serial number that should appear in the session instead of the serial number delivered by the device
- Override name: Optional; alternative device name that should appear in the session instead of the device name delivered by the device
- Postpone
  - The USB device is only removed from the system (thin client) when the session starts. (Default)
  - The USB device is no longer shown immediately after the system is booted. (Default)
  - This setting is only effective if the Takeaway parameter is enabled.
- Takeaway
  - The USB device may be removed from the system (thin client).
  - The device may not be removed. (Default)
- No Reset
  - The device will not be automatically reset after the connection with the session has been terminated.
  - The device will be reset after the connection with the session has been terminated. (Default)
Device rules

A device rule applies to a specific device that is identified by its USB vendor ID and USB product ID.

Managing device rules:

- Create a new entry
- Remove the selected entry
- Edit the selected entry
- Copy the selected entry

Device rule properties:

- **Rule**
  - Allow: Devices that have the properties defined here are redirected by the Fabulatech USB redirection.
  - Prohibit: Devices that have the properties defined here are not redirected.

- **Vendor ID**: Hexadecimal manufacturer number
- **Product ID**: Hexadecimal device number
- **Name**: Short description of the rule; the text appears in the Setup. Example: "Allow scanner"
- **Override serial**: Optional; alternative serial number that should appear in the session instead of the serial number delivered by the device
- **Override name**: Optional; alternative device name that should appear in the session instead of the device name delivered by the device

- **Postpone**
  - The USB device is only removed from the system (thin client) when the session starts. (Default)
  - The USB device is no longer shown immediately after the system is booted. (Default)

  This setting is only effective if the Takeaway parameter is enabled.

- **Takeaway**
  - The USB device may be removed from the system (thin client).
  - The device may not be removed. (Default)

- **No Reset**
  - The device will not be automatically reset after the connection with the session has been terminated.
  - The device will be reset after the connection with the session has been terminated. (Default)
7.4.10. Multimedia

Menu path: Setup > Sessions > RDP > RDP Global > Multimedia

To improve video playback on the remote desktop, proceed as follows:

1. To take advantage of improved playback, ensure that the necessary codecs are installed on the remote desktop page.
2. Enable Video Redirection on the thin client.
3. Create the session.
4. Begin playback on the remote desktop.

⚠️ From IGEL Linux 5.06.100, hardware acceleration for multimedia playback is available on certain devices. You will find more detailed information in an FAQ document on the topic (http://edocs.igel.com/#10201440.htm).
7.5. RDP Session

Menu path: Setup > Sessions > RDP > RDP Sessions

You can set up your own RDP sessions here.

The following configuration pages offer you detailed setup options for the RDP session:

**Server and logon**
Allows you to specify a server and a start application for the terminal server session. The necessary logon information is configured here. Otherwise, the terminal server logon window for entering the user and the password will be displayed.

**Gateway**
Allows you to enable gateway support. Logon data for RD Gateway may also be specified here.

**Window**
Allows you to specify the size of the session window and the color mode. The local taskbar can be configured so that it remains visible during a full-screen session.

**Keyboard**
Allows you to specify the keyboard layout, scan codes and the direct connection between keyboard input and the Windows Server.

**Mapping**
Allows you to specify the audio output device (local/remote) and determine how key strokes and clipboard content are handled. The mapping of serial connections and local drives can be enabled for a session.

You can make connected mass storage devices available to the user using the appropriate mapping: Select Enable, choose the drive letter and the device to be mapped.

**Performance**
Allows you to disable non-essential graphical functions such as skin styles, window animation etc. This is useful in the event of performance problems.

**Options**
Allows you to specify the start application and the work directory for use during the session (how authentication errors are handled during the logon procedure). If, when connecting to the server, a terminal server gateway is to be used, you can configure the relevant settings here (No Gateway is pre-set).

**USB redirection**
Allows you to specify native USB redirection

**Multimedia**
Allows you to specify video redirection.
7.5.1. Server

Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Server

In this area, you can overwrite the following server connection details and thus the default settings:

➢ Choose between Server and RemoteApps Mode.

Server

To set up a server, proceed as follows:

1. Give the Server name or the IP address.
2. Define the RDP Port which is to be used for the connection.
   The default port is 3389.
3. Under Application, specify a start-up application for the terminal server session.
5. Enable Changeable Server-URL on Local Logon in order to allow the server to be entered freely. You must have enabled local logon in order to do this.

Otherwise, the terminal server logon window will be displayed for you to enter a user name and password. If the local logon is used (see above), the thin client's logon window will be shown.

If the Passthrough Authentication option is enabled, the session with the local logon data for the terminal user, e.g. from the domain logon, is used. However, this setting will be overridden by the Local Logon global parameter. You should therefore not use both options at the same time.

Microsoft RemoteApp

Like the published applications of a Citrix server, MS Windows Server 2008 offers the option of passing on RemoteApps to the thin client.


On the client side, only a few parameters need to be configured after enabling the RemoteApp mode.

Please note that the name of the application to be launched must be preceded by two pipe characters (||), e.g. ||Excel.
7.5.2. Window

Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Window

Here, you can specify the settings for the RDP session window.

- **Number of colors**
  Possible values:
  - Global setting (default)
  - 256
  - Thousands
  - Millions

- **Window size**
  Possible values:
  - Global setting (default)
  - fullscreen: The session is shown on the full screen. The thin client's taskbar is not visible.
  - workarea: The session is shown on the full screen, minus the area needed by the thin client's taskbar.
  - Numeric details: The session is shown in the selected resolution or on the selected percentage of the screen area.

- **Desktop scale factor**: Defines the desktop scaling in percents. This functionality is available as of IGEL Linux version 5.11.
  Possible values:
  - Global setting (default)
  - auto: The resolution configured under Setup > User Interface > Display > Options Monitor DPI is used for the RDP session.
  - Numeric details: The display is magnified by the factor specified here. Value range: 100% - 500%

- **Display resolution**
  Possible values:
  - Same as window size (default)
  - Value selection: On the server side, the session runs with the display resolution defined here. On the thin client, the session is displayed with the display resolution defined by the Window size parameter. Thus, if the server-side display resolution is lesser than the Window size, the display is magnified appropriately and, if applicable, anti-aliased. Example of use: Applications which run only resp. optimally with a specific display resolution.

- **Start monitor**: Specifies the monitor on which the session is to start.
  - No configuration (default)
  - Select a specific monitor

- **Multi monitor fullscreen mode**: This setting is relevant if more than one monitor is connected to the terminal:
  - Global setting (default)
  - Restrict fullscreen session onto one monitor
  - Expand fullscreen session onto all monitors
7.5.3. Display, Keyboard and Mapping

Menu path: Setup > Sessions > RDP > RDP Sessions > [session name] > Window / Keyboard / Mapping

➢ Under Window, specify the color depth, window size and the multiscreen behavior.
➢ Under Keyboard, configure the keyboard layout and the hotkey properties.
➢ Enable/disable the allocation of resources for the client, e.g. COM port or printer mapping.
The global parameters (page 55) are the default setting.

7.5.4. Performance and Options

Menu path: Setup > Sessions > RDP > RDP Sessions

Specify the performance settings for the session if they differ from the global configuration (page 55).

You can influence the following values:
• Enable RemoteFX
• Disable desktop background
• Hide window contents when moving windows
• Disable menu and window animation
• Disable desktop themes
• Disable mouse pointer shadow
• Disable mouse pointer settings
• Disable font smoothing
• Compression

7.6. Remote Desktop Web Access

Menu path: Setup > Sessions > RDP > Remote Desktop Web Access

With Web Access for Remote Desktop (Web Access for RD), users can access RemoteApp and a Remote Desktop connection via the start menu on a computer or via a web browser.

RemoteApps and Remote Desktop connections therefore provide a modified view of RemoteApp programs and virtual desktops for users.

7.6.1. Configure Access to RD Connection

Menu path: Setup > Sessions > RDP > Remote Desktop Web Access

In order to allow users access to RemoteApps, you can configure Web Access in three ways:

- **Pre-Defined Configuration** (page 73): Define several server connections with the same user access data. The user must enter their access data and the domain in the logon window.
- **Ask user** (page 74): The connection is pre-configured on the server side. The user only needs to enter their corporate e-mail address.

Or select the third option:
- **Via browser** (page 75): Access via web browser

Pre-defined configuration

Menu path: Setup > Sessions > RDP > Remote Desktop Web Access

To configure pre-defined configuration, proceed as follows:

1. Click on Remote Desktop Web Access > Connections.
2. Select Pre-Defined Configuration under Server Configuration.
3. Create a new session. See the Connections (page 76) section regarding the session settings.

   ![Server configuration](image)

   Figure 11: New RD Web Access Session

   
   If you have selected Pre-Defined Configuration, the Kerberos Passthrough Authentication mode will be available for logging on in addition to the normal user authentication process.
5. Under Logoff / desktop integration (page 77), you can specify how you would like to log on or off.

You must make a setting for the logon icon because this is not pre-configured and you will not otherwise have access to the Web Access logon.

The applications can be provided in the Application Launcher, in the Start Menu, in the Quick Start Panel or on the Desktop. Under Appearance, you can choose from the list of available applications for display on the desktop or in the Quick Start Panel.

Ask User

Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Server

This is a very user-friendly Web Access login.

In order to use it, the network connections connected with the user name on the server side must be pre-configured and it must be possible to query them via DNS.

To configure the Ask user login, proceed as follows:

➢ Select Ask user under Server configuration.

When logging in via RD Web Access, the user will be given a login window where they must only enter their corporate e-mail address, i.e. <name>@<domain>:

![Figure 12: Ask User](image)
Via Browser

The Web Access page for Windows Server 2012 and Windows Server 2012 R2 can also be used on a Linux thin client in the Firefox browser.

- The user only needs the corresponding URL which is entered in the address bar.
- They then log on on the browser page using their user name and password.

![Remotedesktop Web Access in Firefox](image)

If the user clicks on one of the applications offered by Web Access, the thin client will open a logon mask and then a remote desktop session for the chosen application.
7.6.2. Connections

Menupath: Setup > Sessions > RDP > Remote Desktop Web Access > Connections

In this area, you can define the connections to server locations and domains:

For the pre-defined configuration, specify the following values:

1. Select the protocol http:// or https://.
2. Enter the name of the Remote Desktop Web Access Server and the path to the web portal.
3. If you would like to Enable gateway support, you can choose between the settings that you have made globally or in a custom session.

If you would like to carry over the session settings, you must also specify the gateway address.

7.6.3. Authentication

Menupath: Setup > Sessions > RDP > Remote Desktop Web Access > Authentication

You can change logon settings on the server and select applications that are launched automatically after logging on.

The logon settings on the server are only effective if the Server configuration option under Sessions > RDP > Remote Desktop Web Access > Server is set to Predefined configuration. Further information can be found under Connections (page 76).

- Authentication mode: Specifies how the user authenticates themselves on the server.
  - Possible values:
    - Passthrough authentication: This option can be used if the local thin client logon takes place via Kerberos or Shared Workspace. The logon data saved temporarily when logging on to the thin client will be used for the user name and password.
    - Auto logon: The logon data in Username, Password and Domain will be used to log on.
    - User logon: The user enters their data in a logon window.
- Username: User name when logging on to the server.
- Password: Password when logging on to the server.
- Domain: Domain in which the Username and Password are valid.
To select an application for automatic launching, proceed as follows:

1. Click on ✨ in the Start following applications automatically after server connection is established area.
2. In the Add dialog, enter the name of the application. Example: Word 2013
   
   ![You can also enter part of the name followed by an asterisk (*). If for example you enter Word*, all available versions of Microsoft Word as well as Microsoft WordPad will be opened.]

3. Click on Ok.
   
   After a successful logon, the associated desktop icon for each available application will be placed on the thin client desktop. All applications whose name matches one of the names given in the Start following applications automatically after server connection is established area will then be launched.

7.6.4. Appearance

**Menu path:** Setup > Sessions > RDP > Remote Desktop Web Access > Appearance

In this area, you can decide where you would like to display RD Web Access applications:

• In the start menu
• In the Application Launcher
• On the desktop

➢ Enable Use Extended Filter... in order to restrict the applications shown to a specific selection.

➢ Under Add, enter the name of the application that you would like to display on the desktop.

➢ You can also select applications that you would like to display in the Quick Start Panel:

   ![Enable following applications in Quick Start Panel](image)

   Figure 15: Configuring Quick Start Panel

7.6.5. Logoff / Desktop Integration

**Menu path:** Setup > RDP > Remote Desktop Web Access > Logoff

In these two areas, you can specify how you would like to log on to or log off from the application:

➢ Give the name of the session that you would like to integrate into the desktop.

➢ From the Launch Options, specify how the session is to be made accessible.

➢ As an option, specify a hotkey for starting the session.
➢ Enable Autostart to start this session immediately after the system starts. Specify by how many seconds the session start is to be delayed when Autostart is used.

➢ Enable Restart to restart this session after the connection is terminated.

7.7. Horizon Client Global

Menu path: Setup > Sessions > Horizon Client > Horizon Client Global

In this area, you can define the global settings for Horizon Client sessions.

The following settings are carried over from the global settings for RDP sessions; see RDP Global (page 55):

- Drive mapping; see Drive mapping (RDP) (page 59)
- Number of colors; see Window - RDP (page 57)
- Window size; see Window - RDP (page 57)
- Multi-monitor full-screen mode; see Window - RDP (page 57)

7.7.1. Server Options

Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Server Options

In this area, you can specify the settings for the connection between the Horizon Client and the server.

- Preferred desktop protocol: The selected option is preferred by the client when negotiating the connection protocol.

  If the server does not accept the connection protocol preferred by the client, the connection protocol preferred by the server will be used.

  Possible values:
  - Server setting: The client does not give the server details of a preferred connection protocol. The connection protocol preferred by the server is used.
  - RDP: The client tells the server that it prefers RDP as the connection protocol.
  - PCoIP: The client tells the server that it prefers PCoIP as the connection protocol.
  - VMware Blast: The client tells the server that it prefers VMware Blast as the connection protocol.

  Hardware video acceleration can be used for VMware Blast. Information regarding hardware video acceleration on IGEL thin clients can be found in the Hardware Video Acceleration on IGEL Linux FAQS. For hardware video acceleration, the Multimedia Codec Pack must be installed.

  Please note that hardware video acceleration cannot be used in combination with several monitors (Multi-Monitor).

  If no hardware video acceleration is available, rendering will take place via software, without acceleration.

- Enable kiosk mode: If this option is enabled, Horizon Client sessions will be held in kiosk mode.
• Server certificate verification mode: Specifies what will happen if server certificate verification fails.
  Possible values:
  - Reject if verification fails
  - Warn if verification fails
  - Allow unverifiable connections

7.7.2. Local Logon

Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Local Logon

In this area, you can pre-configure user data. As a result, you can avoid users possibly having to log on a number of times.

You can change the following settings:

• Use local login window: If this option is enabled, the local logon window of the thin client will be used to log on to the server. If you use the local logon window, you can pre-configure logon information.
• Preset login information: If this option is enabled, logon information will appear automatically in the logon window. With Type, you can specify the source of the logon information.
• Type:
  - set user/domain from last logon: If this option is enabled, the logon information from the last session will appear automatically in the logon window.
  - set user/domain from session setup: If this option is enabled, session-specific logon information will appear automatically in the logon window. The session-specific logon information is described under Connection Settings (page 82).
  - set user/domain from Appliance Mode: If this option is enabled, the logon information specified in the Appliance Mode for VMware Horizon will appear automatically in the logon window; see Appliance Mode (page 87).
• Show domain: If this option is enabled, the domain will be shown in the logon window.
• Restart mode: If this option is enabled, the logon window will be shown in restart mode and cannot be closed.
• Exit on disconnect or when an error occurs: If this option is enabled, the session will be ended completely when the connection is terminated. If this option is disabled, the connection overview will be shown when the connection is terminated.

Working with domains:

➢ To create a domain, click on 👉.
➢ To remove a domain, click on 🗑.
➢ To change a domain, click on 🏛.

➢ Further settings options can be found under AD/Kerberos Configuration (page 238) and AD/Kerberos (page 238).
7.7.3. USB redirection

Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > USB Redirection

In this area, you can enable and configure USB redirection for specific devices. From IGEL Linux 5.12.100, a USB composite device can be split into its components (interfaces). Example: USB dictation device that is split into the components loudspeaker, microphone, storage device/drive and control buttons.

Ensure that the power supplied by the USB connection is adequate for the device.

If USB redirection is enabled, drive mapping should be disabled; see Drive mapping (page 59). Otherwise, USB redirection can cause a storage device to be removed from the drive mapping. This is the case if the Connect automatically upon insertion option is enabled.

You can change the following settings:

- Enable USB redirection
  - On
  - Off
- Connect automatically at startup
  - USB devices that were inserted before the start of the session are available in the session. (default)
- Connect automatically when inserted
  - USB devices that are inserted during the session are available in the session. (default)
- Default rule: This rule will apply if no special rule was configured for a class or a device.
  - Allow
  - Prohibit
- Automatic splitting of USB composite devices
  - A USB composite device will automatically be split into its individual components (interfaces). The class rules will be applied to these individual devices.
  - The device will not be split into its components.

Enabling USB redirection:
1. Enable the option Enable USB Redirection.
2. Select a Default rule. The default rule defines if the USB redirection is allowed or prohibited in principle.
3. Create one or more rules for classes of devices or single devices.

Creating a class rule:
1. To create a new rule, click in the Class Rules area.
2. Choose a rule. The rule specifies whether use of the device class defined here is allowed or prohibited.
3. Under Class, select the class of device for which the rule should apply. Examples: Audio, Printer, Mass Storage, Storage Devices.
4. Under Name, give a name for the rule.
5. Click on Next.
6. Click on Apply or OK.
   The rule is active.

To create a device rule, proceed as follows:

When a rule is defined, at least one of the properties Vendor ID or Product ID must be given.

1. To create a new rule, click \[+\] in the Device Rules area.
2. Choose a rule. The following rules are available:
   - Deny: The device will not be redirected via USB redirection.
   - Allow: The device will be redirected via USB redirection.
   - Split: A USB composite device will automatically be split into its individual components (interfaces).
   - Do not split: A USB composite device will not be split.
3. Give the Vendor ID of the device as a hexadecimal value.
4. Give the Product ID of the device as a hexadecimal value.
5. Only for USB composite devices: Under Interface Exclusion List, enter a list of interfaces which are to be excluded from USB redirection. The individual interfaces can be separated by commas or spaces.
6. Under Name, give a name for the rule.
7. Click on Next.
8. Click on Apply or OK.
   The rule is active.

7.7.4. Multimedia

Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Multimedia

You can change the following multimedia settings:

- **Enable VMware Multimedia Redirection**
  Possible values:
  - off: The server renders the multimedia data and sends the individual images to the client.
  - on: The client renders the multimedia data supplied by the server.
- **Real Time Audio Video (RTAV)**: Specifies the redirection of video data from the client USB webcam.
  Possible values:
  - off: The client does not forward the webcam data as video data.
  - on: The client forwards the webcam data as video data.

With USB redirection, data from the webcam can be forwarded to the server even if RTAV is disabled.
7.7.5. **Performance**

Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Performance

In this area, you can optimize the performance of Horizon Client sessions.

You can change the following settings:

- **PCoIP client-side image cache size**: Specifies the size of the cache for images. Caching parts of the display reduces the amount of data to be transferred.

  Larger cache sizes of 250 MB or more should only be used if at least 2 GB RAM or more is available.

7.7.6. **Smartcard**

Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Smartcard

In this area, you can specify which smartcards are authorized when logging on.

7.8. **Horizon Client session**

7.8.1. **Connection settings**

Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Connection Settings

In this area, you can define the settings for the connection between the Horizon Client and the server.

- **Server URL**: URL of the VMware Horizon server
- **Use Passthrough authentication for this session**
  - The user name and password from the Active Directory / Kerberos or Shared Workplace login will be used for authentication with this session.
  - The user must enter the user name and password for this session.
- **Username**: User name for login to the VMware Horizon server
- **User password**: Password for login to the VMware Horizon server
- **Domain**: Domain used for login to the VMware Horizon server
- **Session type**: Specifies whether the session contains a desktop or an individual application.
  - Possible values:
    - **Desktop**: The session contains a desktop.
    - **Application**: The session contains an individual application.
- **Desktopname**: Specifies a name for the desktop. This option is available if Session Type is set to "Desktop".
- **Application**: Application that is launched during the session. This option is available if Session Type is set to Application.
• Seamless Application Windows
  - The seamless window mode is activated. The application windows can be moved freely over the desktop. The look and feel, e.g. the title bar, is generated by the operating system on the server. This feature is available starting with IGEL Linux v5.13.100.
  - The application windows are positioned within the session window; the look and feel is generated by the local system (thin client).

• Autoconnect
  - The connection to the desktop or application will be established automatically when the session starts. For this to be possible, the name of the desktop or application must be defined.
  - The overview will be shown when the session starts.

• Preferred desktop protocol: The selected option is preferred by the client when negotiating the connection protocol.

• Enable kiosk mode
  - The session will be held in kiosk mode.

Further settings can be found under AD/Kerberos Configuration (page 238) and AD/Kerberos (page 238).

7.8.2. Window

Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Window

In this area, you can change the way in which the session is displayed.

• Window Size: Specifies the width and height of the window.

  The window size is carried over from the global settings for RDP sessions, see Window (page 57).

• Number of Colors: Specifies the color depth.

  The color depth is carried over from the global settings for RDP sessions, see Window (page 57).

• Start Monitor: Specifies the monitor on which the session is shown.

  Further settings options can be found under Screen (page 175) and Window (page 57).
7.8.3. **Mouse and keyboard**

Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Mouse and Keyboard

In this area, you can define the settings for the mouse and keyboard.

- Disable mouse movement events: If this option is enabled, the mouse pointer will only be shown locally on the thin client. If the user moves the mouse over a session item, no reaction of the item will be shown.

Further settings options can be found under *Language* (page 189) and *Keyboard and Additional Keyboard* (page 194).

7.8.4. **Mapping**

Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Mapping

In this area, you can specify the data transmission between the thin client and the Horizon Client session.

- Enable Client Audio: If this option is enabled, audio data are transmitted.
- Enable Clipboard: If this option is enabled, the clipboard will be available.
- Enable Printer Mapping: If this option is enabled, the printer will be available.
- Enable Com Port mapping: If this option is enabled, the COM port will be available.
- Enable Drive Mapping: If this option is enabled, the external drives will be available.
- Enable USB Redirection: If this option is enabled, the client’s USB data will be forwarded to the server.

Further settings options can be found under *Drive Mapping* (page 59), *Serial Connections (RDP)* (page 60), *Printers (RDP)* (page 60), *Audio* (page 61), *Keyboard* (page 58) and *Printers (Devices)* (page 226).

7.8.5. **Performance**

Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Performance

In this area, you can save system resources by disabling certain visual functions of the user interface.

- Disable Wallpaper: If this option is enabled, no desktop background image will be displayed.
- Don’t show contents of window while dragging: If this option is enabled, the content of a window will not be shown when the window is moved.
- Disable Menu and Window animation: If this option is enabled, transitions for menus and windows will not be animated.
- Disable Themes: If this option is enabled, no optional desktop design will be used.
- Disable Cursor Shadow: If this option is enabled, the mouse pointer will be shown without a shadow.
- Disable Cursor Settings
- Enable font smoothing: If this option is enabled, the edges of fonts will be smoothed.

Further settings options can be found under *Performance (Horizon Global)* (page 82) and *Performance (RDP Global)* (page 62).
7.8.6. Options

Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Options

In this area, you can change various settings.

- **Working Directory**: Directory that is used after logging on
- **Compression**: If this option is enabled, the flow of data between the client and server will be compressed.
- **Enforce TLS encrypted connection**: If this option is enabled, the flow of data between the client and server will be encrypted with TLS.
- **Network Level Authentication**: If this option is enabled, the user will authenticate themselves on the network level (network layer authentication) in order to establish an RDP connection.

If network level authentication is enabled, the local logon window is used. This also applies if the Use local logon window option under Setup > Sessions > Horizon Client > Horizon Client Global > Local Logon is disabled.

Further settings options can be found under **Options (RDP Global)** (page 63), **Performance (RDP Global)** (page 62) and **Local Logon (Horizon Global)** (page 79).

7.8.7. Multimedia

Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Multimedia

You can change the following multimedia setting:

- **VMware multimedia redirection**
  Possible values:
  - **Global setting**: The global setting for Horizon Client sessions is used, see **Horizon Client Global Multimedia** (page 81).
  - **off**: The server renders the multimedia data and sends the individual images to the client.

Further settings options can be found under **Horizon Client Global Multimedia** (page 81).

7.8.8. Proxy

Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Proxy

In this area, you can configure the use of a proxy for the connection between the client and server.

You can change the following settings:

- **Direct connection to the internet**: If this option is enabled, no proxy is used.
- **Manual proxy configuration**: If this option is enabled, a proxy is used. The configuration must be specified in the following fields.
  - **HTTP proxy**: URL of the proxy for HTTP
  - **Port**: Port of the proxy for HTTP
  - **SSL proxy**: URL of the proxy for SSL
  - **Port**: Port of the proxy for SSL
- SOCKS host: URL of the proxy for SOCKS
- Port: Port of the proxy for SOCKS
- SOCKS protocol version: Version of the SOCKS protocol used
- No proxy for: List of URLs for which no proxy is to be used.

- System-wide proxy configuration: If this option is enabled, the proxy configured under Setup > Network > Proxy will be used.

Further settings options can be found under System-wide Proxy (Network) (page 225).

7.9. vWorkspace Client and AppPortal

Menu path: Setup > Sessions > vWorkspace Client

By default, vWorkspace Client session settings are carried over from the RDP Global setup pages. You can change the configuration on the corresponding setup pages for vWorkspace Client sessions.

The vWorkspace Client is based on hypervisors from other providers and is therefore compatible with VMware, vSphere, Microsoft Hyper-V and XenServer.

All configuration parameters for the vWorkspace Client and the vWorkspace AppPortal Farm are described in detail in the original documentation for the relevant client version, for Quest, see https://support.quest.com/Default.aspx (https://support.quest.com - https://support.quest.com).

Figure 16: AppPortal farms configuration
7.10. Appliance Mode

Menu path: Setup > Sessions > Appliance Mode

In Appliance Mode, only a specific session is shown. Access to other applications is not possible.

To enable Appliance Mode for a session type, proceed as follows.

1. In Appliance Mode pull-down menu, select the session type for which Appliance Mode is to be enabled.
   
   You can enable Appliance Mode for one of the following session types:
   
   - VMware Horizon (page 87)
   - Citrix XenDesktop (page 88) (for published desktops only, not for published applications)
   - Citrix Self-Service (page 88)
   - RHEV/Spice (page 89)
   - Imprivata (page 89)
   - RDP Multipoint Server (page 90)
   - Caradigm (page 90)

2. Enter the necessary configuration data for the selected session type.

The system hotkey Ctrl+Alt+S for launching the setup application does not work in the Appliance Mode. Use Ctrl+Alt+F2 instead.

You can set up a hotkey in order to launch quick setup in Appliance Mode. You will find instructions for setting up the hotkey under Desktop Integration (page 27).

7.10.1. VMware Horizon

Menu path: Setup > Sessions > Appliance Mode > VMware Horizon

- Server URL: URL of the VMware Horizon server
- Username: User name when logging on to the VMware Horizon server
- User password: Password when logging on to the VMware Horizon server
- Domain: Domain when logging on to the VMware Horizon server
- Desktop name: Desktop that is to be launched automatically
- Autoconnect: If this option is enabled, the desktop given in Desktop name will be launched automatically.
- Network Level Authentication: If this option is enabled, the user will authenticate themselves on the network level (network layer authentication) in order to establish an RDP connection.

If network level authentication is enabled, the local logon window is used. This also applies if the Use local login window option under Setup > Sessions > Horizon Client > Horizon Client Global > Local Logon is disabled.
• Enable on-screen keyboard: If this option is enabled and a touchscreen is available, an on-screen keyboard will be shown.

If the on-screen keyboard is enabled, the local logon window is used. This also applies if the Use local logon window option under Setup > Sessions > Horizon Client > Horizon Client Global > Local Logon is disabled.

• X position of the on-screen keyboard: Specifies the X position of the on-screen keyboard.
• Y position of the on-screen keyboard: Specifies the Y position of the on-screen keyboard.
• Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.
• Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.

7.10.2. Citrix XenDesktop

Menu path: Setup > Sessions > Appliance Mode > Citrix XenDesktop

• XenDesktop Delivery Server URL: URL of the XenDesktop Delivery server
• Enable Smartcard Login: If this option is enabled, the user can log on with a smartcard.

When the option is enabled, the browser and Xen will be restarted.

• Enable on-screen keyboard: If this option is enabled and the screen is a touchscreen, an on-screen keyboard will be shown.
• X position of the on-screen keyboard: Specifies the X position of the on-screen keyboard.
• Y position of the on-screen keyboard: Specifies the Y position of the on-screen keyboard.
• Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.
• Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.

7.10.3. Citrix Self-Service

Menu path: Setup > Sessions > Appliance Mode > Citrix Self-Service

• Self-Service Delivery Server URL: Server address including the http:// prefix.

In the Appliance Mode, only a single server can be used for Self-Service.

• Multi User (StoreFront servers only): If this option is enabled, the user data on the client will be deleted after logging off or closing the UI.
• Reconnect after logon: If this option is enabled, the Self-Service UI will reconnect automatically after the launch.
• Reconnect to app after starting an application: If this option is enabled, the Self-Service UI will attempt to reconnect to ongoing sessions if an application is launched or the store is reloaded.
• Enable on-screen keyboard: If this option is enabled and the screen is a touchscreen, an on-screen keyboard will be shown.
• X coordinate of the on-screen keyboard: Specifies the X position of the on-screen keyboard.
• Y coordinate of the on-screen keyboard: Specifies the Y position of the on-screen keyboard.
• Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.
• Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.

7.10.4. RHEV/Spice

Menu path: Setup > Sessions > Appliance Mode > RHEV/Spice

• Connection Broker: URL of the Connection Broker
• Enable on-screen keyboard: If this option is enabled and the screen is a touchscreen, an on-screen keyboard will be shown.
• X position of the on-screen keyboard: Specifies the X position of the on-screen keyboard.
• Y position of the on-screen keyboard: Specifies the Y position of the on-screen keyboard.
• Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.
• Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.

7.10.5. Imprivata

Menu path: Setup > Sessions > Appliance Mode > Imprivata

• Set the URL to the server: URL of the single sign on server
• Path to the Appliance: Path to the appliance on the single-sign-on server
• Clear Imprivata data partition: If this option is enabled, information on the Imprivata data partition will be deleted.
• Enable Logging of the Bootstrap Component: If this option is enabled, the bootstrap component will generate a log.
• Bootstrap Component's Logging Verbosity: Specifies the level of detail for the bootstrap component log.
• Generic session: Give the name of the Citrix session that you have configured for Citrix Fast User Switching using generic credentials.
• Enable on-screen keyboard: If this option is enabled and the screen is a touchscreen, an on-screen keyboard will be shown.
• X position of the on-screen keyboard: Specifies the X position of the on-screen keyboard.
• Y position of the on-screen keyboard: Specifies the Y position of the on-screen keyboard.
• Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.
• Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.
7.10.6.  RDP Multipoint Server

Menu path: Setup > Sessions > Appliance Mode > RDP Multipoint Server

- Connect to the server once it has been found: The thin client will find one or more RDP Multipoint Servers by itself if these are in the same network as the thin client and obtain their IP address from the same DHCP server as the thin client.

7.10.7.  Caradigm

Menu path: Setup > Sessions > Appliance Mode > Caradigm

The Caradigm appliance is integrated from IGEL Linux Version 5.09.100.

- Caradigm Vault VIP: IP address or host name of the Caradigm authentication server, also referred to as the Vault
- Caradigm Vault port: Port number of the Caradigm authentication server (default port: 8443)

For the certificates that follow, you have to send the certificate files from the UMS to the client via the file transfer – to the directory `wfs/ca-certs/`. Three files are needed: the thin client certificate, the thin client private key and the Root-CA public key. Now enter the certificates here in the setup. The CA certificates must not be changed because the Root-CA is automatically available after the first reboot via the file `ca-certificates.crt`.

- Thin Client Private Key: Path to the thin client private key
- SSL Client Certificate: Path to the client certificate
- CA certs file: Path to the file which contains the CA certificates. (default: `/etc/ssl/certs/ca-certificates.crt`)
- Disable SSL certificate validation: If this option is enabled, SSL validation will be disabled for test purposes. Normally, the certificates should always be validated.
- Timeout: Specifies the number of seconds after which the connection is automatically terminated.
- Way2Care (EGP): Name of a group within which the user can log on system-wide with a card without having to authenticate themselves again.

This function only affects desktop sessions.

- Default domain: The following options are available for specifying the domain:
  - The authentication server returns a domain.
  - A default domain for the Caradigm Appliance is set.
  - A system-wide default domain is entered. You will find it under IGEL Setup > Network > LAN Interfaces > field Default Domain.
  - The user enters the domain manually when logging on.
• Session type: Selects the session type. To do this, you must have entered the server in the relevant session beforehand.

Depending on the session type, you have the following setting options:

Advanced settings for Citrix HDX/ICA
- Logout behavior: The logout behavior can be specified for Citrix HDX/ICA. The following are possible:
  - User choice
  - Force disconnect
  - Force logoff

Advanced settings for VMware Horizon
- Server URL: URL of the VMware Horizon server
- Desktopname: Name of the desktop that is to be launched automatically.
- Autoconnect:
  - Check box: Connect automatically to the desktop if enough information is given.
- Network Level Authentication: Enables network level authentication (NLA) for RDP connections. Requires local logon window.

• Company Logo: (optional) Full path of an image file for a logo which is to appear in the logon window.
• Logging: Enables local logging.
  - Logging verbosity: Specifies how exact logging is to be. The level of detail decreases as you move down through the selection.
• On-Screen Keyboard: If this option is enabled, an on-screen keyboard will be shown.
  - x coordinate of on-screen keyboard: Specifies the x position of the on-screen keyboard.
  - y coordinate of on-screen keyboard: Specifies the y position of the on-screen keyboard.
  - Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.
  - Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height.

Smartcard logon
To log on or off using a smartcard, proceed as follows:

➢ Tap the card on the card reader to log on.
➢ Tap the card on the card reader once more to log off again.

If you leave the terminal without logging off, you will automatically be logged off as soon as another user logs on.

Forgot your card?
1. Click on the arrow at the bottom right of the logon mask.
   The Enter user data mask will open.
2. Enter your logon data.
7.10.8. XDMCP

Menu path: Setup > Sessions > Appliance Mode > XDMCP for this Display

If this session type is selected, the thin client acts as an XDMCP client.

- Connection type: The type of the connection
  Possible values:
  - Indirect via localhost: At startup, the thin client generates a list of found XDMCP hosts. The user can select a host.
  - Indirect: At startup, a list of XDMCP hosts is displayed. This list is generated by the server specified under Name or IP of the server. The user can select a host.
  - Direct: The login mask of the host specified under Name or IP of the server is displayed.
  - Broadcast: The thin client starts a broadcast request. The login mask of that XDMCP host is displayed which is the first to respond to the broadcast request.

- Name or IP of server: The name or IP of the XDMCP server.

- Enable hotkeys for XDMCP Display: Defines whether hotkeys are managed by the thin client or the host.
  - Hotkeys are managed by the thin client. When the user enters a shortcut key that is defined as a hotkey on the thin client, it starts the appropriate action. The input is not forwarded to the server. (Default)
  - Hotkeys are not managed by the thin client. Almost all keyboard shortcuts are forwarded to the server. The hotkey for opening the IGEL setup can still be used, provided that this hotkey is activated under Accessories > Setup. The default hotkey is \textbf{Strg}+\textbf{Alt}+\textbf{F2} (as with IGEL Linux v5.13.100).

7.11. Caradigm

Menu path: Setup > Sessions > Caradigm

The procedure for configuring your Caradigm session is described below.

- Session name: Name for the session

  The session name must not contain any of these characters:

  \ / : * ? " < > | [ ] { } ( )

Session start options

- Start menu
  - The session can be started with the start menu.
- Application Launcher
  - The session can be started with the Application Launcher.
- Desktop:
  - The session can be started with a program starter on the desktop.
- Quick start panel:
  - The session can be started with the quick start panel.
- Start menu's system tab
  - The session can be started with the start menu’s system tab.
- Application Launcher’s system tab
  - The session can be started with the Application Launcher’s system tab.
- Desktop context menu
  - The session can be started with the desktop context menu.
- Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.
- Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.
- Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.
- Password protection: Specifies which password will be requested when launching the session.
  Possible values:
  - None: No password is requested when launching the session.
  - Administrator: The administrator password is requested when launching the session.
  - User: The user password is requested when launching the session.
  - Setup user: The setup user’s password is requested when launching the session.
- Hotkey:
  - The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.
- Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g. Ctrl. Here, you will find the available modifiers and the associated key symbols:
  - (No modifier) = None
  - = Shift
  - = Ctrl
  - = Super_L
  - = Alt
  Key combinations are formed as follows with |
    - = Ctrl|Super_L
- **Key**: Key for the hotkey

  To enter a key that does not have a visible character, e.g. the `Tab` key, open a terminal, log on as user and enter `xev -event keyboard`. Press the key to be used for the hotkey. The text in brackets that begins with `keysym` contains the key symbol for the Key field. Example: `Tab in (keysym 0xff09, Tab)`

- **Autostart**: If this option is enabled, the session will be launched automatically when the thin client boots.
- **Autostart delay**: Waiting time in seconds between the thin client booting and the session being launched automatically.

### 7.11.1. Verbindung

**Menu path**: Setup > Sessions > Caradigm > Connection

In this area, you can define the connection settings for your Caradigm session:

- **Caradigm Vault VIP**: IP address or host name of the Caradigm authentication server, also referred to as the Vault
- **Caradigm Vault Port**: Port number of the Caradigm authentication server (default: 8443)

For the certificates that follow, you have to send the certificate files from the UMS to the client via the file transfer - to the directory `/wfs/ca-certs/`. Three files are needed: the thin client certificate, the thin client private key and the Root-CA public key. Now enter the certificates here in the setup. The CA certificates must not be changed because the Root-CA is automatically available after the first reboot via the file `ca-certificates.crt`.

- **SSL Client Private Key**: Path to the private key of the thin client (example: `/wfs/ca-certs/tc_pk.pem`)
- **SSL Client Certificate**: Path to the client certificate (example: `/wfs/ca-certs/tc_ca.crt`)
- **CA certs file**: Path to the file which contains the CA certificates (example: `/etc/ssl/certs/ca-certificates.crt`)
- **Disable SSL certification validation**:  
  - **SSL validation will be disabled for testing purposes. Normally, the certificates should always be validated.**
- **Timeout**: Specifies the number of seconds after which the connection is automatically terminated. (default: 30)
- **Way2Care (EGP)**: Name of a group within which the user can log in system-wide with a card without having to authenticate themselves again. (Example: `EGPGroup`)

This function only affects desktop sessions.
7.11.2. Optionen

Menu path: Setup > Sessions > Caradigm > Options

In this area, you can configure additional Caradigm settings such as the location domain and session-type-specific attributes:

- **Default domain**: Name of the default domain. The following options are available for specifying the domain:
  - The authentication server returns a domain.
  - A default domain for the Caradigm Appliance is set.
  - A system-wide default domain is entered. You will find it under IGEL Setup > Network > LAN Interfaces > Default Domain field.
  - The user enters the domain manually when logging on.

- **Session type**: Selects the session type. To do this, you must have entered the server in the relevant session beforehand. Possible values:
  - Citrix HDX/ICA
  - VMware Horizon
  - Microsoft RDP

Depending on the session type, you have the following setting options:

**Advanced settings for Citrix HDX/ICA**

- **Logoff behavior**: The logoff behavior can be specified for Citrix HDX/ICA.
  
  Possible values:
  - User choice
  - Force disconnect
  - Force logoff

**Advanced settings for VMware Horizon**

- **Server URL**: URL of the VMware Horizon server
- **Desktop Name**: Name of the desktop that is to be launched automatically
- **Autoconnect**

✓ Connect automatically to the desktop if enough information is given.

- **Network Level Authentication**
  - **On**: Enables network level authentication (NLA) for RDP connections. Requires local logon window.
  - **Off**: Conventional authentication

- **Company logo**: (Optional) Full path of an image file for a logo which is to appear in the logon window.
- **Logging**:

✓ Local logging is enabled.

- **Logging verbosity**: Specifies how exact logging is to be. The level of detail decreases as you move down through the selection.

  Possible values:
  - debug
  - info
  - warning
  - error
  - critical
7.11.3. Desktop Integration

Menu path: Setup > Sessions > Caradigm > Desktop Integration

You can configure one or more Caradigm sessions.

The settings for launching the session are described below.

- Session name: Name for the session

⚠️ The session name must not contain any of these characters:
\ / : * ? " < > | [ ] { } ( )

Session start options

- Start menu
  - The session can be started with the start menu.
- Application Launcher
  - The session can be started with the Application Launcher.
- Desktop:
  - The session can be started with a program starter on the desktop.
- Quick start panel:
  - The session can be started with the quick start panel.
- Start menu’s system tab
  - The session can be started with the start menu’s system tab.
- Application Launcher’s system tab
  - The session can be started with the Application Launcher’s system tab.
- Desktop context menu
  - The session can be started with the desktop context menu.
- Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/" or "\", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.
- Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.
- Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.
- Password protection: Specifies which password will be requested when launching the session.

Possible values:
- None: No password is requested when launching the session.
- Administrator: The administrator password is requested when launching the session.
- User: The user password is requested when launching the session.
- Setup user: The setup user’s password is requested when launching the session.
• **Hotkey:**
  - The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

• **Modifiers:** A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g. Ctrl. Here, you will find the available modifiers and the associated key symbols:
  - (No modifier) = None
  - ⌘ = Shift
  - ⏎ = Ctrl
  - ⌘ = Super_L
  - ⌘ = Alt

Key combinations are formed as follows with |:

- Ctrl + ⌘ = Ctrl|Super_L

• **Key:** Key for the hotkey

  To enter a key that does not have a visible character, e.g. the Tab key, open a terminal, log on as user and enter xev -event keyboard. Press the key to be used for the hotkey. The text in brackets that begins with keysym contains the key symbol for the Key field. Example: Tab in (keysym 0xff09, Tab)

• **Autostart:** If this option is enabled, the session will be launched automatically when the thin client boots.

• **Autostart delay:** Waiting time in seconds between the thin client booting and the session being launched automatically.

### 7.12. Leostream

**Menu path:** Setup > Sessions > Leostream

In this area, you can configure settings for the Leostream Connection Broker. You have the following options:

**Connections**
Details of the server and domain for logging on.

**Desktop integration**
Start option settings for this session.

**Options**
Setting up the logon prompt and USB redirection.

By default, the RD Desktop client is used for the connection in UDLX – rdesktop must therefore be set as the Leostream API protocol with priority 1 on the server.
More information on the Leostream Connection Broker is available from Leostream by visiting:
http://www.leostream.com/resources/downloads.php
(http://www.leostream.com/resources/downloads.php -

7.13. AppliDis

Menu path: Setup > Sessions > AppliDis

AppliDis Fusion 4 is a virtualization solution which combines the virtualization of desktops and applications in a single console.

If you create an AppliDis session, you can configure the following settings:

**Connections**
Details of the Server URL and Connection Type for logging on. If you use AppliDis SLB Linux in the Connector Mode, the name of the application that uses the connector can be specified here.

**Options**
Allows you to define the language, access data, access path and further settings for the AppliDis client.

**Desktop integration**
Start option settings for this session.

The original documentation with a description of all parameters for the Systancia AppliDis Fusion 4 Client and the administration manual are available from Systancia Experts (http://www.expertssystancia.com/applidis-fusion-4-sp1-administration-manual/).
7.14. Evidian AuthMgr

Menu path: Setup > Sessions > Evidian AuthMgr

The procedure for configuring your Evidian Authentication Manager (AuthMgr) is described below.

7.15. NoMachine NX

Menu path: Setup > Sessions > NX > [Session Name]

If you configure an NX session, retain the NX server data.

Under NX > [Session Name] > Connections > Server, select the session type. Depending on the session type chosen, either the Unix Desktop, Windows Desktop or VNC Desktop setup pages are enabled to allow further configuration.

The IGEL setup pages for NX sessions are essentially an adapted graphical user interface for the NoMachine NX Client.

Further information regarding configuration (performance, services etc.) can be found in the original documentation provided by NoMachine: http://www.nomachine.com/documents.php
(http://www.nomachine.com/documents)

7.16. X Session

Menu path: Setup > Sessions > X Sessions

Set up the basic connection data (type, server and command) on the server side and specify the necessary hotkey and window parameters in order to launch an X session.

7.17. Parallels Client Global

Menu path: Setup > Sessions > Parallels Client > Parallels Client Global

In this area, you can configure global settings for all Parallels Client sessions.

7.17.1. Keyboard

Menu path: Setup > Sessions > Parallels Client > Parallels Client Global > Keyboard

You can change the country setting for the keyboard.

- Keyboard layout: Country setting for the keyboard
7.18. Parallels Client

Menu path: Setup > Sessions > Parallels Client > Parallels Client Sessions > Parallels Client Session

In this area, you can configure desktop integration for the Parallels Client session.

- Session name: Name for the session

⚠️ The session name must not contain any of these characters: 
/ : * ? “ < > | [ ] { } ( )

Session start options

- **Start menu**
  - The session can be started with the start menu.
- **Application Launcher**
  - The session can be started with the Application Launcher.
- **Desktop**:
  - The session can be started with a program starter on the desktop.
- **Quick start panel**:
  - The session can be started with the quick start panel.
- **Start menu’s system tab**
  - The session can be started with the start menu’s system tab.
- **Application Launcher’s system tab**
  - The session can be started with the Application Launcher’s system tab.
- **Desktop context menu**
  - The session can be started with the desktop context menu.
- **Menu folder**: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.
- **Path in the Application Launcher**: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.
- **Desktop folder**: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.
- **Password protection**: Specifies which password will be requested when launching the session.

Possible values:
- **None**: No password is requested when launching the session.
- **Administrator**: The administrator password is requested when launching the session.
- **User**: The user password is requested when launching the session.
- **Setup user**: The setup user’s password is requested when launching the session.

- **Hotkey**:
  - The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.
• **Modifiers**: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g. Ctrl. Here, you will find the available modifiers and the associated key symbols:
  - (No modifier) = None
  - ⦃ = Shift
  - Ctrl = Ctrl
  - ⦄ = Super_L
  - Alt = Alt

  Key combinations are formed as follows with |:
  - Ctrl + ⦄ = Ctrl|Super_L

• **Key**: Key for the hotkey

  ![Image](image.png)

  To enter a key that does not have a visible character, e.g. the Tab key, open a terminal, log on as user and enter xev -event keyboard. Press the key to be used for the hotkey. The text in brackets that begins with keysym contains the key symbol for the Key field. Example: Tab in (keysym 0xff09, Tab)

• **Autostart**: If this option is enabled, the session will be launched automatically when the thin client boots.

• **Relaunch**: If this option is enabled, the session will be relaunched automatically after termination.

  Autostart delay: Waiting time in seconds between the thin client booting and the session being launched automatically.

### 7.18.1. Connection

Menu path: Setup > Parallels Client > Parallels Client Sessions > Parallels Client Session > Connection

In this area, you can specify the settings for the connection between the Parallels Client and the server.

**Application server**

• **Primary Server**: Name or IP address of the primary application server

• **Secondary Server**: Name or IP address of the secondary application server. The secondary application server is used if the primary application server cannot be contacted.

• **Connection Mode**

  Possible values:
  - **Gateway Mode**: This mode is suitable if the Parallels Client does not have access to a physical server and no special demands as regards security apply. The Parallels Client establishes a connection to the Parallels SecureClientGateway via port 80. The RDP sessions runs in a tunnel within this connection.
  - **Direct Mode**: This mode is suitable if the Parallels Client has direct access to a physical server. The Parallels Client establishes a connection to the Parallels SecureClientGateway via port 80 in order to negotiate connection data for the RDP session with the application server. The Parallels Client then terminnates the connection to the gateway and establishes the session with the application server. This mode is the most efficient because the connection to the gateway is temporary and the data traffic is correspondingly low.
- **Gateway SSL Mode**: This mode is suitable if the Parallels Client does not have access to a physical server and there are high demands as regards security. The Parallels Client establishes a connection to the Parallels SecureClientGateway via port 443. The RDP sessions runs in a tunnel within this connection.

- **Direct SSL Mode**: This mode is suitable if the Parallels Client has direct access to a physical server and there are high demands as regards security. The Parallels Client establishes a connection to the Parallels SecureClientGateway via port 443 in order to negotiate connection data for the RDP session with the application server. The Parallels Client then terminates the connection to the gateway and establishes the session with the application server.

- **Port**: Port used for communication with the application server

**Logon**

- **Use system credentials**
  - ✓ The system-wide logon data will be used for logging on to the application server (Single sign-on).
  - This option can be used if the local thin client logon takes place via Kerberos. The logon data saved temporarily when logging on to the thin client will be used for the user name and password.
  - □ The logon data given under User name, Password and Domain will be used when logging on to the application server.

- **User**: User name when logging on to the application server
- **Password**: Password when logging on to the application server
- **Domain**: Domain when logging on to the application server

**7.18.2. Local Resources**

**Menu path**: Setup > Parallels Client > Parallels Client Sessions > Parallels Client Session > Local Resources

- **Remote computer sound**
  - Possible values:
    - Bring to this computer: The thin client plays back the audio data supplied by the application server.
    - Do not play: The thin client does not play back the audio data supplied by the application server.
    - Leave at remote computer: The audio data will be played back on the application server.

- **Display color depth**: Number of colors displayed

  > If the option RemoteFX is enabled under Setup > Parallels Client > Parallels Client Sessions > Parallels Client Session > User Experience, the color depth will be set internally to 32 bit, regardless of the value selected.

  **Possible values:**
  - 8 bit
  - 15 bit
  - 16 bit
  - 24 bit
  - 32 bit
Local devices

- Connect local serial ports
  ✓ The thin client's serial interfaces can be used in the Parallels Client session.
- Connect local smartcards
  ✓ The thin client's card reader can be used in the Parallels Client session.
- Connect local drives
  ✓ The thin client's drives can be used in the Parallels Client session.
- Connect local printers
  ✓ The printer connected to the thin client can be used in the Parallels Client session.

7.18.3. Experience

Menu path: Setup > Parallels Client > Parallels Client Sessions > Parallels Client Session > Experience

You can enable or disable the performance features for the graphical display according to the bandwidth of the network connection.

- Speed of the network connection: Choice of graphical display modes
  Possible values:
  - Modem 28 kbps: The Enable RemoteFX performance feature is enabled.
  - Modem 56 kbps: The Themes and Enable RemoteFX performance features are enabled.
  - Broadband: The Menu and window animation, Show contents of window while dragging, Themes and RemoteFX performance features are enabled.
  - LAN: The Desktop background, Font smoothing, menu and window animation, show window content when moving windows, user interface design and RemoteFX performance features are enabled.
  - Custom: The performance features can be enabled or disabled individually.
- Desktop background
  ✓ The desktop background image for the session will be shown.
- Font smoothing
  ✓ Edges will be smoothed when text is displayed.
- Menu and window animation
  ✓ Transitions for menus and windows will be animated.
- Show contents of window while dragging
  ✓ The window content will be shown when a window is moved.
- Themes
  ✓ The design of the desktop can be modified.
• Enable RemoteFX
  ☑ Microsoft RemoteFX will be used.
  If this option is enabled, the following parameters will be set automatically:
  • The desktop background, font smoothing, menu and window animation, show window content when moving windows and user interface design performance features will be enabled internally, regardless of what is selected under Speed of the network connection.
  • The color depth will be set internally to 32 Bit, regardless of the value set under Setup > Parallels Client > Parallels Client Sessions > Parallels Client Session > Local Resources > Selection Color Depth.

• Adaptive RemoteFX (RDP 8.1):
  ☑ RemoteFX Progressive and H.264 (RDP 8.1) Parallel 2X options are enabled.

7.18.4. Network

Menu path: Setup > Parallels Client > Parallels Client Sessions > Parallels Client Session > Network

You can select whether a proxy is used for communication between the Parallels Client and the application server and, if so, which one.

• Use proxy server
  ☑ A proxy is used for communication between the Parallels Client and the application server.
  ☑ A direct network connection is used for communication between the Parallels Client and the application server.

• Proxy type: Type or protocol of the proxy used.
  Possible values:
  - SOCKS 4
  - SOCKS 4A
  - SOCKS 5
  - HTTP 1.1

• Proxy host: URL of the proxy
• Proxy port: Port of the proxy
• Use proxy credentials: If a proxy demands a logon, this option must be enabled and the logon data must be entered under Proxy user and Proxy password.
  ☑ The logon data in Proxy user and Proxy password will be sent to the proxy.

• Proxy user name: User name when logging on to the proxy
• Proxy password: Password when logging on to the proxy. The password is relevant if either the SOCKS 5 or HTTP 1.1 protocol is selected as the proxy type.
7.18.5. Advanced

Menu path: Setup > Parallels Client > Parallels Client Sessions > Parallels Client Session > Advanced

- Redirect URLs to client
  - URLS will be opened on the client.
  - URLS will be opened on the application server. (default)
- Redirect mail to client
  - E-mails will be opened on the client.
  - E-mails will be opened on the application server. (default)
- Use all monitors for desktop session (if applicable)
  - If more than one monitor is connected to a remote computer, the session will be displayed in both of them.
  - The session is only displayed on the main monitor. (default)
- Use only primary monitor for published applications
  Published applications will run on the server; the input and output data will be exchanged between the client and the application server.
  - Published applications will only be shown on the primary monitor.
  - Published applications will only be shown on all available monitors. (default)
- Span desktop on all monitors
  - The desktop will be shown across all available monitors.
  - The desktop will only be shown on the primary monitor. (default)
- Compression
  - The data flow between the Parallels Client and the application server will be compressed. (default)
  - The data flow between the Parallels Client and the application server will not be compressed.
  ![Compression icon] Compression reduces network traffic but requires more CPU power.
- Overwrite computer name: The name entered here will overwrite the name of the application server shown at the top of the session window.
7.19. PowerTerm WebConnect

Menu path: Setup > Sessions > PowerTerm WebConnect

You can access the following applications locally or remotely via PowerTerm WebConnect:

• Windows terminal server
• A virtual desktop (on hypervisors such as VMware, Microsoft, Citrix and Virtual Iron)
• Blade PCs
• Legacy hosts

➢ Enter the host name of the WebConnect server to which you would like to establish a connection.

➢ The server configuration is described in Ericom’s WebConnect documentation:

7.20. PowerTerm Terminal Emulation

Menu path: Setup > Sessions > PowerTerm Terminal Emulation

The PowerTerm InterConnect software we use in IGEL Linux is the official Linux version from ERICOM Software Ltd.

To use your Ericom PowerTerm Terminal emulation you need a free license key from IGEL. To get to the activation form please register at our IGEL Service & Support System (https://support.igel.com/overview.html).

To configure a session:

1. Click on Add New Session.
2. Select PowerTerm as the session type.
   The PowerTerm Emulation Setup window opens.
Figure 18: PowerTerm Emulation setup

This setup offers a good overview of the emulation types supported.

The setup pages used here were designed to look as similar as possible to the setup pages described in the original documentation from ERICOM Software Ltd.


7.20.1. PowerTerm selection

Menu path: Setup > Sessions > PowerTerm Terminal Emulation > PowerTerm Selection

Two versions of the PowerTerm are available to choose from here:

- 10.1.0.0.20130211.2-_rc_-31580
- 9.2.0.6.20091224.1-_rc_-25848

Default, which corresponds to Version 9.2.0.6.20091224.1-_rc_-25848, is preset.
7.21. IBM iSeries Access

Menu path: Setup > Sessions > IBM iSeriesAccess

IBM iSeries Access for Linux (5722-XL1) offers emulation of the IBM-5250 terminal.

💡 A full description of the emulation is available from IBM by visiting:

(http://publib.boulder.ibm.com/infocenter/iseries/v5r4/index.jsp?topic=/rzatv/rzatvI5250.htm -

⚠️ The configuration is not accessible until the user confirms that the necessary license is available.

7.22. IBM iAccess Client

Menu path: Setup > Sessions > IBM iAccess Client

IBM iAccess Client is a Java-based emulation of IBM 5250 terminals that supports a variety of encodings.

➢ To use IBM iAccess Client, add a session.

➢ Under Connection, at least add an IP address or the DNS name of a server as the Destination Address. The client can prompt for credentials interactively.

➢ In the iAccess Client menu, click Help > Information Center in order to view the included documentation in a browser window.

IBM iAccess Certificates for server authentication and encrypted connections can be deployed as files with Universal Management Suite (UMS).

7.23. ThinLinc

Menu path: Setup > Sessions > ThinLinc

You can set up one or more Thin Linc sessions.

💡 You will find further information on setting up the session in the “Client Configuration” chapter of the ThinLinc administration handbook: http://www.cendio.com/resources/docs/adminguide.pdf
(http://www.cendio.com/resources/docs/adminguide.pdf -
7.23.1. ThinLinc Global

Menu path: Setup > Sessions > ThinLinc > ThinLinc Global

In this area, you can change the global settings for ThinLinc sessions.

Server

Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Server

You can specify the port for communication between the client and server and allow remote monitoring of the client through shadowing.

- SSH port
  Possible values:
  - Default SSH (22): Port 22 is used.
  - HTTP (80): Port 80 is used.
  - Custom: Under Custom Port number, you can enter an alternative port number.

- User-defined port number: Alternative port number
- Enable shadowing: If this option is enabled, the session can be remote monitored by shadowing via VNC.

Window

Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Window

In this area, you can define the window settings for ThinLinc sessions.

- Screen size
  Possible values:
  - 800x600
  - 1024x768
  - 1280x1024
  - 1600x1200
  - Current monitor: The entire display area of the current monitor is used for the ThinLinc session.
  - All monitors: The display area of all monitors is used for the ThinLinc session.
  - Work area (maximized): The display area of the current monitor minus the height of the taskbar is used for the ThinLinc session.
  - Custom size: The display area specified with Custom Screen Width and Custom Screen Height is used for the ThinLinc session.

- Custom Screen Width: Width of the display area for the session in pixels
- Custom Screen Height: Height of the display area for the session in pixels
- Full-screen mode: If this option is enabled, the entire screen area will be used for the ThinLinc session.
- Full screen all monitors: If this option is enabled, the entire screen areas of all monitors will be used for the ThinLinc session.
- Control bar for ThinLinc sessions: If this option is enabled, a session control bar will be shown for a ThinLinc session in full-screen mode. You can minimize or close the session with the control bar.
Options
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Options
You can change various settings and enable local directories.

- Enable Sound: If this option is enabled, the audio output will be forwarded from the server to the thin client. The audio data can then be played back via the built-in loudspeaker or the headset.
- Redirect Serial Port: If this option is enabled, the data from the thin client serial port will be forwarded to the server. The serial port can then be used in the ThinLinc session.
- Enable Printer: If this option is enabled, local printers can be used in the session.
- Enable Smartcard Readers: If this option is enabled, the server will be given access to the local smartcard reader.
- Enable Drive Access: If this option is enabled, the server will be given access to local directories. These directories can be selected in the Exported Paths and Permissions area.

To select a local directory for server-side access, proceed as follows:

1. Click on 🌟.
2. In the Path field, enter the local directory path. Example: /userhome
3. Select the Permission that the server is to have for the directory.
   - Read only: The server has read rights for the directory but no write rights.
   - Read/Write: The server has read and write rights for the directory.
   - Disabled: The server has no read rights and no write rights for the directory.

   ![If you set a directory to Disabled, ensure that it is not a sub-directory of a directory for which the server has read or write rights.]

4. Click on Ok.

Optimization
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Optimization
You can increase the transmission speed by setting various compression procedures.

- Enable Custom compression level: If this option is enabled, you can specify how much the data transmitted between the client and server are compressed. If this option is disabled, compression level 8 will be used.
- Compression level: Allows you to select the compression level; 9 is the highest compression
- Use JPEG Compression: If this option is enabled, graphical data will be compressed using the JPEG procedure.

   ![A higher JPEG compression level saves bandwidth but reduces the image quality.]

- JPEG Quality: Allows you to select the image quality. 1 means the highest compression and the lowest image quality, 9 means the lowest compression and the highest image quality.
- SSH Compression: If this option is enabled, the data will be compressed using SSH.
VNC Optimization

Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > VNC Optimization

You can change VNC protocol settings in order to optimize transmission.

- **VNC autoselect**: If this option is enabled, the coding and color depth will be set automatically.
- **Preferred encoding**: Specifies how the data to be transmitted are to be coded. The coding is negotiated between the client and server.

  Possible values:
  - Tight
  - ZRLE
  - Hextile
  - raw

- **Color depth**: Allows you to select the color resolution

  Possible values:
  - Full (all colors): The maximum value set on the server is used.
  - Medium (256 colors)
  - Low (64 colors)
  - Very low (8 colors)

7.23.2. ThinLinc Sessions

Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name]

In this area, you can configure desktop integration for the ThinLinc session.

- **Session name**: Name for the session

  The session name must not contain any of these characters:
  
  \ / : * ? “ < > | [ ] { } ( )

Session start options

- **Start menu**
  - The session can be started with the start menu.
- **Application Launcher**
  - The session can be started with the Application Launcher.
- **Desktop**:
  - The session can be started with a program starter on the desktop.
- **Quick start panel**:
  - The session can be started with the quick start panel.
- **Start menu’s system tab**
  - The session can be started with the start menu’s system tab.
- **Application Launcher’s system tab**
  - The session can be started with the Application Launcher’s system tab.
• Desktop context menu
  - The session can be started with the desktop context menu.

• Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

• Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.

• Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

• Password protection: Specifies which password will be requested when launching the session.
  Possible values:
  - None: No password is requested when launching the session.
  - Administrator: The administrator password is requested when launching the session.
  - User: The user password is requested when launching the session.
  - Setup user: The setup user’s password is requested when launching the session.

• Hotkey:
  - The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

• Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g. Ctrl. Here, you will find the available modifiers and the associated key symbols:
  - (No modifier) = None
  - = Shift
  - = Ctrl
  - = Super_L
  - = Alt

  Key combinations are formed as follows with |:
  - Ctrl + = Ctrl|Super_L

• Key: Key for the hotkey

To enter a key that does not have a visible character, e.g. the Tab key, open a terminal, log on as user and enter xev -event keyboard. Press the key to be used for the hotkey. The text in brackets that begins with keysym contains the key symbol for the Key field. Example: Tab in (keysym 0xff09, Tab)

• Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.
• Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched automatically.
Server

Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Server

- Server: Name or URL of the ThinLinc server
- User: User name for the connection to the ThinLinc server
- Password: Password for the connection to the ThinLinc server
- Use global SSH port settings: If this option is enabled, the port set under Setup > Sessions > ThinLinc > ThinLinc Global > Server will be used for the SSH connection. If this option is disabled, the port set in SSH Port or Custom Port Number will be used.
- SSH port
  Possible values:
  - Default SSH (22): Port 22 is used, the default port for SSH connections.
  - HTTP (80): Port 80 is used, the default port for HTTP connections.
  - Custom: Under Custom Port Number you can enter an alternative port number.
- Custom Port Number: Alternative port number

Window

Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Window

In this area, you can define the window settings for the ThinLinc session. You will find a description under the global settings, see Window (page 109).

![Tip: You can only enable the control bar for ThinLinc sessions in the global settings.]

- Use global screen settings: If this option is enabled, the settings under Setup > Sessions > ThinLinc > ThinLinc Global > Window will be used, see Window (page 109).

Options

Menu path: Setup > Menu Path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Options

You can change various settings, allow access to local directories and allow shadowing.

- Use global shadowing settings: If this option is enabled, permission for shadowing will be specified under Setup > Menu Path: Setup > Sessions > ThinLinc > ThinLinc Global > Server, see Server (page 109).
- Enable shadowing: If this option is enabled, the session can be remote monitored by shadowing via VNC.
- Enable Sound: If this option is enabled, the audio output will be forwarded to the thin client.
- Enable Serial Port: If this option is enabled, the serial interface of the thin client can be used in the session.
- Enable Printer: If this option is enabled, local printers can be used in the session.
- Enable SmartCard Readers: If this option is enabled, the server will be given access to the local smartcard reader.
- Enable Srive Access: If this option is enabled, the server will be given access to local directories. These directories can be selected in the Exported Paths and Permissions area.
- Options Popup Key: Specifies the key which brings up the options menu.
Optimization

Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Optimization

In this area, you can define the settings for optimizing the ThinLinc session. You will find a description under the global settings, see Optimization (page 110).

- Use global compression level: If this option is enabled, the settings under Setup > Sessions > ThinLinc > ThinLinc Global > Optimization will be used for Use user-defined compression level and Compression level.
- Use global JPEG quality settings: If this option is enabled, the settings under Setup > Sessions > ThinLinc > ThinLinc Global > Optimization will be used for Use JPEG compression and JPEG quality.
- Use global SSH connection settings: If this option is enabled, the settings under Setup > Sessions > ThinLinc > ThinLinc Global > Optimization will be used for SSH compression.

VNC Optimization

Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > VNC Optimization

In this area, you can define settings for the VNC protocol in order to optimize transmission. You will find a description under the global settings, see VNC Optimization (page 111).

- Use global VNC settings: If this option is enabled, the settings under Setup > Sessions > ThinLinc > ThinLinc Global > VNC Optimization will be used.

User Interface

Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > User Interface

You can change the fields and settings options of the logon window as well as the ThinLinc Client Options dialog.

- Lock Server Name: If this option is enabled, the server name given under Setup > Sessions > ThinLinc Sessions > Server will be used and it will not be possible to change it in the logon window.
- Hide options button: If this option is enabled, the Options button will not appear in the logon window. The ThinLinc Client Options dialog therefore cannot be opened.
- Advanced Mode: If this option is enabled, the fields which can be opened under Advanced will appear when the session is launched.
- Lock ThinLinc Options Tab: If this option is enabled, the settings in the Options tab cannot be changed in the ThinLinc Client Options dialog.
- Lock Local Devices Options Tab: If this option is enabled, the settings in the Local Devices tab cannot be changed in the ThinLinc Client Options dialog.
- Lock ThinLinc Screen Tab: If this option is enabled, the settings in the Screen tab cannot be changed in the ThinLinc Client Options dialog.
- Lock ThinLinc Optimization Tab: If this option is enabled, the settings in the Optimization tab cannot be changed in the ThinLinc Client Options dialog.
- Lock Security Tab: If this option is enabled, the settings in the Security tab cannot be changed in the ThinLinc Client Options dialog.
- Debug level: Specifies how detailed the debugging information is to be. 1 is the lowest level, 5 is the highest.
7.24. SSH Session

Menu path: Setup > Sessions > SSH

This section describes the procedure for configuring an SSH session.

Use the SSH session to launch a remote application on the host via SSH (Secure Shell) and display it on the terminal. SSH allows secure, encrypted communication between two hosts or host and terminal via an unsecured network. X11 connections can also be routed via this secure channel.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name (remote)</td>
<td>Name of the remote user - The selected user must have a user account on the remote host.</td>
</tr>
<tr>
<td>Computer (remote)</td>
<td>Name or IP address of the remote host from which the remote application is launched.</td>
</tr>
<tr>
<td>Command line</td>
<td>Allows you to enter the name of the application program which is to be launched.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward X11 connection</td>
<td>X11 connections are automatically forwarded to the remote computer so that each X11 program launched from the shell or the command passes through the encrypted SSH channel. The authentication data are also defined automatically. This option is enabled by default.</td>
</tr>
<tr>
<td>Enable compression</td>
<td>Reduces the amount of data transmitted via the data channel - This option is disabled by default.</td>
</tr>
<tr>
<td>Get protocol version</td>
<td>You must prove your identity to the remote host using one of the various identification methods. These depend on the protocol version used. In this area, you can obtain details of the protocol version after opting for a particular identification method.</td>
</tr>
</tbody>
</table>

⚠️ You will find detailed information on SSH and the various authentication methods on the relevant pages of the manual for your server operating system.
7.25. VNC Viewer

Menu path: Setup > Sessions > VNC Viewer

Create a VNC Viewer session in order to be able to access remote computers (VNC server) via the thin client. Connection options such as the server address or the full-screen mode can be pre-populated for each session or defined individually when the system starts.

If a server address is specified for the session, the connection dialog will not appear when the session starts – the connection will be established immediately.

7.26. VERDE session

Menu path: Setup > Sessions > VERDE Sessions

Virtual Bridges VERDE is a scalable virtual desktop solution. It supports traditional virtual desktop environments, available remote branches and both Windows and Linux users. VERDE is the basis for IBM Virtual Desktop.

More information is available from Nimboxx (https://www.nimboxx.com/solutions/use-cases/vdi/).

7.27. Browser

Menu path: Setup > Sessions > Browser

In order to allow central configuration via the IGEL UMS, the original configuration parameters for the Firefox 38.4.0 ESR web browser are assigned to the IGEL setup. These global settings can be changed for each browser session.

7.27.1. Browser Global

Menu path: Setup > Sessions > Browser > Browser Global

In this area, you can define the start page, display resolution and font size for the browser.

You can change the following settings:

- When browser starts: Specifies what pages are shown when the browser is launched.
  - Start with a blank page
  - Show my home page
  - Resume previous session: All tabs from the last session are reopened.
- Home page: Specifies the URL of the start page. You can specify a number of start pages by separating the URLs of the start pages with a pipe character "|".
• Display resolution: Specifies the display resolution for the browser in DPI. Typical values are 72 for medium screens and 96 for large screens.
• Minimum font size: Specifies the minimum size of the fonts displayed on websites. The formats of the websites are overwritten in the process.
• Show browser splash screen: If this option is enabled, a Firefox logo will be shown in the middle of the screen when the browser is launched.

Tabs
Menu path: Setup > Sessions > Browser > Browser Global > Tabs

In this area, you can define settings for the browser tabs.

You can change the following settings:
• New pages should be opened in: Specifies how links to new pages are to be opened.
  - the current window: The page will open in the current window even if the link defines a new window as the target.
  - a new window: If the link does not define a target, the page will open in the current window. If the link defines a new window as the target, the page will open in a new window.
  - a new tab: If the link does not define a target, the page will open in the current window. If the link defines a new window as the target, the page will open in a new tab.
• Warn me when closing multiple tabs: If this option is enabled, a warning will be shown as soon as you attempt to close a browser window with a number of tabs.
• Warn me when opening multiple tabs might slow down the browser: If this option is enabled, a warning will be shown as soon as you open a very large number of tabs.
• When a link is opened in a new tab, switch to it immediately: If this option is enabled, the focus will switch to the new tab when a new tab is opened by a link. If this option is disabled, the focus will be retained when a new tab is opened by a link.

Content
Menu path: Setup > Sessions > Browser > Browser Global > Content

In this area, you can change settings regarding popups, JavaScript, downloads and the browser display.
• Block pop-up windows: If this option is enabled, websites will be prevented from automatically opening popups. With Exceptions..., you can allow popups to be opened automatically for specific websites.

To add an exception for the automatic opening of popups, proceed as follows:
  a) Click on Exceptions....
  b) Click on 🌟.
  c) In the Website field, give the URL of the website for which the exception is to apply.
  d) Click on Ok.
• Load images automatically: If this option is enabled, websites will be loaded in full, including all images. If this option is disabled, the images will not be loaded and placeholders will be shown instead. As a result of this, websites can be displayed more quickly, but the layout is impaired. With Exceptions... you can allow or prevent automatic loading for specific websites.
To add an exception for the automatic loading of images, proceed as follows:

a) Click on Exceptions....

b) Click on 🌟.

c) In the Website field, give the URL of the website for which the exception is to apply.

d) Using the Status drop-down menu, specify whether the automatic loading of images is to be allowed or prevented for the given website.

e) Click on Ok.

- **Type of download directory**: Specifies the directory in which a downloaded file is saved.
  - `userhome`: The file is saved locally on the thin client desktop.
  - `user-defined path`: You can specify whether the downloaded file is to be opened with an application or saved locally.

- **Download path**: Local directory in which the downloaded file is saved if Type of download directory is set to user-defined path. Example: `/userhome`

- **Enable JavaScript**: If this option is enabled, JavaScript will run on websites.
  - Raise or lower windows: If this option is enabled, a website can place windows in the background or foreground via JavaScript.
  - Move or resize existing windows: If this option is enabled, a website can move windows or change the window size via JavaScript.
  - Disable or replace context menus: If this option is enabled, a website can define a custom context menu via JavaScript; the browser’s own context menu will be suppressed in the process.

- **Languages for Web Pages**: One or more preferred languages for multilingual websites, given in the form of language abbreviations separated by commas. The languages should be given in the order of preference. Example: With `de, en, fr, it`, the website will be shown in German, if available, otherwise in English etc.

**Print**

Menu path: Setup > Sessions > Browser > Browser Global > Print

In this area, you can set the Default Paper Size for the printer.

- **Use system settings for default paper size**: If this option is enabled, the paper size set globally will be used when printing websites. If this option is disabled, you can set the paper size via Default Paper Size.

- **Default Paper Size**: Preset paper size when printing websites.
Proxy

Menu path: Setup > Sessions > Browser > Browser Global > Proxy

In this area, you can change the proxy configuration.

To change the proxy configuration, proceed as follows:

1. In the Proxy Configuration pull-down menu, select the type of proxy configuration.

   The following proxy configurations are available:
   - Direct connection to the Internet
   - Manual proxy configuration
   - Automatic proxy configuration
   - System-wide proxy configuration
   - Auto-detect proxy settings for this network

2. Enter the necessary configuration data for the selected proxy configuration.

Direct connection to the Internet

With this proxy configuration, no proxy is used.

Manual proxy configuration

The configuration data must be specified in the following fields.

- **FTP Proxy**: URL of the proxy for HTTP
- **Port**: Port of the proxy for FTP
- **HTTP Proxy**: URL of the proxy for HTTP
- **Port**: Port of the proxy for HTTP
- **SSL Proxy**: URL of the proxy for SSL
- **Port**: Port of the proxy for SSL
- **SOCKS Host**: URL of the proxy for SOCKS
- **Port**: Port of the proxy for SOCKS
- **SOCKS Protocol version**: Version of the SOCKS protocol used
- **No Proxy for**: List of URLs for which no proxy is to be used.
• **Proxy Realm**: Area in which the browser authenticates itself for the proxy. Together with the user name and password, this information is necessary for authentication.

The **Proxy Realm** field is internally pre-populated with the value `moz-proxy://[HTTP Proxy]:[Port]`. If the field is empty, this value will be used when authenticating the browser.

If the proxy expects another unknown value for the proxy realm, you can determine this as follows: Leave the **Username** and **Password** fields empty and launch the browser. The dialog window which appears will contain the correct value for the **Proxy realm** field:

![Authentication Required](image)

In the example above, the value for the **Proxy realm** field is as follows:

`moz-proxy://172.30.178.10:8080`

• **Use Passthrough authentication**: This option can be used if the local thin client logon takes place via Kerberos. If this option is enabled, the logon data temporarily saved when logging on to the thin client will be carried over for the user name and password.

• **Username**: User name with which the browser authenticates itself for the proxy.

• **Password**: Password with which the browser authenticates itself for the proxy.

• **Do not prompt for proxy authentication if credentials are saved**: If this option is enabled and logon data are already saved in the browser, the user will not be asked for a user name and password.

![Warning](image)

This option should not be enabled in multiuser environments. If this option is enabled in a multiuser environment, a user can use the logon data of a previous user.

**Automatic proxy configuration**

With this proxy configuration, the PAC file (Proxy Auto Config) available under URL will be used.

• **URL**: URL of the proxy configuration file

• **Do not prompt for proxy authentication if credentials are saved**: If this option is enabled, the user will not be prompted to enter a user name and password if the logon data are already saved in Firefox.

![Warning](image)

This option should not be enabled in multiuser environments. If this option is enabled in a multiuser environment, a user can use the logon data of a previous user.
System-wide proxy configuration

With this proxy configuration, the proxy configured under Setup > Network > Proxy will be used.

- Do not prompt for proxy authentication if credentials are saved: If this option is enabled, the user will not be prompted to enter a user name and password if the logon data are already saved in Firefox.

  This option should not be enabled in multiuser environments. If this option is enabled in a multiuser environment, a user can use the logon data of a previous user.

Automatically recognize proxy configuration for this network

With this proxy configuration, WPAD (Web Proxy Autodiscovery Protocol) will be used. The browser will determine the URL of the WPAD file wpad.dat automatically with the help of DNS.

Privacy

Menu path: Setup > Sessions > Browser > Browser Global > Privacy

In this area, you can configure settings relevant to data protection.

- Store Browsing History (in days): Specifies how long your browsing history will be stored. If you select Do not save History, all browsing history data will be lost when the browser restarts.

  All browsing history data stored before the period specified here will be lost.

- Save information entered in forms and the Search Bar: If this option is enabled, entries in forms and search bars will be retained after the browser restarts.
- Remember passwords: If this option is enabled, entered passwords will be retained after the browser restarts.
- Clear private data when closing browser: If this option is enabled, any data entered will be deleted when the browser is closed. What data are deleted is specified in the following options.

Select the items to be cleared

- Browsing & Download History: If this option is enabled, the addresses (URLs) of visited websites and the list of downloads will be deleted when the browser is closed.
- Form & Search History: If this option is enabled, entries in the search window and in website forms will be deleted when the browser is closed.
- Saved Passwords: If this option is enabled, any passwords entered will be deleted when the browser is closed.
- Cookies: If this option is enabled, any cookies will be deleted when the browser is closed.
- Cache: If this option is enabled, the cache for temporarily saving websites will be deleted when the browser is closed.
- Active Logins: If this option is enabled, ongoing sessions on websites will be terminated when the browser is closed and will need to be restarted after the browser restarts.
- Allow private browsing feature: If this option is enabled, you can open one or more private windows in the browser. All data from private windows will be deleted after the browser is closed.
- Always start in private browsing mode: if this option is enabled, the browser will be launched in private mode. All data will be deleted after the browser is closed.
• Enable "Do Not Track" feature: If this option is enabled, the browser will inform the website you are visiting that you do not wish to be tracked, i.e. you do not want your surfing history to be recorded.

The browser will use the DNT ("Do Not Track") field in the HTTP header for this purpose. Observing this setting is voluntary; from a technical point of view, websites can still record the surfing history even when DNT is set to 1.

• Enable built-in tracking protection: If this option is enabled, the browser will block specific domains and websites which use tracking. The browser has an internal list for selecting the domains and websites to be blocked.

If tracking protection is enabled, a shield symbol will be shown at the left-hand edge of the address bar.

• Suggest visited sites in URL bar: If this option is enabled, suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on previously visited websites which are stored in the history.
  - Suggest only typed visited sites: If this option is enabled, the suggestions will be based only on the websites that were typed directly into the address bar. Websites that were visited via bookmarks or links in other websites will not be used for the suggestions.
• Suggest bookmarked sites in URL bar: If this option is enabled, suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on bookmarks.
• Suggest open pages in URL bar: If this option is enabled, suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on previously opened tabs.

Security

Menu path: Setup > Sessions > Browser > Browser Global > Security

In this area, you can define settings for phishing and malware.

• Safe Browsing: If this option is enabled, the browser will check each address entered as to whether it can be found in the black list of fraudulent websites which use phishing. If this is the case, you will be given a warning.
• Malware Protection: If this option is enabled, the browser will check whether the relevant website can be found in the black list of fraudulent websites which provide malware for downloading before a file is downloaded. If this is the case, you will be given a warning.

Advanced

Menu path: Setup > Sessions > Browser > Browser Global > Advanced

In this area, you can change various settings as well as add or change user-defined configuration parameters.

You can change the following settings:

• Use old searchbar: If this option is enabled, the logo of the search engine currently set will be shown in the search window. If this option is disabled, the search engine currently set will not be shown in the search window and search suggestions will be shown in the drop-down menu.
• Always use the cursor keys to navigate within pages: If this option is enabled, caret browsing will be enabled when the browser is launched. If caret browsing is enabled, you can navigate with the keyboard in websites without using the mouse. With the insertion mark, you can copy text to the clipboard.

You can enable or disable caret browsing at any time by pressing F7. To prevent caret browsing being disabled, you will also need to enable the Setup > Sessions > Browser > Browser Sessions > [session name] > Settings > Hotkeys > Disable Hotkeys for Starting Caret Browsing option.

• Find As You Type: If this option is enabled, search suggestions which match the characters typed will be shown while you type.

• Warn me when websites try to redirect or reload the page: If this option is enabled, a message window will be shown as soon as a website tries to get the browser to load another website or reload the current website.

• Check my spelling as I type
   Possible values:
   - Off: Your spelling will not be checked while you type.
   - On for multi-line controls: Your spelling will be checked if you are typing in text fields with multiple lines.
   - On for multi- and single-line controls: Your spelling will be checked if you are typing in text fields with one line or multiple lines.

• Use autoscrolling: If this option is enabled, you can launch automatic page scrolling by clicking on the middle mouse button to place a scroll symbol in the text and then positioning the mouse pointer above or below the anchor.

• Use smooth scrolling: If this option is enabled, you can browse through a page using the Page Up/Down keys smoothly as with scrolling. If the option is disabled, the display will jump immediately when you press the Page Up/Down keys.

• Disable GStreamer in Browser: If this option is enabled, GStreamer will not be used to play back videos. This may be a good idea if you experience problems when playing back videos.

We recommend that you disable this option if there is no multimedia codec pack installed on your thin client and you wish to view videos on HTML5 websites.

• Disable OpenGL acceleration: If this option is enabled, hardware acceleration with OpenGL will not be used. This may be a good idea if you experience problems with OpenGL applications.

To add a user-defined configuration parameter, proceed as follows:

Changes to the advanced Firefox browser settings can impair its stability, security and speed. IGEL Support is not responsible for problems caused by changing the browser configuration, even if the browser configuration was changed in the IGEL setup.

The configuration parameters can also be changed in the browser via about:config. To do this, the Browser Sessions > [Session Name] > Window Settings > Hide Browser Configuration Page option must be disabled.

1. In the Custom preferences area, click on 🌟.
2. Using the Active option, specify whether the configuration parameter is to be active.
3. Specify the Mode of the configuration parameter.
   Possible values:
   - `pref`: You can change the value in the browser via `about:config`. When the browser restarts, this change will be lost and the value set here will be used.
   - `defaultPref`: You can change the value in the browser via `about:config`. When the browser restarts, this change will remain.
   - `lockPref`: You cannot change the value in the browser via `about:config`.
   - `clearPref`: You cannot change the value in the browser via `about:config` and the value will not be shown via `about:config`.

4. Under Custom preference, give the name of the configuration parameter. Example:
   `ui.textSelectBackground`

5. Specify the Type of the configuration parameter.
   Possible values:
   - `String`: The value is a string of characters.
   - `Integer`: The value is a whole number.
   - `Boolean`: The value is a Boolean value, i.e. `true` or `false`.

6. Specify the Value of the configuration parameter. The possible entries depend on the Type selected.

7. Click on Ok.
   The configuration parameter will take effect the next time that the browser is launched.

You will find information regarding the configuration parameters in Firefox in the MozillaZine Knowledge Base under `Firefox About:config entries` (http://kb.mozillazine.org/About:config_entries).
Commands

Menu path: Setup > Sessions > Browser > Browser Global > Commands

In this area, you can define commands for the browser.

- Click on a command in order to enable the Edit button.

![Commands Setting](image)

Figure 19: Commands setting

Encryption

Menu path: Setup > Sessions > Browser > Browser Global > Encryption

In this area, you can define the settings for encryption methods and certificate validation.

- **Minimum required encryption protocol:** This protocol will be used to establish a secure connection if no higher protocol is available. Higher protocols are preferred.
- **Maximum supported encryption protocol:** This protocol is requested when negotiating the connection. If this protocol is not available, the next lowest protocol will be requested.
- **If a website requires a certificate:** Specifies how the browser behaves if a website requests a security certificate.
  
  Possible values:
  - Select one automatically: The browser selects a certificate automatically.
  - Ask me every time: A dialog window requesting the certificate will be displayed.
  - View Certificates: If you click on this button, the certificates saved in the browser's Certificate Manager will be displayed.
• Certificate Validation: Specifies the validation of certificates using OCSP (Online Certificate Status Protocol).
  - Do not use OCSP for certificate validation: The certificate will not be validated using OCSP.
  - Validate a certificate if it specifies an OCSP server: The certificate will be validated with the OCSP server specified in the certificate. If no OCSP server is specified, no certificate validation will take place.
  - Validate all certificates using the following OCSP server: All certificates will be validated with the OCSP server specified under the Service URL, irrespective of which OCSP server is specified in the certificate.

• Response signer: Signer of the response from the OCSP server
• Service URL: URL of the OCSP server
• When an OCSP server connection fails, treat the certificate as invalid: If, owing to a failed connection to the OCSP server, no validation can take place, the certificate will be treated as invalid. In this case, the browser will show the This connection is not trusted error message.
• Use "Gemalto/SafeNet eToken" Security Device: If this option is enabled, Gemalto/SafeNet eToken will be used for encryption.
• Use "Gemalto" Security Device: If this option is enabled, Gemalto will be used for encryption.
• Use "IDProtect" Security Device: If this option is enabled, Athena IPProtect will be used for encryption.
• Use "SafeSign" Security Device: If this option is enabled, SafeSign will be used for encryption.
• Use "SecMaker" Security Device: If this option is enabled, SecMaker will be used for encryption.
• Use TCOS 3 NetKey Security Device: If this option is enabled, TCOS 3 NewKey will be used for encryption.
• Use TCOS 3 SigG Security Device: If this option is enabled, TCOS 3 SigG will be used for encryption.
• Use TCOS 3 Elster Security Device: If this option is enabled, TCOS 3 Elster will be used for encryption.
• Use TCOS 3 SD Security Device: If this option is enabled, TCOS 3 SD will be used for encryption.

7.27.2. Browser Sessions

Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name]

In this area, you can configure desktop integration for the browser session.

• Session name: Name for the session

The session name must not contain any of these characters:
\ / : * ? " < > | [ ] { } ( )

Session start options

• Start menu
  ✔ The session can be started with the start menu.
• Application Launcher
  ✔ The session can be started with the Application Launcher.
• Desktop:
  ✔ The session can be started with a program starter on the desktop.
• Quick start panel:
  - The session can be started with the quick start panel.

• Start menu’s system tab
  - The session can be started with the start menu’s system tab.

• Application Launcher’s system tab
  - The session can be started with the Application Launcher’s system tab.

• Desktop context menu
  - The session can be started with the desktop context menu.

• Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

• Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.

• Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

• Password protection: Specifies which password will be requested when launching the session.
  Possible values:
  - None: No password is requested when launching the session.
  - Administrator: The administrator password is requested when launching the session.
  - User: The user password is requested when launching the session.
  - Setup user: The setup user's password is requested when launching the session.

• Hotkey:
  - The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

• Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g. Ctrl. Here, you will find the available modifiers and the associated key symbols:
  - (No modifier) = None
  - Shift = Shift
  - Ctrl = Ctrl
  - Super_L = Super_L
  - Alt = Alt

  Key combinations are formed as follows with |:
  - Ctrl + Super_L = Ctrl|Super_L

• Key: Key for the hotkey

  To enter a key that does not have a visible character, e.g. the Tab key, open a terminal, log on as user and enter xev -event keyboard. Press the key to be used for the hotkey. The text in brackets that begins with keysym contains the key symbol for the Key field. Example: Tab in (keysym 0xff09, Tab)

• Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.

• Relaunch: If this option is enabled, the session will be relaunched automatically after termination.
• Autostart delay: Waiting time in seconds between the thin client booting and the session being launched automatically.

**Settings**

Menu path: Setup > Browser > Browser Sessions > [Session Name] > Settings

In this area, you can define the start page, display resolution and font size for the browser.

You can change the following settings:

• **When browser starts**: Specifies what pages are shown when the browser is launched.
  - Global setting: The settings under Setup > Sessions > Browser > Browser Global are used.
  - Start with a blank page
  - Show my home page
  - Resume previous session: All tabs from the last session are reopened.

• **Home page**: Specifies the URL of the start page. You can specify a number of start pages by separating the URLs of the start pages with a pipe character "|".

• **Display resolution**: Specifies the display resolution for the browser in DPI. Typical values are 72 for medium screens and 96 for large screens.

• **Minimum font size**: Specifies the minimum size of the fonts displayed on websites. The formats of the websites are overwritten in the process.

**Tabs**

Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Tabs

In this area, you can define settings for the browser tabs. You will find a description under the global settings, see *Tabs* (page 117).

**Content**

Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Content

You will find a description under the global settings, see *Content* (page 117).

 Exceptions for the blocking of popups and for the automatic loading of images can only be defined in the global settings.

**Printing**

Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Printing

In this area, you can set the default paper size for the printer. You will find a description under the global settings, see *Printing* (page 118).

**Proxy**

Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Proxy

In this area, you can change the proxy configuration. You will find a description under the global settings, see *Proxy* (page 119).
Data Protection
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Data Protection
In this area, you can configure settings relevant to data protection. You will find a description under the global settings, see Data Protection (page 121).

Security
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Security
In this area, you can define settings for phishing and malware. You will find a description under the global settings, see Security (page 122).

Advanced
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Advanced
In this area, you can change various settings. You will find a description under the global settings, see Advanced (page 122).

User-defined configuration parameters can only be added and OpenGL acceleration disabled in the global settings.

Encryption
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Encryption
In this area, you can define the settings for encryption methods and certificate validation. You will find a description under the global settings, see Encryption.

Restarting
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Restarting
In this area, you can specify whether the browser is restarted after being closed and after what delay time.

- Restart: If this option is enabled, the browser will be restarted automatically after being closed.
- Restart Timeout enabled: If this option is enabled, the browser will be restarted automatically if, after the time interval defined under Time limit for restarting, no action on the part of the user has occurred.
- Restart Timeout: Time interval in minutes after which the browser is automatically restarted if in the meantime no action on the part of the user has occurred.
### Window settings

**Menu path:** Setup > Sessions > Browser > Browser Sessions > Window

In this area, you can define the window settings for a browser session.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start in Fullscreen Mode</td>
<td></td>
</tr>
<tr>
<td>Start Monitor</td>
<td>1st monitor</td>
</tr>
<tr>
<td>Firefox Translation</td>
<td>System setting</td>
</tr>
<tr>
<td>Hide local filesystem</td>
<td></td>
</tr>
<tr>
<td>Hide configuration page of the browser</td>
<td></td>
</tr>
</tbody>
</table>

![Image of Window settings](image)

**Figure 20: Window settings**

The full-screen mode is disabled by default.

- Check the checkbox in order to enable the full-screen mode.
  
  If you have connected a number of monitors, you can specify the start monitor here.

- Under Firefox translation, select the language that the Firefox user interface is to be translated into.

- Enable Hide local filesystem if you do not want the local structure to be displayed when you save files.

- Disable Hide configuration page of the browser if you would like the configuration page of the browser to be displayed for editing.
Menus and symbol bars

Menu path: Setup > Sessions > Browser > Browser Sessions > Menus & Toolbars

In this area, you can adapt Firefox menus and symbol bars to meet your personal needs by

- Hiding items in the menu bar
- Hiding list items
- Configuring the symbol bar

➢ Enable User customization of tool bars in order to allow the user to configure symbol bars.

➢ Configure the navigation symbol bar.
   The following items are pre-set:

![Figure 21: Navigation symbol bar](image1)

➢ Configure the Application menu:
   The following items are pre-set:

![Figure 22: Application menu](image2)
Please note that a number of items are only shown if the corresponding feature is enabled.

➢ Configure the Application menu:

➢ Other possible items for the navigation symbol bar and the application menu are:

- Loop button
- Zoom controls
- Edit controls
- History panel menu
- Private browsing button
- Save page button
- Find button
- Open file button
- Developer button
- Sidebar button
- Feed button
- Print button
- Character encoding button
- Social share button
- Panic button
- Web apps button
- New window button
- Fullscreen button
- Tab view button
- Downloads button
➢ Click on Reset icon configuration to default in order to undo your changes.

Hotkeys

Menu path: Setup > Sessions > Browser > Browser Sessions > Hotkeys

In this area, you can disable the following Firefox hotkeys:

<table>
<thead>
<tr>
<th>Disable the following Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Hotkey Quit/Close</td>
</tr>
<tr>
<td>Disable Hotkey for Print dialog</td>
</tr>
<tr>
<td>Disable Hotkey for save page</td>
</tr>
<tr>
<td>Disable Hotkeys for open new window/tab</td>
</tr>
<tr>
<td>Disable Hotkeys for open new webpage/location and download window</td>
</tr>
<tr>
<td>Disable Hotkeys to show history and page info</td>
</tr>
<tr>
<td>Disable Hotkeys for creating bookmarks</td>
</tr>
<tr>
<td>Disable Hotkeys for opening help pages</td>
</tr>
<tr>
<td>Disable Hotkeys for caret browsing</td>
</tr>
</tbody>
</table>

Figure 23: Hotkeys settings

Context menu

Menu path: Setup > Sessions > Browser > Browser Sessions > Context

In this area, you can disable various items in the browser context menu.

<table>
<thead>
<tr>
<th>Disable the following Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable button for save page</td>
</tr>
<tr>
<td>Disable button for open new window/tab</td>
</tr>
<tr>
<td>Disable button to show infobar/source</td>
</tr>
<tr>
<td>Disable button for creating and editing bookmarks</td>
</tr>
<tr>
<td>Disable button for searching the web</td>
</tr>
<tr>
<td>Hide the browser's context menu</td>
</tr>
</tbody>
</table>

Figure 24: Context menu settings
7.27.3. Browser Plug-ins

Menu path: Setup > Sessions > Browser > Plugins

Various plug-ins are available, such as a
- PDF viewer
- Adobe Flash Player
- Red Hat Spice

However, they may need to be licensed by the user first. Integration of the SecMacer security solution Net iD can also be configured here.

Integration of the SecMacer security solution Net iD can also be configured here Media Player Global>Browser Plug-in (page 137).

Flash Player

Menu path: Setup > Sessions > Browser > Plugins > Flashplayer

Before you can download and install Adobe Flash Player, you need to confirm that the software is licensed - IGEL Universal Desktop Linux does not contain a license to use the Flash Player.

➢ Activate the option I will license the flashplayer by myself to activate the Download Flashplayer page.

To install Adobe Flash Player:

1. Navigate to the Download Flashplayer page.
2. Activate the option I want to download Adobe flashplayer and care about the licensing by myself.
3. Adjust the following settings:
   - Use Firmware Update settings for download: If the option is activated, the parameters User authentication, User name, Password, and Download URL are set to the default values and cannot be changed.
   - User authentication: If the option is activated, the thin client authenticates with the server using the access data provided in User name and Password.
   - Download URL: URL of the directory in which the Adobe Flash Player is stored. The default value is the official link from Adobe. Alternatively, you can provide the storage location in your company network.

   The Adobe link is valid at the time when the firmware is released, but it is subject to change. In case the download fails, modify the URL accordingly.

   - Download File: Name of the file containing the Adobe Flash Player.
4. Click Apply or Ok.

The Adobe Flash Player is downloaded and installed.
PDF viewer

Menu path: Setup > Sessions > Browser > Plugins > PDF Viewer

Here, you can specify whether PDF documents are to be embedded in the browser or displayed in a separate window.

RHEV/Spice

Menu path: Setup > Sessions > Browser > Plugins > RHEV/Spice

In this area, you can define settings for virtual environments.

➢ Enable browser plugin in order to display virtual desktop environments everywhere via the Internet.

➢ Enable or disable USB sharing.

7.28. Media Player

Menu path: Setup > Sessions > Media Player

Set up the Media Player for your multimedia applications here.

IGEL Linux supports the following multimedia formats and codecs out of the box:

• Ogg/Vorbis
• Ogg/Theora
• WAV
• FLAC

The following codecs are licensed via the separately available Multimedia Codec Pack:

<table>
<thead>
<tr>
<th>Supported formats:</th>
<th>Supported codecs:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVI</td>
<td>MP3</td>
</tr>
<tr>
<td>MPEG</td>
<td>AAC</td>
</tr>
<tr>
<td>ASF (restricted under Linux)</td>
<td>WMA stereo</td>
</tr>
<tr>
<td>WMA</td>
<td>WMV 7/8/9</td>
</tr>
<tr>
<td>WMV (restricted under Linux)</td>
<td>MPEG 1/2</td>
</tr>
<tr>
<td>MP3</td>
<td>MPEG4</td>
</tr>
<tr>
<td>OGG</td>
<td>H.264</td>
</tr>
</tbody>
</table>

AC3 is not licensed.
IGEL Zero Clients (IZ series) have the Multimedia Codec Pack installed by default.

On IGEL Linux 5.06.100 and newer hardware accelerated playback is available on selected devices. Find further information in an FAQ (http://edocs.igel.com/#10201440.htm) document.

### 7.28.1. Media Player Global

**Menu path:** Setup > Sessions > Media Player > Media Player Global

- Configure universal settings which will apply by default during all Media Player sessions.

You can override global settings in the individual sessions.

### Window

**Menu path:** Setup > Sessions > Media Player > Media Player Global > Window

- Under Image Aspect Ratio, specify the required aspect ratio for video playback. You can also choose the following options:
  - Full-screen mode
  - Automatically change window size as soon as a new video is loaded
  - Main window should remain in the foreground
  - Show operating components

### Playback

**Menu path:** Setup > Sessions > Media Player > Media Player Global > Playback

- Specify how you would like to play back media files:

<table>
<thead>
<tr>
<th>Endless loop</th>
<th>Automatically plays back a play list endlessly until you stop it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random mode</td>
<td>Plays back the files in a play list in a random order.</td>
</tr>
</tbody>
</table>

- If you wish, choose the visual effects to be used during audio playback.

<table>
<thead>
<tr>
<th>Visualization type</th>
<th>Determines the visualization plug-in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visualization size</td>
<td>Determines the visualization size.</td>
</tr>
</tbody>
</table>
Video
Menu path: Setup > Sessions > Media Player > Media Player Global > Video

<table>
<thead>
<tr>
<th>Video output</th>
<th>GConf:</th>
<th>System-wide configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto:</td>
<td>Automatically selects the output</td>
<td></td>
</tr>
<tr>
<td>XVideo:</td>
<td>Hardware-accelerated, uses shared memory to write images to the graphics card memory</td>
<td></td>
</tr>
<tr>
<td>X11:</td>
<td>Not hardware-accelerated, playback via the X Window System display protocol</td>
<td></td>
</tr>
</tbody>
</table>

➢ Specify the brightness, saturation, contrast and color settings for videos.

Audio
Menu path: Setup > Sessions > Media Player > Media Player Global > Audio

<table>
<thead>
<tr>
<th>Audio output</th>
<th>GConf:</th>
<th>System-wide configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto:</td>
<td>Automatically selects the output</td>
<td></td>
</tr>
<tr>
<td>ALSA:</td>
<td>Direct output via kernel driver for sound cards</td>
<td></td>
</tr>
<tr>
<td>Audio output type</td>
<td>Select Stereo if you are working with an IGEL thin client.</td>
<td></td>
</tr>
</tbody>
</table>

Options
Menu path: Setup > Sessions > Media Player > Media Player Global > Options

➢ Specify whether you would like to disable the screen saver during audio playback.

➢ Specify the network connection speed in order to influence media file playback.

➢ Specify the necessary buffer size for your network in order to ensure smooth audio and video playback.

➢ Specify whether you would like to automatically load subtitles as soon as a video begins. Currently, the coding for subtitles is always UTF-8.

➢ Specify the font and text size for the subtitles.

Browser Plugin
Menu path: Setup > Sessions > Media Player > Media Player Global > Browser Plugin

If you would like to use the Media Player as a Browser Plugin, you can change the configuration values here.

This will affect manually configured Media Player sessions.
7.28.2. Media Player Sessions

Menu path: Setup > Sessions > Media Player > Media Player Sessions

You can set up your own personal Media Player sessions here.

1. Click on Add to create a new session.
2. Specify a session name.
3. Specify which possible ways of launching the session you would like. You may choose a number of options here.
4. You may like to select the option of using hotkeys and define them.
5. You can also specify whether autostart (following a system start) and/or restart (after a connection is established) are to be used.
6. For the autostart option, you can also specify by how many seconds the session start is to be delayed.

As soon as you have set up a Media Player session of your own, it will appear in the structure tree under the Media Player Sessions directory. Your own session in turn contains three folders: Playback, Options and Desktop Integration.

Playback

Menu path: Setup > Sessions > Media Player > Media Player Sessions > [Session name] > Playback

➢ Under Medium / File, give the path of the file which is to be played back when the session is launched.
  Use the following formats:
  /directory/filename
  or
  http://servername/filename.

For the window settings, you can choose whether you would like to carry over the global settings or use your own settings for this special session.

Options

Menu path: Setup > Sessions > Media Player > Media Player Sessions > [Session name] > Options

If necessary, you can change the pre-configured settings for the operating components here.

7.29. Java Web Start Session

Menu path: Setup > Sessions > JWS Sessions

You can set up one or more Java Web Start sessions. This can be for example an IGEL UMS console running as Java Web Start.

To set up a Java Web Start session, proceed as follows:

1. In the JWS Sessions area, click on 🌟.
   A new Java Web Start session will be created.
2. Configure the Java Web Start session. You will find further information under Java Web Start Session (page 139).
7.29.1. Java Web Start

Menu path: Setup > Sessions > JWS Sessions > Java Web Start

You can change the following settings:

- Session Name: Name of the Java Web Start session.
- Start Menu: If this option is enabled, the Java Web Start session can be launched in the start menu.
- Application Launcher: If this option is enabled, the Java Web Start session can be launched with the Application Launcher.
- Desktop: If this option is enabled, the Java Web Start session can be launched with a program launcher on the desktop.
- Quick Start Panel: If this option is enabled, the Java Web Start session can be launched in the Quick Start Panel.
- Start Menu's System tab: If this option is enabled, the Java Web Start session can be launched in the start menu's system tab.
- Application Launcher's system tab: If this option is enabled, the Java Web Start session can be launched in the Application Launcher's system tab.
- Desktop Context Menu: If this option is enabled, the Java Web Start session can be launched in the desktop context menu.
- Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the Java Web Start session. The menu path will be used in the start menu and in the desktop context menu. Example: "Functions/Screen functions".
- Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the Java Web Start session. The menu path will be used for the program launcher on the desktop. Example: "Functions/Screen functions".
- Password Protection: Specifies the password request when launching the Java Web Start session.
  Possible values:
  - None: No password is requested when launching the Java Web Start session.
  - Administrator: The administrator password is requested when launching the Java Web Start session.
  - User: The user password is requested when launching the Java Web Start session.
  - Setup User: The setup user's password is requested when launching the Java Web Start session.
- Hotkey: Specifies a hotkey consisting of modifiers and a key which can be used to launch the Java Web Start session.
- Modifiers: One or two modifiers for the hotkey
- Key: Key for the hotkey
- Autostart: If this option is enabled, the Java Web Start session will be launched automatically when the thin client boots.
- Autostart Delay: Waiting time in seconds between the thin client booting and the Java Web Start session being launched automatically.
Java Web Start

Menu path: Setup > Sessions > JWS Sessions > Java Session

In this area, give the address of the JNLP file which is needed for launching the Java Web Start session. The file is loaded into the cache before being executed.

- JNLP file: Address of the JNLP file. Example: http://www.server.com/example.jnlp

7.30. VoIP Client

Menu path: Setup > Sessions > VoIP Client

IGEL Linux includes the Ekiga voice over IP client (http://ekiga.org). This client allows you to use the SIP (Session Initiation Protocol) and H.323.


In this area, you can configure desktop integration for the VoIP session.

- Session name: Name for the session

The session name must not contain any of these characters:

\ / : * ? " | < > [ ] { } ( )

Session start options

- Start menu
  - The session can be started with the start menu.
- Application Launcher
  - The session can be started with the Application Launcher.
- Desktop:
  - The session can be started with a program starter on the desktop.
- Quick start panel:
  - The session can be started with the quick start panel.
- Start menu’s system tab
  - The session can be started with the start menu’s system tab.
- Application Launcher’s system tab
  - The session can be started with the Application Launcher’s system tab.
• Desktop context menu
  - The session can be started with the desktop context menu.

• Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

• Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.

• Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

• Password protection: Specifies which password will be requested when launching the session.
  Possible values:
  - None: No password is requested when launching the session.
  - Administrator: The administrator password is requested when launching the session.
  - User: The user password is requested when launching the session.
  - Setup user: The setup user's password is requested when launching the session.

• Hotkey:
  - The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

• Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g. Ctrl. Here, you will find the available modifiers and the associated key symbols:
  - (No modifier) = None
  - ↓ = Shift
  - Ctrl= Ctrl
  - = Super_L
  - Alt= Alt

  Key combinations are formed as follows with |:
  - Ctrl + = Ctrl|Super_L

• Key: Key for the hotkey

  To enter a key that does not have a visible character, e.g. the Tab key, open a terminal, log on as user and enter xev -event keyboard. Press the key to be used for the hotkey. The text in brackets that begins with keysym contains the key symbol for the Key field. Example: Tab in (keysym 0xff09, Tab)

• Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.

• Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

  Autostart delay: Waiting time in seconds between the thin client booting and the session being launched automatically.
7.30.1. User Account

Menu path: Setup > Sessions > VoIP Client > User Account

You can set up or change one or more user accounts as well as specify the name displayed.

- Full Name: Name of the user; this name will be shown to the other person. Example: John Doe

To set up an SIP user account, proceed as follows:

1. Click ⭐.
2. If the user account is to be active once set up, enable the Enable Account option.
3. Enter the following data:
   - Protocol: Select SIP.
   - Name: Name for this user account.
     Choose a name which allows a distinction to be made easily between a number of user accounts.
   - Registrar: URI with which the VoIP client registers. This can be a DNS name or an IP address.
   - User name: Numerical or alphanumerical value. The user name is part of the SIP address. Example: john.doe
   - Login Name: Numerical or alphanumerical value. Name with which the VoIP client registers on the registrar. This name can differ from the name given under user name.
   - Password: Password with which the VoIP client registers on the registrar
   - Registration Update Timeout: Timeout after which the registration should be updated
4. Click Ok.
   The user account has been set up.

7.30.2. Audio

Menu path: Setup > Sessions > VoIP Client > Audio

You can change the audio settings of the VoIP client.

Recommendation: Configure the settings Device for ringtone, Device for audio playback and Device for audio recording in the VoIP client. All available audio devices of the thin client are shown in the VoIP client.

To configure the audio devices in the VoIP client, proceed as follows:

1. In the IGEL setup, ensure that the option Save configuration changes made in the application is enabled under Sessions > VoIP Client > Preferences.
2. Start the VoIP client.
3. Configure your desired settings in the VoIP client under Edit > Preferences > Audio > Devices.
4. To save your settings, close the VoIP client window, right-click on 📲 in the system tray and select Close.

The changes will be saved in the IGEL setup once the VoIP client is terminated.

Settings in the setup:

- **Sound Event Output Device**: Specifies which audio device is used for the ringtone.

  It is recommended that you select the audio device that is connected to the thin client’s built-in loudspeaker.

- **Audio Output Device**: Specifies which audio device is used for playback. Example: the audio device that is connected to the headset’s loudspeakers.

- **Audio Input Device**: Specifies which audio device is used for playback. Example: the audio device that is connected to the headset’s microphone.

- **Enable Silence Detection**: If this option is enabled, audio transmission will be suppressed in the absence of voice activity. This helps to save bandwidth.

  Voice activity detection can reduce the voice quality.

- **Enable Echo Cancelation**: If this option is enabled, the VoIP client will suppress echoes of your own voice.

- **Maximum Jitter Buffer (in Milliseconds)**: The jitter buffer improves voice quality by compensating for delay variations when transmitting voice packets. The VoIP client continuously measures delay variations and automatically adjusts the buffer size. The bigger the delay variations are, the bigger the jitter buffer will be set.

  A bigger jitter buffer results in greater latency.

7.30.3. **SIP**

Menu path: Setup > Sessions > VoIP Client > SIP

You can change SIP-specific settings for the proxy, forwarding and the multi-frequency dialing process (DTMF).

- **Outbound Proxy**: URI of the SIP proxy that handles outbound calls.

- **Forward URI**: SIP URI to which inbound calls are forwarded if forwarding is enabled. You will find further information on forwarding under **Call Options** (page 144).

- **Send DTMF as**: Specifies how key sequences are transmitted while a connection is in place.

  Possible values:
  - INFO: The key sequence is transmitted as SIP INFO.
  - RFC 2833: The key sequence is transmitted using RTP (Real-time Transport Protocol).
7.30.4.  H.323

Menu path: Setup > Sessions > VoIP Client > H.323

You can change H.323-specific settings for forwarding, H.245, quick start and for the multi-frequency dialing process (DTMF).

- **Forward URI**: H.323 URI to which inbound calls are forwarded if forwarding is enabled. You will find further information on forwarding under Call Options (page 144).
- **Enable H.245 tunneling**: If this option is enabled, H.245 messages will be packaged in H.225 messages. Port 1720 is needed for this purpose.
- **Enable early H.245**: If this option is enabled, H.245 will be launched at an earlier point in the connection process. The voice connection can be established more quickly as a result.
- **Enable Fast Start procedure**: If this option is enabled, the voice connection will be established in quick start mode (fast connect, part of H.323 v2).
- **Send DTMF as**: Specifies how key sequences are transmitted while a connection is in place.
  - **String**: The key sequence is transmitted using H.245 User Input Indication.
  - **Tone**: The key sequence is transmitted as a tone sequence in the audio data flow.
  - **RFC 2833**: The key sequence is transmitted using RTP (Real-time Transport Protocol).
  - **Q.931**: The key sequence is transmitted via the signaling channel.

7.30.5.  Call Options

Menu path: Setup > Sessions > VoIP Client > Call Options

You can change settings for inbound calls.

- **Always forward calls to the given address**: If this option is enabled, inbound calls will immediately be forwarded to the address defined in Setup > Sessions > VoIP Client > SIP > Foward URI (see SIP) or Setup > Sessions > VoIP Client > H.323> Forward URI (see H.323 (page 144)).
- **Forward calls to the given address if no answer**: If this option is enabled, inbound calls will be forwarded to the address defined in Setup > Sessions > VoIP Client > SIP > URI for Forwarding (see SIP) or Setup > Sessions > VoIP Client > H.323> URI for Forwarding (see H.323 (page 144)) after the time specified under Time limit for calls not taken. If this option is disabled, inbound calls will be rejected after the time specified under Time limit for calls not taken.
- **Forward calls to the given address if busy**: If this option is enabled, inbound calls during a call will be forwarded to the address defined in Setup > Sessions > VoIP Client > SIP > URI for Forwarding (see SIP) or Setup > Sessions > VoIP Client > H.323> URI for Forwarding (see H.323 (page 144)).
- **No Answer Timeout**: Time in seconds after which calls not taken are rejected or forwarded.

7.30.6.  Phone Book

Menu path: Setup > Sessions > VoIP Client > Telephone Book

You can add one or more LDAP address books or local contacts.

To add an LDAP address book, proceed as follows:

1. In the List of LDAP address books area, click on .
2. Enter the following data:
   - **Name**: Name with which the LDAP address book will be displayed in the VoIP client
   - **Server Name**: Host name of the LDAP server
   - **Port**: Port for the connection to the LDAP server
   - **Basis DN**: Basis for the search in the LDAP tree
   - **Scope**: Area for the LDAP search
   - **Display Name Attribute**: LDAP attribute that is displayed as the name of the contact in the VoIP client. Example: `cn`
   - **Call Attribute**: LDAP attribute that contains the telephone number.
   - **Filter Template**: Filter for the LDAP search
   - **Bind ID**: Identifier for the LDAP search. This identifier is sent to the LDAP server in a BIND request.
   - **Password**: Password for the user account for the LDAP search

3. Click on **Ok**.

To add a contact to the local contact list, proceed as follows:

1. In the **List of Contacts** area, click on 🌟.

2. Enter the following data:
   - **Name**: Name of the SIP or H.323 address displayed
   - **Address**: SIP or H.323 address. Example: `sip:500@example.com`
   - **Group**: Optional group name in order to group contacts

### 7.30.7. Settings

**Menu path:** Setup > Sessions > VoIP Client > Settings

You can change VoIP client settings.

- **Save configuration changes made in the application**: If this option is enabled, changes made in the VoIP client will be saved in the IGEL setup when the VoIP client is terminated. This applies to all settings available in the IGEL setup, with the exception of settings for the LDAP address book.

### 7.30.8. Desktop Integration

**Menu path:** Setup > Sessions > VoIP Client > Desktop Integration

In this area, you can configure desktop integration for the VoIP client session, see **VoIP Client** (page 140).
8. Accessories

Menu path: Setup > Accessories

Information on other accessories provided by the Universal Desktop can be found here.

8.1. ICA Connection Center

Menu path: Setup > Accessories> ICA Connection Center

The Citrix ICA Connection Center provides an overview of existing connections to Citrix servers. It also allows the server connection to be terminated/canceled and the connection properties to be displayed, e.g. for support purposes.

8.2. Local Terminal

Menu path: Setup > Accessories> Terminals

With a terminal session, you can execute local commands via a shell.

It is also possible to access a local shell without a terminal session: You can switch to the virtual terminals tty11 and tty12 by pressing `Ctrl+Alt+F11` / `Ctrl+Alt+F12`.

8.3. Change Smartcard Password

Menu path: Setup > Accessories> Change Smartcard Password

Set up a session in order to change your IGEL smartcard password. Details of the setup procedure for your IGEL smartcard can be found under Security > Login > Smartcard.

8.4. Setup

Menu path: Setup > Accessories> Setup

Specific areas of the setup can be made available to the user, even if the overall setup can only be accessed by the administrator. This is useful for example for keyboard and mouse settings or for screen configuration. See Enable Setup Pages for Users (page 24).
8.5. User Page Permissions

Menu path: Setup > Accessories > Quick Setup

Specific areas of the setup can be made available to the user, even if the overall setup can only be accessed by the administrator. This is useful for example for keyboard and mouse settings or for screen configuration. See Quick Setup.

8.6. Display switch

Menu path: Setup > Accessories > Display Switch

With this function, you can configure the display on several screens. For details of how to set the function, see Options (page 149). For details of how to use the function, see Using "Display Switch" function (page 150).

The settings for starting the function are described below.

• Session name: Name for the session

⚠️ The session name must not contain any of these characters:
\ / : * ? “ < > | [ ] { } ( )

Session start options

• Start menu
  ✓ The session can be started with the start menu.

• Application Launcher
  ✓ The session can be started with the Application Launcher.

• Desktop:
  ✓ The session can be started with a program starter on the desktop.

• Quick start panel:
  ✓ The session can be started with the quick start panel.

• Start menu’s system tab
  ✓ The session can be started with the start menu’s system tab.

• Application Launcher’s system tab
  ✓ The session can be started with the Application Launcher’s system tab.

• Desktop context menu
  ✓ The session can be started with the desktop context menu.

• Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.
• Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.

• Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

• Password protection: Specifies which password will be requested when launching the session.

   Possible values:
   - None: No password is requested when launching the session.
   - Administrator: The administrator password is requested when launching the session.
   - User: The user password is requested when launching the session.
   - Setup user: The setup user’s password is requested when launching the session.

• Hotkey:

   The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

   - (No modifier) = None
   - = Shift
   - Ctrl = Ctrl
   - = Super_L
   - Alt = Alt

   Key combinations are formed as follows with |:

   - Ctrl + = Ctrl|Super_L

• Key: Key for the hotkey

   To enter a key that does not have a visible character, e.g. the Tab key, open a terminal, log on as user and enter xev -event keyboard. Press the key to be used for the hotkey. The text in brackets that begins with keysym contains the key symbol for the Key field. Example: Tab in (keysym 0xff09, Tab)

• Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.

• Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

   Autostart delay: Waiting time in seconds between the thin client booting and the session being launched automatically.
8.6.1. Options

Menu path: Setup > Accessories > Display Switch > Options

To set up your screens' Display, proceed as follows:

1. Open the Display Switch that you set up under Display Switch (page 147).
   The Displays mask will open.

2. Click on Advanced in order to be able to configure special display options.
   The Display mask will open:

   ![Display Screen Configuration]

   Figure 25: Magnified view

Click on one of the screens shown and configure the settings, e.g.:

- Use this display - in order to enable it.
- Primary display - in order to specify the first screen, see Screen 1 in the Screen Selection (page 175).
  The taskbar appears on the main screen.
- Mirror displays - in order to place the screens over each other.
- Zoom - in order to set the magnified display.

If you disconnect the only active screen, the one that was active last will be shown again. As a result, you can still configure something even in an emergency.
8.6.2. Using "Display Switch" function

➢ Start the Display Switch function. The start options are described under Display Switch (page 147). Depending on the setting under Setup > Accessories > Display Switch > select menu Dialog type, the minimal or advanced dialog is displayed.

Identify Displays

➢ To start monitor detection, click on Identify Displays. The names and properties of the displays are detected. On each display, the connector, the assigned number (1 = main screen) as well as the name is shown. Example: 1: DVI-D(II): Samsung 24"

Define Primary Display

1. If necessary, change to the advanced dialog by clicking Advanced.
2. Select the display you want to define as main display.
3. Activate Primary Display.

Split display over several screens

The procedure with the minimal dialog is described below. To switch from the advanced to the minimal dialog, click on Simple.

➢ To show the same content on all screens (shadow screens), click on .

➢ If you would like to expand the display to all screens and the other screens are to the left of the main screen, click on .

➢ If you would like to expand the display to all screens and the other screens are to the right of the main screen, click on .

Rotate displays (Page orientation)

The procedure with the minimal dialog is described below, provided that Setup > Accessories > Display Switch > Options > Rotate displays (Page orientation) is activated. To switch from the advanced to the minimal dialog, click on Simple.

➢ To rotate the display anti-clockwise, click on .

➢ To rotate the display clockwise, click on .

Change mouse settings

The procedure with the minimal dialog is described below, provided that Setup > Accessories > Display Switch > Options > Mouse options is activated. To change from the advanced dialog to the minimal dialog, click Simple.

➢ To adjust the mouse for left-handed users, enable the Left-handed mode.

➢ To adjust the speed of the mouse pointer, change the value under Pointer speed. The higher the value, the further the mouse pointer will travel when the mouse is moved.
➢ To change the time interval within two consecutive mouse clicks are recognized as a double-click, change the number of milliseconds under Double click interval.

**Magnify screen (zoom)**

You can magnify the screen content. The effect is equivalent to the screen magnifier in full screen mode with Microsoft Windows: All fonts and graphics are magnified using the same factor; in this way, a virtual screen is created which is larger than the available monitor size. Thus, the user sees a magnified detail of the complete screen content; he can relocate the detail by moving the mouse to the edge of the screen.

1. If necessary, change to the advanced dialog by clicking **Advanced**.
2. Activate **Zoom**.
3. Set **Virtual Resolution** to the highest value that is possible. Example: 1920x1200
4. Set resolution to a lower value. This value simulates the real resolution of the screen. Example: 1280x800
5. Click **Apply**.

The screen content is magnified. The scaling factor results from the relation between virtual resolution and simulated real resolution.

When the same content is displayed on several screens (shadow screens), all screens show the same detail. However, you can set the zoom for each screen individually.

**Change refresh rate**

For standard monitors, 60 Hz is an appropriate refresh rate in most cases.

1. If necessary, change to the advanced dialog by clicking **Advanced**.
2. Set the desired value for **Refresh rate**.

**Restore default settings**

➢ Click **Reset** to restore the default settings.
8.7. Application Launcher

Menu path: Setup > Accessories > Application Launcher

- Session name: Name for the session

⚠️ The session name must not contain any of these characters:
\ / : * ? " < > | [ ] { } ( )

Session start options

- Start menu
  - The session can be started with the start menu.

- Application Launcher
  - The session can be started with the Application Launcher.

- Desktop:
  - The session can be started with a program starter on the desktop.

- Quick start panel:
  - The session can be started with the quick start panel.

- Start menu’s system tab
  - The session can be started with the start menu’s system tab.

- Application Launcher’s system tab
  - The session can be started with the Application Launcher’s system tab.

- Desktop context menu
  - The session can be started with the desktop context menu.

- Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

- Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.

- Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

- Password protection: Specifies which password will be requested when launching the session.
  Possible values:
  - None: No password is requested when launching the session.
  - Administrator: The administrator password is requested when launching the session.
  - User: The user password is requested when launching the session.
  - Setup user: The setup user’s password is requested when launching the session.

- Hotkey:
  - The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.
• **Modifiers**: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g. Ctrl. Here, you will find the available modifiers and the associated key symbols:

- (No modifier) = None
- ↑ = Shift
- Ctrl = Ctrl
- = Super_L
- Alt = Alt

Key combinations are formed as follows with |:

- Ctrl + = Ctrl|Super_L

• **Key**: Key for the hotkey

  To enter a key that does not have a visible character, e.g. the Tab key, open a terminal, log on as user and enter xev -event keyboard. Press the key to be used for the hotkey. The text in brackets that begins with keysym contains the key symbol for the Key field. Example: Tab in (keysym 0xff09, Tab)

• **Autostart**: If this option is enabled, the session will be launched automatically when the thin client boots.

• **Relaunch**: If this option is enabled, the session will be relaunched automatically after termination.

  Autostart delay: Waiting time in seconds between the thin client booting and the session being launched automatically.

Under Application Launcher > Configuration, you can hide the following items from the user:

• **System page**
• **"Reboot" button**
• **"Shut down" button**
• **Network information page**
8.8. Sound Preferences

Menu path: Setup > Accessories > Sound Preferences

With this function, you can configure your thin client’s audio system. For details of how to change the presets for the audio system, see Options (page 155). For details of how to use the function, see Using “Audio Settings” function (page 157).

The settings for starting the function are described below.

- Session name: Name for the session

⚠️ The session name must not contain any of these characters:
\ / : * ? “ < > | [ ] { } ( )

Session start options

- Start menu
  - ✔ The session can be started with the start menu.
- Application Launcher
  - ✔ The session can be started with the Application Launcher.
- Desktop:
  - ✔ The session can be started with a program starter on the desktop.
- Quick start panel:
  - ✔ The session can be started with the quick start panel.
- Start menu’s system tab
  - ✔ The session can be started with the start menu’s system tab.
- Application Launcher’s system tab
  - ✔ The session can be started with the Application Launcher’s system tab.
- Desktop context menu
  - ✔ The session can be started with the desktop context menu.
- Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.
- Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.
- Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.
• Password protection: Specifies which password will be requested when launching the session.
   Possible values:
   - None: No password is requested when launching the session.
   - Administrator: The administrator password is requested when launching the session.
   - User: The user password is requested when launching the session.
   - Setup user: The setup user’s password is requested when launching the session.

• Hotkey:
   ☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.
   • Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g. Ctrl. Here, you will find the available modifiers and the associated key symbols:
     - (No modifier) = None
     - = Shift
     - = Ctrl
     - = Super_L
     - = Alt
   Key combinations are formed as follows with |:
     - Ctrl + = Ctrl|Super_L

• Key: Key for the hotkey

   To enter a key that does not have a visible character, e.g. the Tab key, open a terminal, log on as user and enter xev -event keyboard. Press the key to be used for the hotkey. The text in brackets that begins with keysym contains the key symbol for the Key field. Example: Tab in (keysym 0xff09, Tab)

• Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.
• Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched automatically.

8.8.1. Options

Menu path: Setup > Accessories > Sound Preferences > Options

With this function, you can change presets for the audio system.

• Show volume control in taskbar

  ☑ The button will be shown on the taskbar. Click on this button to show the volume control. (default)

  ☐ The button will not be shown. The user must start the Audio Settings function to change the volume. Further information can be found under Using “Audio Settings” function (page 157).
Remote Volume Settings

☑ The settings for the parameters Mute, PCM Volume, Mute recording and Input Volume will be restored after each system start. The aforementioned parameters are only effective if Remote Volume Settings is enabled.

☐ The last settings made by the user will remain after the next system start. (default)

Mute

☑ Audio playback is off.

☐ Audio playback is on. (default)

PCM Volume: Preset volume in percent. (default: 50)

Input Mute

☑ The audio input is muted. Sounds from a microphone that are recorded are not transferred via the thin client.

☐ The audio input is switched on. Sounds from a microphone that are recorded can be transferred via the thin client. (default)

Input Volume: Volume in percent at which sounds at the audio input are recorded - for example, from a microphone. (default: 100)

Default sound output

Port name

Possible options:
- Automatic: The audio output is assigned to a device automatically. The following order of priority applies:
  1. USB devices
  2. PCI devices; this includes the HDMI interface.
  3. Internal speaker
  Ports which are not connected are ignored.
- HDMI / DisplayPort
- Speakers
- Headphones

Device Name: Name of the device as displayed in the tab Output of the Sound Preferences dialog; see Using "Sound Preferences" Function (page 157). The name should be self-explanatory. Examples: "Built-in Audio", "Microsoft LifeChat LX-3000"

Default sound input

Port Name

Possible options:
- Automatic: The audio output is assigned to a device automatically. The following order of priority applies:
  1. USB devices
  2. PCI devices
  Ports which are not connected are ignored.
- Microphone
- Headset microphone
**Device Name**: Name of the device as displayed in the tab Output of the Sound Preferences dialog; see *Using "Sound Preferences" Function* (page 157). The name must be provided literally. Examples: "Built-in Audio", "Microsoft LifeChat LX-3000"

---

8.8.2. **Using "Audio Settings" Function**

- Start the Audio Settings function. The start options are described under *Audio Settings* (page 154).

To change the playback volume, proceed as follows:

- Move the Playback Volume slider to the right to increase the volume or to the left to reduce the volume.

To select and configure the device for playback, proceed as follows:

1. Click on the Output tab.
2. Under Sound output via, select the device to be used for playback.
3. If necessary, adjust the Balance, Crossover and Subwoofer settings.

To select and configure the device for recording, proceed as follows:

1. Click on the Input tab.
2. Under Sound input via, select the device to be used for audio output.
3. Adjust the Input Volume if necessary.

To change the playback volume for specific applications, proceed as follows:

1. Click on the Applications tab.
2. Adjust the volume control for the relevant application.

---

8.9. **System Log Viewer**

Menu path: Setup > Accessories > System Log Viewer

All available system logs are updated and displayed. You can add your own log files in the options. The contents of the selected log can be searched in the viewer and also copied (e.g. for support purposes).
8.10. UMS Registration

Menu path: Setup > Accessories > UMS Registration

Registration of the thin client in the IGEL Universal Management Suite can also be performed locally.

1. Open the Application Launcher.
2. In the System area, launch the UMS Registering application.

![UMS Registering Window]

3. Enter the Server Address, Login and Password for your UMS server.

   ![Enter UMS details]

   If there is a corresponding DNS entry for the UMS server, you can leave the default value igelrmserver in the address field.

4. Optional: Define a Structure Tag in order to sort the thin client into a directory in accordance with the UMS directory rules.

   ![Structure Tags Information]

   Further information regarding the use of structure tags can be found in the Using Structure Tags (http://edocs.igel.com/index.htm#10202089.htm) How-To.

5. Optional: Select a directory on the server.
6. Optional: The New Hostname specifies the name under which the client will be registered in the UMS.
7. Click Register.
8.11. Touchscreen Calibration

Menu path: Setup > Accessories > Touchscreen Calibration

Enable the calibration program for your touchscreen here and specify how you would like to bring it up. After launching the calibration program, you will see a pattern with calibration points which must be touched one after another.

➢ Further setting options can be found under Touchscreen (page 195).

8.12. Task Manager

Menu path: Setup > Accessories > Taskmanager

This function provides an overview of the applications and other processes running on the thin client. Information regarding use of this function can be found under Using the Task Manager (page 160). The settings for launching the function are described below.

➢ To apply a changed setting, click on Apply.
➢ To apply a changed setting and close the setup, click on OK.

You can change the following settings:

• Session Name: Name for the Taskmanager function
• Start Menu: If this option is enabled, the Task Manager can be launched in the start menu.
• Application Launcher: If this option is enabled, the Task Manager can be launched with the Application Launcher.
• Desktop: If this option is enabled, the Task Manager can be launched with a program launcher on the desktop.
• Quick Start Panel: If this option is enabled, the Task Manager can be launched in the Quick Start Panel.
• Start Menu's system tab: If this option is enabled, the Task Manager can be launched in the start menu's system tab.
• Application Launcher's System tab: If this option is enabled, the Task Manager can be launched in the Application Launcher's system tab.
• Desktop Context Menu: If this option is enabled, the Task Manager can be launched in the desktop context menu.
• Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the Task Manager. The menu path will be used in the start menu and in the desktop context menu. Example: "Functions/Screen functions".
• Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the Task Manager. The menu path will be used for the program launcher on the desktop. Example: "Functions/Screen functions".
• Password Protection: Specifies the password request when launching the Task Manager.

Possible values:

- None: No password is requested when launching the Task Manager.
- Administrator: The administrator password is requested when launching the Task Manager.
- User: The user password is requested when launching the Task Manager.
- Setup user: The setup user's password is requested when launching the Task Manager.
• **Hotkey**: Specifies a hotkey consisting of modifiers and a key which can be used to launch the Task Manager.
• **Modifiers**: One or two modifiers for the hotkey
• **Key**: Key for the hotkey
• **Autostart**: If this option is enabled, the Task Manager will be launched automatically when the thin client boots
• **Restart**: If this option is enabled, the Task Manager will be relaunched automatically after termination.
• **Autostart Delay**: Waiting time in seconds between the thin client booting and the Task Manager being launched automatically.

### 8.12.1. Using the Task Manager

The following section explains how to use the Task Manager.

➢ **Launch the Task Manager function.** The launch options are described under *Task Manager* (page 159).

To determine the thin client's total processor usage, proceed as follows:

➢ **Read the percentage value under CPU**:.

| CPU: 18% | Processes: 208 | Memory: 27% | Swap: 4% |

To determine the thin client's total memory usage, proceed as follows:

➢ **Read the percentage value under RAM**:.

| CPU: 18% | Processes: 208 | Memory: 27% | Swap: 4% |

➢ **To determine the value in bytes, click on** and enable the **Show memory usage in bytes** option.

To determine the extent to which a specific application contributes to processor usage, proceed as follows:

1. In the search window, enter the name of the application or part of the name.

   The Task Manager will now show only the relevant applications and processes.

2. Read the percentage value for the relevant application in the **CPU** column.

![Task Manager](image)

To determine the extent to which a specific application contributes to memory usage, proceed as follows:

1. In the search window, enter the name of the application or part of the name.

   The Task Manager will now show only the relevant applications and processes.
2. Read the values in the VSZ and RSS columns.

The VSZ column shows how much memory is available for the application. The RSS column shows how much memory the application is currently using.

➢ If the VSZ column is not shown, click next to and enable the Virtual Bytes option.

➢ If the RSS column is not shown, click next to and enable the Private Bytes option.

### 8.13. Screenshot Tool

Menu path: Setup > Accessories > Screenshot Tool

With this function, you can take a screenshot.

Information regarding use of this function can be found under *Taking a screenshot* (page 162). The settings for launching the function are described below.

➢ To apply a changed setting, click on Apply.

➢ To apply a changed setting and close the setup, click on OK.

You can change the following settings:

- **Session Name**: Name for the Screenshot Tool function.
- **Start Menu**: If this option is enabled, the Screenshot Tool function can be launched from the start menu.
- **Application Launcher**: If this option is enabled, the Screenshot Tool function can be launched with the Application Launcher.
- **Desktop**: If this option is enabled, the Screenshot Tool function can be launched with a program launcher on the desktop.
- **Quick Start Panel**: If this option is enabled, the Screenshot Tool function can be launched from the Quick Start Panel.
- **Start Menu’s System tab**: If this option is enabled, the Screenshot Tool function can be launched in the start menu’s system tab.
- **Application Launcher’s System tab**: If this option is enabled, the Screenshot Tool function can be launched in the Application Launcher’s system tab.
• Desktop Context Menu: If this option is enabled, the Screenshot Tool function can be launched in the desktop context menu.
• Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the Screenshot Tool. The menu path will be used in the start menu and in the desktop context menu. Example: "Functions/Screen functions".
• Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the Screenshot Tool. The menu path will be used for the program launcher on the desktop Example: "Functions/Screen functions".
• Password Protection: Specifies the password request when launching the Screenshot Tool function.
  Possible values:
  - None: No password is requested when launching the Screenshot Tool function.
  - Administrator: The administrator password is requested when launching the Screenshot Tool function.
  - User: The user password is requested when launching the Screenshot Tool function.
  - Setup user: The setup user's password is requested when launching the Screenshot Tool function.
• Hotkey: Specifies a hotkey which can be used to launch the Screenshot Tool function.
  You can also define a hotkey for taking a screenshot under Setup > User Interface > Hotkeys > Commands, see Hotkeys (page 200).
  • Modifiers: Combination of modifiers for the hotkey. You can specify a modifier, a combination of an unlimited number of modifiers or no modifier.
  • Key: Key for the hotkey
  • Autostart: If this option is enabled, the Screenshot Tool function will be launched automatically when the thin client boots.
  • Restart: If this option is enabled, the Screenshot Tool function will be relaunched automatically after termination.
  • Autostart Delay: Waiting time in seconds between the thin client booting and the Screenshot Tool function being launched automatically.

8.13.1. Taking a screenshot

To take a screenshot of the active window, proceed as follows:

1. Press the keys \textbf{Alt} + Print simultaneously.

2. Specify how the screenshot is to be used. You have the following options:
   - Save: If this option is enabled, the screenshot will be saved in PNG format via your thin client. You can save the screenshot locally, on a network drive or on a USB mass storage device.
   - Copy to the clipboard: If this option is enabled, the screenshot will be available in the thin client's local cache. You can access the local cache from an RDP session and open the image in an RDP session application.
   - Open with: If this option is enabled, the screenshot will be opened in your thin client's image viewer as soon as it is taken.

To take a screenshot of the entire screen or a selectable region, proceed as follows:

1. Launch the Screenshot Tool function by pressing \textbf{Ctrl} + Print simultaneously. More launch options are described under Screenshot (page 161).
2. Select the area you would like to photograph. You have the following options:
   - Entire screen: If this option is enabled, the entire screen contents will be photographed.
   - Active window: If this option is enabled, the window which is currently the focus will be photographed.
   - Select a region: If this option is enabled, you can freely select part of the screen using the mouse.
   - Capture the mouse pointer: If this option is enabled, the mouse pointer will be visible on the screenshot.

3. Specify the Delay before capturing in seconds. The minimum value is 1.

4. Click on Ok.

   If you have enabled Entire screen or Active window, the screenshot will be taken after the Delay before capturing has elapsed.
   If you have enabled Select a region, you can select the desired part of the screen using the mouse. To do this, press and hold the left mouse button while dragging the mouse across the screen.

5. Specify how the screenshot is to be used. You have the following options:
   - Save: If this option is enabled, the screenshot will be saved in PNG format via your thin client. You can save the screenshot locally, on a network drive or on a USB mass storage device.
   - Copy to the clipboard: If this option is enabled, the screenshot will be available in the thin client’s local cache. You can access the local cache from an RDP session and open the image in an RDP session application.
   - Open with: If this option is enabled, the screenshot will be opened in your thin client’s image viewer as soon as it is taken.

8.14. On-Screen Keyboard

Menu path: Setup > Accessories > On-Screen Keyboard

In this area, you can enable the On-Screen Keyboard for use with our IGEL UD10 or any other touchscreen. In order to display the on-screen keyboard, you can either automatically launch it or show the On-Screen Keyboard button in the taskbar. These settings can be configured for the following cases:

• If the logon dialog is visible
• If the screen is locked

This setting has no effect on the on-screen keyboard in the appliance mode.

You can also influence which special keys are shown on the keyboard. These also apply for the appliance mode. The following three options are available to choose from:

• Function keys
• Navigation keys
• Numeric keys

You will find additional settings under Keyboard and Additional Keyboard (page 194).
8.15. Bluetooth Tool

Menu path: Setup > Accessories > Bluetooth Tool

With the Bluetooth Tool, you can connect Bluetooth devices, e.g. a keyboard, a mouse or a headset, to your thin client.

The Bluetooth Tool supports the following pairing methods, i.e. the mutual authentication of the Bluetooth device and thin client:

- Pairing with PIN entry (for most keyboards)
- Pairing with fixed PIN (for most headsets, mice or GPS devices)
- Pairing with automatic PIN allocation

In order to use Bluetooth devices, a Bluetooth USB adapter must be connected to the thin client.

To connect a Bluetooth device with PIN entry, proceed as follows:

1. Ensure that the pairing mode is enabled on the Bluetooth device.
2. Launch the Bluetooth Tool via > System > Bluetooth Tool or another launch option, if available.
   The DeviceSearch dialog page will be shown. After a few seconds, the Bluetooth devices found by the thin client will be displayed.
3. Highlight the desired Bluetooth device and click on Forward.
   A PIN will be shown on the Device setup dialog page.
4. Enter the PIN shown into your Bluetooth device.
   On the Setup summary dialog page, the status of the connection will be shown.
5. Click on Close.

To connect a Bluetooth device with a fixed PIN, proceed as follows:

1. Launch the Bluetooth Tool via > System > Bluetooth Tool or another launch option, if available.
   The DeviceSearch dialog page will be shown. After a few seconds, the Bluetooth devices found by the thin client will be displayed.
2. Highlight the desired Bluetooth device.
3. Click on PIN Options.
4. Select one of the specified PINs or enable Custom PIN and enter the PIN for the Bluetooth device. You will find this PIN in the documentation for your Bluetooth device.
   On the Setup summary dialog page, the status of the connection will be shown.
5. Click on Close.

To connect a Bluetooth device with automatic PIN allocation, proceed as follows:

1. Ensure that the pairing mode is enabled on the Bluetooth device.
2. Launch the Bluetooth Tool via > System > Bluetooth Tool or another launch option, if available.
   The DeviceSearch dialog page will be shown. After a few seconds, the Bluetooth devices found by the thin client will be displayed.
3. Highlight the desired Bluetooth device and click on Forward.
   A PIN will be shown on the Device setup dialog page and on your Bluetooth device.
4. If the PINs on the Device setup dialog page and on your Bluetooth device are identical, click on Yes.
   On the Setup summary dialog page, the status of the connection will be shown.

5. Click on Close.

To cancel pairing to a Bluetooth device, proceed as follows:

1. Launch the Bluetooth Tool via > System > Bluetooth Tool or another launch option, depending on
   the configuration.
   The connected Bluetooth device will be shown on the Device Search dialog page.

2. Highlight the connected Bluetooth device and click on Forward.
   On the Setup summary dialog page, the status of the connection will be shown.

3. Click on Close.

---

8.16. Java Control Panel

Menu path: Setup > Accessories > Java Control Panel

The Java Control Panel is an operating console which is used for various purposes.

➢ Specify how Java runs on your computer on the basis of various parameters.

➢ Manage temporary files used for the Java plug-in.
   By doing this, you allow your web browser to use Sun Java to execute applets and Java Web Start. As a
   result, you can launch Java applications via the network.

➢ Check certificates via the operating console. This gives you the security you need to use applets and
   applications via the network.

➢ Define runtime parameters for applets executed with Java plug-in and applications executed with Java
   Web Start.

➢ Further information can be found at
   http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-guide/jcp.html
   (http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-guide/jcp.html -
   http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-guide/jcp.html).
8.17. Monitor Calibration

Menu path: Setup > Accessories > Monitor Calibration

When calibrating your monitor (auto adjust), please use this special pattern. Generally speaking, you will achieve better results than if you calibrate the monitor with a conventional desktop and windows. Clicking on the pattern with the mouse closes the application again.

![Figure 28: Kalibrierungsmuster](image)

8.18. Commands

Menu path: Setup > Accessories > Commands

The following system commands can be made accessible to the user:

- Log out
- Sort symbols
- Switch off terminal
- Restart terminal
- Restart window manager

8.19. Network Tools

Menu path: Setup > Accessories > Network Tools

The IGEL Universal Desktop Linux firmware features a number of tools for network analysis. These include:

- Device information (page 166)
- Ping (page 167)
- Netstat (page 167)
- Traceroute (page 167)
- Look-up (page 168)

8.19.1. Device Information

This tool provides information regarding the status of the network device used. This includes:

- MAC and IP address
- Link speed
- Various interface statistics (bytes transferred, errors etc.)
8.19.2. Ping

The Ping tool allows you to send contact queries to a network address. You can specify the exact number of queries to be sent. Alternatively, you can enable Unlimited Requests which means that the echo requests will be sent until you stop the process.

The Ping result is shown below, and the Ping duration of the last five Pings is illustrated in a bar chart.

![Ping Network Tools](image)

Figure 29: Ping-Network-Tools

- Enable Program > Signal Tone for Ping to configure the thin client to output an audible signal each time a Ping is sent.

8.19.3. Netstat

Netstat provides information on active network services with protocol and port information as well as a routing table and multicast information for your network devices.

8.19.4. Traceroute

With Traceroute, you can trace the route to a network address.
8.19.5. Look-up

The Look-up tool shows various information regarding your network address. The available information types are shown in this screenshot.

![Figure 30: Information types for network address](image)

8.20. System Information

Menu path: Setup > Accessories > System Information

The system information provides an overview of all internal and connected thin client hardware components as well as the constituent parts of the Linux system (e.g. kernel modules). The information shown can be copied to the clipboard in order to send it to the IGEL Support department for example.

8.21. Disk Utility

Menu path: Setup > Accessories > Disk Utility

Drive management shows all recognized USB drives along with their respective properties (device name, mount point etc.).

➢ If Dynamic Client Drive Mapping is enabled, you will find a button to safely remove external drives here.

➢ You can configure a Hotkey for opening Disk Utility.
8.22. Safely Remove Hardware

Menu path: Setup > Accessories > Safely Remove Hardware

With this function, you can remove a hotplug storage device connected to your thin client safely without the risk of losing data. For details of how to use the function, see Using “Safely Remove Hardware” function.

The settings for starting the function are described below.

For the Remove Drive function, you have additional start options:

➢ In the system tray, click on ".
➢ If the system tray is not shown, e.g. in a full-screen session, you can use the session control bar. Further information can be found under Session Control Bar (page 188).

• Session name: Name for the session

The session name must not contain any of these characters:
\ / : * ? " < > | [ ] { } ( )

• Start menu: If this option is enabled, the session can be launched from the start menu.
• Application Launcher: If this option is enabled, the session can be launched with the Application Launcher.
• Desktop: If this option is enabled, the session can be launched with a program launcher on the desktop.
• Quick start panel: If this option is enabled, the session can be launched with the quick start panel.
• Start menu’s system tab: If this option is enabled, the session can be launched with the start menu’s system tab.
• Application Launcher’s system tab: If this option is enabled, the session can be launched with the Application Launcher’s system tab.
• Desktop context menu: If this option is enabled, the session can be launched with the desktop context menu.
• Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.
• Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used in the Application Launcher.
• Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be created for the session. The menu path will be used for the program launcher on the desktop.
• Hotkey:
  ✓ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.
- Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g. Ctrl. Here, you will find the available modifiers and the associated key symbols:
  - (No modifier) = None
  - ⇧ = Shift
  - (ctrl) = Ctrl
  - ⌘ = Super_L
  - ⌘ = Alt

Key combinations are formed as follows with |:
  - Ctrl + ⌘ = Ctrl|Super_L

- Key: Key for the hotkey

  To enter a key that does not have a visible character, e.g. the Tab key, open a terminal, log on as user and enter xev -event keyboard. Press the key to be used for the hotkey. The text in brackets that begins with keysym contains the key symbol for the Key field. Example: Tab in (keysym 0xff09, Tab)

8.22.1. Using "Safely Remove Hardware" Function

To remove a hotplug storage device safely, proceed as follows:

1. Start the Safely Remove Hardware function. The start options are described under Safely Remove Hardware (page 169).

2. In the context menu, click on the hotplug storage device that you want to remove.

   The hotplug storage device is disconnected from the thin client. Once it has been disconnected, the storage device can be removed from the thin client.

   If Setup > Devices > Storage Devices > Storage Hotplug > Use storage hotplug beep is enabled, a signal tone will signal that the device has been disconnected successfully. If Setup > Devices > Storage Devices > Storage Hotplug > Show storage hotplug messages is enabled, a message window will signal that the device has been disconnected successfully.

8.23. Firmware Update

Menu path: Setup > Accessories > Firmware Update

This session updates the firmware with the settings saved in System > Update > Firmware Update.
8.24. Smartcard Personalization

Menu path: Setup > Accessories > Smartcard Personalization

Configure the options to start the Smartcard Personalization (page 235).

8.25. Identify Monitors

Menu path: Setup > Accessories > Identify Monitors

Shows the screen number from the IGEL setup and hardware information on every connected screen.

![Figure 31: Identify screens](image)

8.26. Upgrade License

Menu path: Setup > Accessories > Upgrade License

You can distribute additional firmware functions via the IGEL Universal Management Suite or import licenses locally to a thin client. To do this, an IGEL USB stick with a smartcard or a storage medium containing licenses that have already been produced for this device must be inserted.
8.27. Webcam Information

Menu path: Setup > Accessories > Webcam Information

The Webcam Information tool reads information such as the manufacturer, model and supported video formats from a connected webcam. A test image from the camera with the chosen settings can also be displayed.

➢ Launch Webcam Information in the Application Launcher (System).
➢ Select a resolution and click Test in order to display the camera image.

![Webcam Information Tool](image)

Figure 32: Webcam information

A list with all supported video formats can be created in the Linux Console using the command:

```
webcam-info -l
```

![Local Terminal](image)

Figure 33: Command webcam-info -l

➢ In order to check whether the webcam is functioning in a session (e.g. redirected via Citrix HDX Webcam Redirection), open the website cameroi.com (http://cameroi.com) in your browser within the session (Adobe Flash must be installed).
8.28. Image viewer

The GPicview image viewer is installed from IGEL Universal Desktop Linux 5.06.100.

Applications such as the Firefox browser or the file manager use the image viewer as an auxiliary application. The image viewer does not have a menu entry for opening it directly.

The image viewer can be used to view a wide range of graphic MIME types:

- image/bmp
- image/gif
- image/jpeg
- image/jpg
- image/png
- image/x-bmp
- image/x-pcx
- image/x-tga
- image/x-portable-pixmap
- image/x-portable-bitmap
- image/x-targa
- image/x-portable-greymap
- application/pcx
- image/svg+xml
- image/svg-xml
- image/x-portable-bitmap

An entry in the FAQ (http://edocs.igel.com/index.htm#10203086.htm) explains how you can change the way in which they are assigned.
Instructions for using the image viewer can be found on the Ubuntu Users website. (http://wiki.ubuntuusers.de/GPicview)

Figure 34: Bildbetrachter
9. **User Interface**

You can configure the user interface according to your needs.

9.1. **Display**

Menu path: **Setup > User Interface > Display**

**Figure 35: Screen settings**

<table>
<thead>
<tr>
<th>Color Depth</th>
<th>True Color (24)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of screens</td>
<td>2</td>
</tr>
<tr>
<td>Selected screen</td>
<td>2</td>
</tr>
<tr>
<td>Resolution</td>
<td>1280x1024</td>
</tr>
<tr>
<td>Frequency</td>
<td>60</td>
</tr>
<tr>
<td>Screen rotation</td>
<td>None</td>
</tr>
<tr>
<td>Monitor</td>
<td>Automatic</td>
</tr>
</tbody>
</table>

- **Color Depth**: Allows you to select the desktop color depth. The following options are available:
  - 16 bits per pixel (High Color / 65,000 colors)
  - 24 bits per pixel (True Color / 16.7 million colors)

- Make sure that all screens connected to the thin client support the color setting.
### DDC

DDC Allows you to activate the Display Data Channel in order to share information between the system and the screen. If screen problems should occur, enable and disable the DDC setting in the Options by way of a test. DDC is enabled by default and the native resolution supported by the screen is determined automatically.

### Screen configuration

Every screen connected to the IGEL UD device can be configured independently. The position of the individual screens can be determined in relation to Screen 1. Click on Identify monitors to show the screen identifier on each device.

For details of the display resolution supported by your IGEL thin client, please see its data sheet.

If you use the Shared WorkPlace (SWP) feature with user-specific display resolutions, please note the How-To (http://edocs.igel.com/index.htm#10202975.htm) on the subject.

### 9.1.1. Power Options

**Menu path:** Setup > User Interface > Display > Power Options

In this area, you can handle display power management. Your screen must support Display power management signaling (DPMS).

#### Display power management settings

- Handle display power management

<table>
<thead>
<tr>
<th></th>
<th>On battery</th>
<th>Plugged in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby Time</td>
<td>6 Minutes</td>
<td>10 Minutes</td>
</tr>
<tr>
<td>Suspend Time</td>
<td>8 Minutes</td>
<td>12 Minutes</td>
</tr>
<tr>
<td>Off Time</td>
<td>10 Minutes</td>
<td>15 Minutes</td>
</tr>
</tbody>
</table>

#### Brightness reduction

- On inactivity reduce to
- Reduce after

<table>
<thead>
<tr>
<th></th>
<th>On battery</th>
<th>Plugged in</th>
</tr>
</thead>
<tbody>
<tr>
<td>On inactivity reduce to</td>
<td>20 %</td>
<td>80 %</td>
</tr>
<tr>
<td>Reduce after</td>
<td>Never</td>
<td>Never</td>
</tr>
</tbody>
</table>

Figure 36: Display power Management Options

- Enable Handle display power management in order to switch on the DPMS energy saving functions.
Specify separately for battery and mains operation the number of minutes before the screen switches to a specific energy-saving mode:

Three different modes are offered:
- Standby time (standby mode)
- Suspend time (sleep mode)
- Off time (Off)

If a device is switched on but not used for some time, energy can also be saved by reducing the brightness of the screen.

Specify by how many percent the brightness of the screen is to be reduced and how long the period of inactivity before brightness reduction should be. Values between 10 seconds and two minutes are available to choose from.

Naturally, all stages are gone through only if the X-Server does not receive any new entries during this period.

9.1.2. Access control

Menu path: Setup > User Interface > Display > Access Control

Thin client access control is enabled by default. If you highlight Switch off console access, it will be possible to access your terminal screen from any UNIX host.

Fixed X-Key

You can grant specific users permanent remote access to your thin client. To do this, you will need to enable this option, click on the Calculate button and enter the 32-character key you have received into the Xauthority file on the user's computer.
List of Trusted X hosts

Click on the Add button to open the entry mask. Give the name of the remote host (not the IP address) you would like to add and confirm this by clicking on OK.

9.1.3. Gamma correction

Menu path: Setup > User Interface > Display > Gamma correction

In this area, you can increase or decrease the various brightness ranges in order to adjust the display on your screen to your preferences.

![Figure 38: Gamma correction](image-url)
9.1.4. Options

Menu path: Setup > User Interface > Display > Options

Configure the options for the display here:

![Display options](image)

<table>
<thead>
<tr>
<th>Monitor Probing (DDC)</th>
<th>Select Off in order to disable the automatic probing of display properties.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor DPI</td>
<td>Enter the DPI resolution (dots per inch) for your monitor. The default setting is 96 DPI.</td>
</tr>
<tr>
<td>Composite Manager</td>
<td>You will find three modes for the Composite Manager, the start menu and windows with animations and effects here:</td>
</tr>
<tr>
<td></td>
<td>- Automatic: Disables the Composite Manager during battery operation, if the color depth is low or if the hardware is weak.</td>
</tr>
<tr>
<td></td>
<td>- On</td>
</tr>
<tr>
<td></td>
<td>- Off</td>
</tr>
</tbody>
</table>
9.1.5. Universal MultiDisplay

The IGEL Universal MultiDisplay (UMD) solution enables you to set up an extended desktop with up to eight screens in any arrangement (the individual screen areas must however be in contact with each other at one edge and corner, and cannot overlap).

A master thin client (master) can be connected to up to three satellite thin clients (satellite), while one or two screens can be connected to each of the thin clients within the group. Only the master is connected to the company network. The satellites are connected, via their own network, only to the master, which must have a second network card for this purpose.

All other peripherals such as a keyboard, mouse etc. are connected to the master. The entire system is also configured on the master, either via its local setup or the IGEL Universal Management Suite UMS.

![Figure 40: IGEL Universal MultiDisplay Setup](image)

Software Requirements

The following software requirements must be met in order to use IGEL Universal MultiDisplay:

- IGEL UD Linux firmware offering IGEL Universal MultiDisplay support on the master and satellites

  Note: Devices with IGEL Universal Desktop OS cannot be used for IGEL Universal MultiDisplay.

- IGEL Universal MultiDisplay Starter Kit license for up to three displays (2x master, 1x satellite)
• IGEL Universal MultiDisplay license for each additional display connected

Note: You will receive the Starter Kit license along with the master thin client. Licenses for additional displays can be added to the master thin client in the IGEL Universal Management Suite Console (UMS Administration > Global Configuration > Licenses).

Hardware and Network Requirements

The following requirements must be met in order to use IGEL UMD:

• Master: IGEL UD5-x30 LX thin client with PCIe network card installed
• Satellite: Up to 3 IGEL thin clients with Universal Desktop Linux
• The master is connected to the company network via the internal Ethernet port. The additional PCIe network card is used to connect one satellite directly, or a number of satellites via an intermediate switch.

The IP address of the master is: 192.168.199.1, the IP address of the first satellite: 192.168.199.2, which means that each additional satellite will be counted up.

• Depending on the particular hardware configuration, screens can be connected to the master and the satellites via the VGA, DVI or display port.

Advanced Options

In the IGEL Registry under Setup→System→Registry, you will find a number of additional parameters which are not yet available in the actual screen configuration:

x.dmx.number_of_screens_master and x.dmx.number_of_screens_slaveX allow you to define only one connected monitor for a particular thin client (the default setting is two available monitors per device). This makes sense if two or more UD5s, each with a high-resolution monitor, are to be connected together via the display port for example.

The master saves the list of available satellites. A satellite can be deleted from the list via the x.dmx.slaveX parameter by selecting Delete Instance.

The satellites can be arranged in any order by making changes in x.dmx.slaveX.number. However, there is no consistency check, so you must therefore carry out a manual check to ensure that the numbering is clear.

With x.dmx.net, the automatic configuration of the internal network between the master and clients can also be carried out manually, e.g. the IP address of the master or the address area of its DHCP server.
Configuration

Once you have connected the master and satellites to each other as described above, switch on the master thin client. In the master setup, enable IGEL Universal MultiDisplay under User Interface > Screen > IGEL Universal MultiDisplay.

Select the number of screens and set the resolution, rotation etc. for each one. You can select the screens from the list or simply by clicking on them in the arrangement overview.

Using drag & drop, arrange the screens in the overview in the same way as they are physically arranged. When all screens are configured, confirm your choices by clicking on OK.

Now switch on the satellites, one after another, starting with satellite 1. After powering up a satellite, wait around 30 seconds before switching on the next one. The satellites will receive their configuration, including IP address, from the master. IGEL Universal MultiDisplay is now ready for use.

9.2. Desktop

Menu path: Setup > User Interface > Desktop

On this page, you can configure general settings for the appearance of the desktop:

• Local Window Manager for this Display: Here, you can disable the window manager if you only work in full-screen sessions and do not require this service.
• User Interface Theme: Currently there is only one design available in IGEL Linux v5: IGEL-light.
• Desktop Icon Size: Specify the size in which you would like the icons to be displayed on the desktop.
• Monitor for Desktop Icons: Specify on which monitor the desktop icons are to be displayed.

Possible options:
- All monitors
- Same as taskbar
- 1st monitor
- 2nd monitor

• Single Click Mode: This option was set up specially for users of touchscreen monitors. Enable this mode in order to open programs with a single click.
• Default Font: Choose between serif and sans-serif text and between standard and bold.
• Default Font Size: Specify your desired font size in pt (points) here.
• Desktop Icon Font Size: Specify your desired font size for desktop icons in pt (points) here.
• Titlebar Font: Choose between serif and sans-serif text and between standard and bold.
• Titlebar Font Size: Specify your desired font size in pt (points) here.
9.2.1. Background

Menu path: Setup > User Interface > Desktop > Background

In this area, you can configure the desktop background with pre-defined IGEL backgrounds, a fill color or a color gradient.

You can also select a background image of your own.

![You can set up a separate background image for each monitor that is connected to the thin client.]

**Own background image - server configuration**

- **Wallpaper**: Provides a selection of pre-defined IGEL backgrounds
- **Wallpaper Style**: Provides various design versions:
  - Automatic
  - Centered
  - Tiled
  - Stretched
  - Scaled
  - Zoomed
- **Color Style**: Sets a fill color or a color gradient.
- **Desktop Color**: Sets a desktop color.

![You can also use a background image of your own. You can set up a separate background image for each monitor that is connected to the thin client.]

- You can provide a user-specific background image on a download server.
  1. In the Desktop > Background window, enable the option Own background image.
  2. Give a name for the background image file.
  3. Specify the download server under Desktop > Background > Background Image Server.

![If you have already defined a server for the system update files, you can use the same server setting for downloading the background image.]

The user-specific background image will be downloaded from the specified server if the function was enabled and if requested manually (Update Background Image). The download can also be launched from the IGEL Universal Management Suite via Update desktop changes.

- A user-specific boot image can be provided on a download server.

![The file types BMP, JPG, GIF, TIF, PNG and SVG are supported for an own background image and bootsplash. A total storage area of 25 MB is available for all user-specific images.]

The file types BMP, JPG, GIF, TIF, PNG and SVG are supported for an own background image and bootsplash. A total storage area of 25 MB is available for all user-specific images.
9.2.2. Taskbar

**Menu path:** Setup > User Interface > Desktop > Taskbar

In this area, you can enable and configure the taskbar.

You can change the following settings:

- **Use taskbar:** If this option is enabled, the taskbar will be displayed.
- **Taskbar Position:** Specifies the position in which the taskbar is displayed.
  
  Possible values:
  
  - **Bottom**
  - **Top**
  - **Left**
  - **Right**

- **Vertical Taskbar Mode:** Specifies how items are shown in the taskbar. This parameter is available if Taskbar Position is set to Left or Right.
  
  Possible values:
  
  - **Vertical:** The session texts are rotated by 90°.
  - **Deskbar:** The session texts are not shown.

- **Taskbar Height/Width:** Specifies the height of the taskbar in pixels.

  If Number of rows/columns in Taskbar is set to Automatic, the window buttons as well as the symbols in the Quick Start Panel will be shown in a number of rows depending on the height of the taskbar. The number of rows increases in increments of 55 pixels:
  
  - **1 to 55 pixels:** One row
  - **56 to 110 pixels:** Two rows
  - **111 to 165 pixels:** Three rows
  - **166 to 220 pixels:** Four rows
  - **221 to 275 pixels:** Five rows
  - **276 or more pixels:** Six rows

  The Maximum number of rows/columns in window button list parameter is described under *Taskbar Items* (page 186).

- **Number of rows/columns in taskbar:** Specifies the number of rows for the Quick Start Panel. The following taskbar items can be broken down into a number of rows and columns: Symbols in the Quick Start Panel, window buttons,

  - **Automatic:** The number of rows for the Quick Start Panel depends on the height and width of the taskbar.
  - **Numeric value:** The chosen value specifies the number of rows for the Quick Start Panel.

- **Multi Monitor Taskbar Size:** Specifies whether the taskbar is expanded across a number of monitors or restricted to one monitor.

- **Monitor:** Specifies the screen on which the taskbar is shown. This parameter is available if Multi Monitor Taskbar Size is set to Restrict taskbar to one monitor.

- **Taskbar on top of all windows:** If this option is enabled, the taskbar is accessible from all monitors, even in sessions with a full-screen window.

- **Taskbar Auto Hide:** If this option is enabled, the taskbar is hidden and will only be shown if the mouse pointer is moved to the position of the taskbar at the edge of the screen.
• Auto Hide Behavior: Specifies when the taskbar is automatically hidden.

Possible values:
- Intelligently: The taskbar is shown as standard. The taskbar will be hidden if the space is needed by a window, e.g. a window in full-screen mode.
- Always: The taskbar is hidden as standard. The taskbar will be shown if the mouse pointer is moved to the edge of the screen.

• Taskbar Show Delay: Time interval in milliseconds before the taskbar is shown. The mouse pointer must be at the edge of the screen constantly during this time interval. This setting is only effective if Taskbar Auto Hide is enabled.

With the show delay, you can prevent the taskbar for a full-screen session being covered by the thin client’s taskbar. A show delay is necessary if the taskbar for the full-screen session is set to be shown automatically and both taskbars are positioned at the same screen edge. If no show delay is set and the user brings up the taskbar for the full-screen session, this will immediately be covered by the thin client’s taskbar.

During the show delay time interval, the user has time to move the mouse pointer away from the edge of the screen.

• Taskbar Hide delay: Time interval in milliseconds before the taskbar is hidden. This setting is only effective if Taskbar Auto Hide is enabled.

Further settings can be found under Screen Lock/Saver (page 189).

9.2.3. Taskbar background

Menu path: Setup > User Interface > Desktop > Taskbar Background

You can specify the background style for the taskbar here.

To incorporate your company logo into the taskbar, proceed as follows:
1. Select Background Image under Background Style.
2. Give the path of the background image.

See also Taskbar (page 184) under User Interface.
9.2.4. Taskbar Items

Menu path: Setup > User Interface > Desktop > Taskbar Items

- Taskbar Clock: If this option is enabled, a clock will be shown in the taskbar.
- Sorting order in window button list: Specifies the criteria according to which the window buttons are sorted.
  Possible values:
  - Timestamp: The window buttons are sorted in the chronological order in which the windows were opened.
  - Group and time stamp: The window buttons are grouped according to the type of application. If for example a number of setup applications are open, all associated window buttons will be arranged next to each other. Within the group, the window buttons are sorted chronologically.
  - Window title: The window buttons are sorted alphabetically.
  - Group and window title: The window buttons are grouped according to type. If for example a number of setup applications are open, all associated window buttons will be arranged next to each other. Within the group, the window buttons are sorted alphabetically.
  - Drag’n’Drop: You can order the buttons as you wish using drag and drop. You must drag a button over at least half of the button to be skipped.
- Maximum number of rows/columns in window button list: Specifies the maximum number of rows available for window buttons.
  Possible values:
  - Automatic: The number of rows depends on the Taskbar height/width and Number of rows/columns in taskbar parameters, see Taskbar (page 184).
  - Numeric values: This value specifies the maximum number of rows.
- Show labels in window button list: If this option is enabled, the names of ongoing sessions are shown in the associated window buttons. If this option is disabled, only the symbols are shown.
- Taskbar System Tray: If this option is enabled, the system tray will be shown in the taskbar.
- Size of icons in system tray: Specifies the size of system tray icons (volume, network connection etc.).
  You can choose a pre-defined value or enter a numeric value between 1 and 64.
  Predefined values:
  - Automatic: The size is adjusted to the height and width of the taskbar.
  - Small: 20 pixels
  - Medium: 40 pixels
  - Large: 60 pixels

Further settings can be found under On-screen Keyboard (page 163), Keyboard and Additional Keyboard layouts (page 194) and Screen Lock/Saver (page 189).
9.2.5. Pager

Menu path: Setup > User Interface > Desktop > Pager

In this area, you can enable the use of a number of virtual workstations.

The Pager is a tool with virtual desktops which can be used as an easy way of switching between open applications. This window is shown at the right of the taskbar. You can use up to 25 virtual desktops. If you use a Pager, you can switch between full-screen applications for example at the click of a mouse.

Instead of minimizing/maximizing sessions or switching between them using key combinations, you simply click on the desired screen using the mouse. The screen is then shown as it was when you closed it (unless you restarted the system beforehand).

- Use pager: Allow a number of virtual desktops.
- Number of Screens - Horizontal: Specify how many pages you want to display next to each other.
- Number of Screens - Vertical: Specify how many pages you want to display above each other.
- Names of the workspaces: Give names for the individual desktops.
- Paging Resistance: Specify how many pixels the cursor needs to be moved over the edge of the screen before it triggers a switch of desktop. You only need to make this setting if you enable at least one of the following options:
  - Wrap Workspaces when dragging a window: The desktop is switched as soon as a window is dragged out of view.
  - Wrap Workspaces with pointer: The desktop is switched as soon as the mouse reaches the edge of the screen.

9.2.6. Start menu

Menu path: Setup > User Interface > Desktop > Start Menu

In this area, you can configure the Start Menu:

There are three Start Menu Types:

- Legacy: Standard setting which is similar to that from Windows 95 - a list of available sessions and options.
- Advanced: An expanded start menu featuring a search function and a more attractive design It requires more resources, which is particularly noticeable on slow devices.
- Auto: Automatically select the classic or advanced start menu depending on the processor.

Pick from the following options which items are to be shown in the Start Menu:

- Lock Display Button
- Logout Button
- Restart Button
- Shutdown Button
- System Tab
- About Button
9.2.7. In-Session Control Bar

Menu path: Setup > User Interface > Desktop > In-Session Control Bar

The session control bar allows you to eject a USB drive from a full-screen session, to minimize a session view and to end the session.

- Use in-session control bar in all supported sessions: If this option is enabled, the session control bar will be displayed. Depending on the configuration, the session control bar will be permanently visible or will be shown as soon as you move the cursor to the top edge of the screen.

The session control bar is available for the following session types:

- RDP - see RDP Global (page 55)
- Citrix - see HDX / ICA Global (page 28), Legacy ICA Sessions (page 45) and Citrix StoreFront / Web Interface (page 49)
- ThinLinc - see ThinLinc (page 108)
- NX - see NX (page 99)
- Parallel 2X Client - see Parallel 2X Client (page 100)

To use the session control bar, proceed as follows:

➢ To eject a USB device, click on ▶️.

➢ To minimize the session view, click on ✧✦.

➢ To end the session, click on ✗.

➢ To make the session control bar permanently visible, click on ➡️.
9.3. Language

Menu path: Setup > User Interface > Language

Select the system language from the list. You can also set the keyboard layout and the input language depending on the system language.

The language selected is the language for the user interface and therefore applies to all local applications.

<table>
<thead>
<tr>
<th>Language</th>
<th>English</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard layout</td>
<td>German</td>
</tr>
<tr>
<td>Show indicator in taskbar</td>
<td>Yes</td>
</tr>
<tr>
<td>Input language</td>
<td>Follows Keyboard layout</td>
</tr>
<tr>
<td>Standards and formats</td>
<td>Follows Input language</td>
</tr>
</tbody>
</table>

Figure 41: Language Settings

9.4. Screen Saver and Screen Lock

Menu path: Setup > User Interface > Screen Lock/Saver

You can set up the screen saver so that it is activated either automatically or in response to a key combination (hotkey). You can also select a password option. The look of the taskbar can be configured separately for the login dialog and the locked screen.

Example configuration of a screen lock:
General
The screen can be locked via taskbar or desktop icons or using hotkey `Ctrl-Shift-L`.

Options
The screen lock starts automatically after 5 minutes without user action at the thin client. The screen lock can be stopped by entering a user password or administrator password (see Password).
Taskbar

The locked screen does not display the taskbar until the login dialog appears. The user can bring up a soft keyboard, e.g. to login using touchscreen monitor.

9.4.1. Options

Menu path: Setup > User Interface > Desktop > Screenlock/Screensaver > Options

- **Start automatically**
  
  ✓ The screenlock or screensaver starts automatically if there is no activity on the thin client within this time limit. The screenlock can be overridden by the user or administrator with the relevant password (see: Password (page 234)). (default)

- **Timeout**: Period of time in minutes before the screenlock or the screensaver starts. The start of the screenlock can be initiated by a countdown. (default: 5)

**Screen Lock Password:**

✓ **None**: No password is set. A screenlock cannot be set up.

✓ **User Password**: The user password is used. If the user has logged in via AD (Active Directory), the AD password is used.

✓ **Screen Lock Password**: You can set a password of your own.
• **Countdown duration in seconds:** Duration of the countdown that initiates the screen lock. If the value is 0, the screen is locked without countdown. (default: 0)

  The appearance of the countdown’s digits can be defined together with the clock display settings under Setup > User Interface > Screen Lock/Saver > Screensaver; see Screensaver (page 193). The following parameters are relevant for the countdown:
  - Image display mode
  - Clock display monitor
  - Clock display size
  - Horizontal clock position
  - Vertical clock position
  - Clock background color
  - Clock foreground color

• **Countdown visual effect:** During the countdown, an up-to-date screenshot is displayed. This parameter defines which visual is applied to the screenshot.

  Possible options:
  - Dark screenshot (default)
  - Gray screenshot

• **Countdown background image:** Path and file name of an image that is displayed in the background. This image is displayed instead of the screenshot if the path and file name are valid; if the field is empty, the screenshot is displayed. Supported file formats: JPEG, PNG, GIF. Example: /userhome/image.jpg

• **Different Screen Lock Timeout**
  - You can specify a time limit of your own for the screen lock. (default)
  - The same time limit will be used for the screen lock as for the screensaver. This means that after the set time the screen will be locked and then the screensaver will appear.

• **Allow administrator password:**
  - Access is allowed for the user and the administrator. (default)
  - Access is allowed for the user only.

### 9.4.2. Taskbar

**Menu path:** Setup > User Interface > Desktop > Screen Lock/Saver > Taskbar

**Taskbar settings when the logon dialog is visible:**
  - Show taskbar during the logon dialog (default)
  - Show clock (default)
  - Show switch for the keyboard layout (default)
  - Show “On-screen keyboard” button
  - Start on-screen keyboard automatically
  - Show “Restart” button
☑ Show “Shut down” button (default)

Taskbar settings when the screen is locked:

☑ Show taskbar when the screen is locked (default)
☑ Show clock (default)
☑ Show switch for the keyboard layout (default)
☑ Show “On-screen keyboard” button
☑ Start on-screen keyboard automatically
☑ Show “Restart” button
☑ Show “Shut down” button

No taskbar is shown for the locked screen, the taskbar is visible in the logon dialog and allows an on-screen keyboard, e.g. for touchscreen monitors, to be shown.

9.4.3. Screensaver

Menu path: Setup > User Interface > Desktop > Screen Lock/Saver > Screensaver

• Screen background color: Color palette for determining the background color of the screen.
• Enable image display
  ☑ An image will be shown as the screensaver. (default)
• File for screen saver logo: Complete path for an individual image file or directory that contains an unlimited number of images. If no path is given, the IGEL logo will be used.

If you enter a folder instead of a single image file as the source, all images in the folder will be displayed as a slide show, the display time for the images can be configured.

• One image per monitor
  ☑ If a number of monitors are used, a different image will be shown on each one. (default)
  □ Images will be distributed across the monitors.
• Image duration: Time in seconds until the image is changed. (default: 10)
• Image display mode: Type of display. The following are available to choose from:
  - Small-sized hopping - Small images are shown in changing positions.
  - Medium-sized hopping - Larger images are shown in changing positions.
  - Full-screen center cut-out - The images are shown in full-screen size. However, they may be clipped.
  - Full-screen letterbox - The images are shown as large as possible in relation to the screen size.
• Clock display monitor: Selects the monitor on which the clock is to be shown. The following are available to choose from:
  - None
  - All
  - A specific monitor
• Show seconds: Shows the seconds in digital format.
• Clock display size: The following sizes are available to choose from:
  - Tiny
  - Small
  - Medium
  - Large
  - Huge

• Horizontal clock position
  - Left
  - Center
  - Right

• Vertical clock position
  - Top
  - Center
  - Bottom

• Clock background color: Color palette for determining the background color of the clock.
• Clock background opacity percentage: 75% is preset.
• Clock foreground color: Color palette for determining the foreground color of the clock.

9.5. Input

Menu path: Setup > User Interface > Input

These setup pages allow you to set the keyboard layout and other input options.

The following input devices can be configured:

• Keyboard (page 194)
• Mouse (page 195)
• Touchscreen (page 195)
• Signaturpad (page 199)

9.5.1. Keyboard

Menu path: Setup > User Interface > Input > Keyboard

In this area, you can configure the keyboard.

• Keyboard layout – Determines the keyboard layout. The selected layout applies for all parts of the system including emulations, window sessions and X applications.
• Keyboard type – Determines the keyboard type.
• Key repeat – Determines the automatic repeat behavior for the keyboard:
  - Repeat delay – Determines the delay (in milliseconds) before automatic repetition begins.
  - Repeat rate – Determines how often a character repeats per second.
  - Enable dead keys – Enable this function if the keyboard used supports dead keys for special characters.
• Start with NumLock on – Stipulates that NumLock is to be automatically enabled during the boot procedure.
9.5.2. Additional keyboard layouts

Menu path: Setup > User Interface > Input > Additional Keyboard Layouts

➢ You can define Additional Keyboard Layouts which can be selected by the user. The layout can be selected in the taskbar or changed via configurable hotkeys.

➢ Further settings can be configured under On-screen Keyboard (page 163).

9.5.3. Mouse

Menu path: Setup > User Interface > Input > Mouse

In this area, you can configure the mouse.

• Lefthand mode: Changes the orientation of the mouse by switching the mouse buttons to left-handed mode.
• Emulate 3-button mouse: Enables/disables emulation of the third (middle) mouse button for mice with only two physical buttons. This third button is emulated by pressing both buttons at the same time. If 3-button emulation was enabled, the emulation time limit determines how long (in milliseconds) the driver waits before deciding whether two buttons were pressed at the same time.
• Hide cursor: Cursor will be hidden after the defined timeout.
• Pointer Speed: Determines the mouse resolution in counts per inch.
• Double Click interval: Changes the maximum interval (in milliseconds) between two consecutive mouse clicks which are to be recognized as a double-click.
• Double Click Distance: Changes the maximum distance in pixels between two clicks, considered as double-click. The object under the second click receives the double-click.

9.5.4. Touchscreen

Menu path: Setup > User Interface > Input > Touchscreen

To ensure that you can open the setup and navigate within it, the initial configuration should take place with a mouse and keyboard connected. The setup procedure with an on-screen keyboard is described below.

Touchscreen drivers

The touchscreen types currently supported are:

• Elographics serial touchscreens
• TSharc serial touchscreens
• EvTouch USB touchscreens

➢ You will find the complete list of supported devices in the IGEL Linux 3rd Party Hardware Database (https://www.igel.com/linux-3rd-party-hardware-database/).

• Touchscreen already calibrated

If you enable the touchscreen function, the touchscreen must be calibrated first. Unless you enable this option, calibration will begin automatically after each system boot.
• Swap X and Y values
  Enable this option if the mouse pointer moves vertically when you move your finger in a horizontal direction.

• Minimum/maximum X value/Y value
  These values are determined by the calibration tool. However, you can also change them manually.

• Let-go limit
  The maximum permitted time (in milliseconds) between two instances of contact in order to still be registered a single touch. When moving windows by drag-and-drop, for example, your contact with the screen may inadvertently be interrupted. Increasing this value prevents the thin client from registering two individual contacts in this case.

• Contact limit
  Determines how long (in milliseconds) the screen needs to be touched in order for the contact to be recognized.

• Baud rate (for serial touchscreens only)
  Determines the speed of communication via the selected connection. (If in doubt, read the monitor manual.)

• Touchscreen connection
  You can connect the touchscreen either to COM1 or COM2. Select your preferred connection here.

• Set driver-specific default settings
  Click on this button once after changing the touchscreen type or to restore the default settings.

 ➢ A list of the touchscreens currently supported by IGEL Linux can be found in the IGEL Linux 3rd Party Hardware Database (https://www.igel.com/linux-3rd-party-hardware-database/).

 ➢ Enable the on-screen keyboard for touchscreen use in the setup under Accessories > On-screen Keyboard.
  The layout for the normal keyboard will also be used for the on-screen keyboard.

 ➢ Calibrate the touchscreen for optimum contact recognition. The touchscreen calibration application can be found under Application Launcher > System.
  After launching the calibration program, you will see a pattern with calibration points which must be touched one after another.
9.5.5. Touchpad

Menu path: Setup > User Interface > Input > Touchpad

If you use the Universal Desktop Converter, you have the option of defining touchpad settings.

The actual options depend on the particular touchpad. You will find these under User Interface > Input > Touchpad.

The settings options are subdivided into

- **Touchpad General** (page 197)
- **Touchpad Scrolling** (page 198)
- **Touchpad Advanced** (page 198)

**Touchpad General**

Menu path: Setup > User Interface > Input > Touchpad

In this area, you can configure the touchpad according to your needs.

➤ Enable Touchpad custom configuration in order to define personal settings.

![General settings for the touchpad](image)

Figure 42: General settings for the touchpad

➤ Select a touchpad mode from:
  - Enable touchpad - Decide whether you would like to enable the touchpad by default...
  - Disable touchpad - ... or disable it.
  - Disable tapping and scrolling - As an alternative, you can disable tapping and scrolling only.

➤ Use the sliders to set the speed of the mouse pointer in seconds.
With a number of touchpads, you can assign functions to the four corners. The following settings apply by default:
- **Left mouse button** - Tap on the relevant corner to highlight objects, place the cursor and move text or objects from one place to another.
- **Middle mouse button** - Tap on the relevant corner to bring up program-specific functions.
- **Right mouse button** - Tap on the relevant corner to display the context menu.
- **Disable** - Tap on the relevant corner to disable the mouse button.

### Touchpad Scrolling

**Menu path:** Setup > User Interface > Input > Touchpad

Define the properties for vertical and horizontal scrolling here.

![Figure 43: Scrolling properties for the touchpad](image)

- **Enable Vertical scrolling** in order to set the vertical scroll speed.
- **Enable Horizontal scrolling** in order to set the horizontal scroll speed.
- **Enable Two finger horizontal scroll** if required.

### Touchpad Advanced

**Menu path:** Setup > User Interface > Input > Touchpad

Further settings are possible here:

![Figure 44: Advanced settings for touchpad](image)
Enable the following functions in order to:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corner coasting</td>
<td>Continue scrolling if your finger reaches the corner when scrolling vertically or horizontally along the touchpad edges.</td>
</tr>
<tr>
<td>Circular scrolling</td>
<td>Scroll in a circular fashion. In the selection menu, specify where circular scrolling is to begin.</td>
</tr>
<tr>
<td>Tap and drag gesture</td>
<td>Move items by tapping and dragging them.</td>
</tr>
<tr>
<td>Locked drags</td>
<td>End the tap and drag gesture only after an additional tap; it will otherwise end when you let go.</td>
</tr>
<tr>
<td>Palm detection</td>
<td>Avoid triggering a function accidentally with the palm of your hand. The function must be supported by the device.</td>
</tr>
<tr>
<td>ClickPad</td>
<td>Allow ClickPads. These are touchpads with so-called integrated soft buttons on which physical clicks are possible.</td>
</tr>
</tbody>
</table>

### 9.5.6. SCIM Input Methods Platform

Menu path: Setup > User Interface > Input > SCIM Input Methods Platform

Smart Common Input Method (SCIM) platform offers entry methods for over 30 languages under Linux. You can enable one of the methods provided by the IGEL system for Chinese character sets (Simplified Chinese, Traditional Chinese) or manage generic tables for describing the entry method.

### 9.5.7. Signature Pad

Menu path: Setup > User Interface > Entry > Signature Pad

The following signature pads are available for connection to IGEL Linux thin clients:

- Softpro
- StepOver TCP
- signotec VCOM Daemon

To enable the StepOver TCP Client in order to be able to use USB signature pads from this manufacturer in sessions, proceed as follows:

1. Select the checkbox for StepOver TCP Client.
   If necessary, you can change the TCP port.
2. Click on Apply.
You will find detailed information regarding the configuration of signature pads in the How-To for StepOver Pads (http://edocs.igel.com/index.htm#10202852.htm) and Softpro/Kofax pads (http://edocs.igel.com/#10202863.htm).

To enable the signotec VCOM Daemon in order to be able to use USB signature pads from this manufacturer in sessions, proceed as follows:

1. Select the checkbox for signotec VCOM Daemon.
2. Click on Apply.
3. Go to Mapping > Serial Connections under ICA or RDP Global.
4. Enable COM Port Mapping.
5. Click on Add and choose one of these devices Search Devices.
   Under Select Available Device, you can choose from the signotec devices /dev/ttyVST0 and /dev/ttyVST1.
6. Select one of these devices.
7. Your signotec signature pad can now be used.

9.6. Hotkeys

Menu path: Setup > User Interface > Hotkeys > Commands

In order to make it easier to use your thin client, hotkeys are available for frequent operating routines. A hotkey is a combination of one or more modifiers and an alphanumeric key.

You can enable or disable hotkeys and change the keys used.

To enable or disable a hotkey, proceed as follows:

1. Highlight the hotkey in the list.
2. Click on Modify....
3. Enable or disable the Hotkey option in the dialog window.
4. Click on Continue in the dialog window.
5. Click on Apply or OK.

To change the keys used for a hotkey, proceed as follows:

1. Highlight the hotkey in the list.
2. Click on Modify....
3. In the Modifiers selection list, select a modifier, no modifier or a combination of modifiers.
4. Enter the Key.
5. Click on OK or Cancel.
9.6.1. Commands

Menu path: Setup > User Interface > Hotkeys > Commands

The following hotkeys are available and can be modified:

- Hide all windows and show desktop
- Mapping Ctrl+Alt+End as Ctrl+Alt+Del for Citrix sessions
- Open start menu
- Open start menu (2)
- Screenshot of active window
- Screenshot of entire screen
- Switch between active windows using Task Switcher
- Switch between active windows using Task Switcher (backwards)
- Switch focus to next window
- Switch focus to next window (2)
- Switch focus to next window (backwards)
- Volume down (multimedia key)
- Volume mute (multimedia key)
- Volume up (multimedia key)

9.7. Font Services

Menu path: Setup > User Interface > Fonts Services

You can import further fonts in addition to those provided by IGEL:

- XC font service (page 201)
- NFS font service (page 202)

9.7.1. XC Font Service

Menu path: Setup > User Interface > Fonts Services > XC Font Service

If you need other fonts in addition to those offered by the thin client, you can use the XC font service.

- This service must be installed on a server and fully configured there.

The advantage of using the XC font service rather than NFS is its better performance.

➢ Click on Enable XC Font Service in order to enable the following entry fields.

<table>
<thead>
<tr>
<th>XC font server</th>
<th>Give the name of the server on which the XC font service operates.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port number</td>
<td>Give the number of the port used by the font service for reception purposes - the default setting is port number 710.</td>
</tr>
<tr>
<td>Favor local fonts</td>
<td>Enable this option if local fonts are to be used before a request is sent to the font server.</td>
</tr>
</tbody>
</table>
9.7.2. NFS Font Service

Menu path: Setup > User Interface > Fonts Services > NFS Font Service

Using the NFS font service is another way to import additional fonts. The NFS font service also offers the advantage that the mount point for the fonts can be configured. This is necessary for a number of remote applications that search for your fonts in a specific directory.

➢ Define and enable an NFS font path entry in order to use the NFS font service. This will be added to the list of NFS mounted font directories.

➢ Click on Add to open the dialog window:

<table>
<thead>
<tr>
<th>Local directory</th>
<th>Defines the local directory for the mount point</th>
</tr>
</thead>
<tbody>
<tr>
<td>NFS server</td>
<td>Name or IP address of the server that makes available the font directories via NFS.</td>
</tr>
<tr>
<td>Server path</td>
<td>Path on the server under which the fonts are available.</td>
</tr>
<tr>
<td>Favor local fonts</td>
<td>If this option is enabled, local fonts are to be used before a request is sent to the font server.</td>
</tr>
</tbody>
</table>

➢ Click on Enable to enable the entry.

➢ Export the font directory to the server via NFS read-only for the thin client.
10. Network

Menu path: Setup > Network

Configure the thin client’s network connections here.

10.1. Mobile Broadband Network

If no LAN or WLAN is available at your location, you can establish a UMTS connection with the Huawei E3531 HSPA+ surf stick.

![Warning symbol]
Ensure that data traffic is adequately secured. You can do this in the following ways:

- Use a private APN.
- Use OpenVPN and block traffic that would circumvent VPN with firewall rules.

If the surf stick is already inserted and has been configured, the network connection will be established within approx. 35 seconds after the thin client boots. The network connection will remain in place until the surf stick is removed or the thin client is put on standby or shut down.

Symbols in the system tray indicate the status of the network connection:

- ![Network symbol]
The network connection is established; the thin client is online
- ![Network symbol]
The network connection was interrupted; the thin client is offline

To change the settings for the mobile broadband network, proceed as follows:

1. Right-click on or .
2. In the context menu, select the option Configure mobile broadband network.
3. Change the settings:
   - Enabled: If this option is enabled, the mobile broadband network is active.
   - APN: APN (Access Point Name) for your network connection. If you do not know the APN, ask your mobile communications operator for it.
   - Network ID: Network ID for your network connection. If you do not know the network ID, ask your mobile communications operator for it.
   - Number: Access number for your network connection. If you do not know the access number, ask your mobile communications operator for it.
   - User name: User name for your network connection. If you do not know the user name, ask your mobile communications operator for it.
   - Password: Password for your network connection. If you do not know the password, ask your mobile communications operator for it.
   - PIN: PIN for your SIM card.
4. Click on OK.
10.2. LAN Interfaces

Menu path: Setup > Network > LAN Interfaces

➢ Click on Network > LAN interfaces in the client setup.

➢ Choose between automatic network setup with the protocols DHCP and BOOTP or manual network configuration in order to set the thin client for each network interface.

<table>
<thead>
<tr>
<th>Activate default interface (Ethernet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get IP from DHCP Server</td>
</tr>
<tr>
<td>Specify an IP Address</td>
</tr>
<tr>
<td>IP Address</td>
</tr>
<tr>
<td>Network Mask</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Default Gateway</th>
<th>enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Name</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Domain</td>
</tr>
<tr>
<td>Nameserver</td>
</tr>
<tr>
<td>Nameserver</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Manually overwrite DHCP settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic DNS Registration</td>
</tr>
<tr>
<td>Dynamic DNS Registration Method</td>
</tr>
<tr>
<td>TSIG key file for additional DNS authentication</td>
</tr>
</tbody>
</table>

Figure 45: LAN Interfaces
| **DHCP** | Via the Dynamic Host Configuration Protocol, the thin client receives its IP address, network mask, DNS, gateway and other network configurations from a DHCP server. DHCP is enabled by default for LAN 1 (internal). DHCP options can be enabled in the DHCP Client menu. A list of standard options is available. However, you can also define your own options. |
| **BOOTP** | Via the BOOTP, the thin client receives its IP address, network mask, DNS, gateway and other network configurations from a BOOTP server database. |

The transferring of a setup.ini file or a boot script is not supported. BOOTP is not used to call up a boot image from a server and boot this image, in spite of what the term may imply.

| **Specify IP address manually** | Configures the network settings manually instead of searching for a DHCP server. Ensure that the fixed IP address that you enter is not used by another computer in your network. If you have to use a gateway to forward the data packages to and from the target network, click on Enable and enter the gateway IP address. |
| **Terminal name** | Give the local name of the thin client. Otherwise, the standard name IGEL <MAC address> will be generated. |
| **Enable DNS** | Configures the DNS - Specify the standard domain in which the device will work as well as the IP address of up to two name servers which will be queried one after the other. |
| **Manual overwrite DHCP settings** | Manual entries overwrite the standard route, the domain name and the DNS servers. |
| **Dynamic DNS registration** | Here, you can automatically report the current IP address of the thin client to the DNS. The DHCP and DNS methods are available. If you select DNS, you may have to specify a private TSIG key for DNS authentication. |

You can find instructions for dynamic DNS registration via DNS in an FAQ document (http://edocs.igel.com/index.htm#10203508.htm).
10.2.1. Individual Interface

Menu path: Setup > Network > LAN Interfaces > [Interface]

Under the name of the individual interface (for example Interface 1), you can overwrite some of the general settings for LAN interfaces. In addition, there are two further settings:

<table>
<thead>
<tr>
<th>IPv6 configuration</th>
<th>Here, you can choose a configuration type for operation with IPv6. You will find further details in a How-To document (<a href="http://edocs.igel.com/index.htm#10203497.htm">http://edocs.igel.com/index.htm#10203497.htm</a>).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network link type</td>
<td>Specify the network link type for the interface. The default is Automatic Recognition.</td>
</tr>
</tbody>
</table>

![Configuration of an individual interface](image)

**Authentication**

Menu path: Setup > Network > LAN Interfaces > [Interface] > Authentication

You can enable and configure network port authentication in accordance with the IEEE 802.1x standard here. The following settings are available:

- **Enable IEEE-802.1x authentication**: This option enables network port authentication.
- **EAP Type**: You can choose between the PEAP and TLS authentication procedures here.

For the EAP Type PEAP, the following phase 2 authentication methods are available to choose from under Auth Method:

- MSCHAPV2
- TLS
- GTC
- MD5

- **Validate Server Certificate**: If this option is enabled, the certificate of the server will be checked cryptographically. In order to do this, the path to the CA certificate file is required in CA Root Certificate. The file can be in PEM or DER format.

A number of the following fields need to be filled in only for specific combinations of EAP type and Auth Method.

- **Manage certificates with SCEP (NDES)**: Automatically manage client certificates with SCEP (page 219)
- **Identity**: The user name for network access
• **Password:** The password for network access

If you leave the Identity and Password fields empty, an entry mask for authentication purposes will be shown. However, this does not apply to the methods with a client certificate (TLS and PEAP-TLS) where these details are mandatory.

• **Client Certificate:** Path to the file with the certificate for client authentication in the PEM (base64) or DER format. If a private key in the PKCS12 format is used, leave this field empty.

• **Private key:** Path to the file with the private key for the client certificate. The file can be in the PEM (base64), DER or PFX format. The Private Key Password may be required for access.

---

**Wake-on-LAN**

**Menu path:** Setup > Network > LAN Interfaces > [Interface] > Wake on LAN

Select the packages or messages with which the thin client can be started via the network.

- Wake on magic packet
- Wake on ARP packet
- Wake on broadcast message
- Wake on multicast message
- Wake on physical activity
- Wake on unicast message

Figure 47: Wake-on-LAN options
10.2.2. Wireless

Menu path: Setup > Network > LAN Interfaces > Wireless

In this area, you can configure everything relating to your wireless connections.

You will find details of compatible wireless modules in our IGEL Linux 3rd Party Hardware Database (https://www.igel.com/linux-3rd-party-hardware-database/).

If you use mobile devices and regularly spend time in different wireless zones, you will benefit from our new function: IGEL Café Wireless. This means that you can

- easily connect to new, previously unknown wireless networks
- save connections that you have set up and then reuse them later on

straight from the user interface via the Wireless Manager (page 209) as you would with a smartphone. This function is irrelevant for stationary desktop devices that are managed centrally. In this case, it is assumed that the network has fixed settings and cannot be influenced by the end user.

To configure the wireless interface, proceed as follows:

1. Open the IGEL Setup and click on Network > LAN Interfaces > Wireless.

   ![Figure 48: Enable user-defined connections](image)

2. Enable the Wireless Interface.
3. Select the configuration for your IP Addresses (DHCP or manual).
4. Select a configuration type for operation with IPv6.
5. Enable at least the tray icon, context menu and Wireless Manager (page 209) items. Via the Wireless Manager (page 209), you can use IGEL Café Wireless.

   Ensure that the Overwrite sessions parameter is disabled for UMS profiles with this wireless configuration. Otherwise, user-defined connections will be lost when the thin client is rebooted.
6. Configure the wireless network connection in the *Default Wi-Fi network* (page 213) dialog if you do not select it via the *Wireless Manager* (page 209).

Additional connections can be configured in the Additional Wi-Fi networks dialog.

7. Configure your location in the *Wireless regulatory domain* (page 214) dialog.

Once these settings become active on the thin client, a new tray icon for wireless connections will appear:

![WiFi Symbol](image)

**Wireless Manager**

You can bring up the Wireless Manager from the tray icon:

![Symbol bar with WiFi context menu](image)

You will need to have switched on the Wireless Manager under Network > LAN Interfaces > Wireless (page 208)
1. Click on the Wireless Tray Icon in the task bar and then on Manage wireless network connections in order to bring up the Wireless Manager:

![Image of Wireless Manager]

Figure 51: Wireless Manager

2. Search for available networks.
   - The list of active networks is sorted according to the quality of their signal strength.
   - Previously configured connections are flagged with a tick in the Configured column.
   - The connection currently active is likewise flagged with a symbol under Connected.

3. Double-click on a network in the list in order to open the entry mask. If you are using the Wireless Manager for configuration, you only need to give the network key – this is considerably easier than using the Setup or the UMS for configuration:

![Image of Configure WiFi connection]

Figure 52: Configure WiFi connection

You can either permanently save the logon information or enter it each time you establish a connection to this network.
Click on the key symbol in order to display the key phrase while you are typing.

4. Click on the Connect network button in order to establish the previously configured connection:

![Figure 53: Establish connection to WiFi](image)

The tray icon will change and show the quality of the connection to the active network. Hidden networks appear in the Wireless Manager with the network name empty or can be defined using the Search for network button:

![Figure 54: Hidden network](image)

In order to connect to a previously unknown hidden network, you must first enter the SSID before the access data are retrieved:

![Figure 55: Name of the hidden network](image)
If you have configured the available connections, you will no longer need the Wireless Manager in order to establish a connection.

In the context menu for the tray icon, all available networks are listed and can be brought up from here.

5. The IGEL Setup shows all connections configured by the local user locally and in the UMS under Network > LAN Interfaces > Wireless > Other WLANs:

A Yes in the User-defined column means that you can change or delete this connection in the Wireless Manager. A connection that you have set up in the Wireless Manager is automatically user defined. Connections that are specified in the Setup or in the UMS can also be flagged as user defined. In most cases, however, this would not make much sense. After all, the end user should only be able to delete the connections that they themselves have set up, e.g. when traveling.
Configure Connections in the Setup

Menu path: Setup > Network > LAN Interfaces > Default Wi-Fi network

In the Default Wi-Fi network and Additional Wi-Fi networks areas, you can configure wireless network connections:

1. Select an Encryption Method.
2. Enter the Network Name (SSID).
3. Set further parameters depending on the encryption method selected.

For WPA(2) Enterprise encryption, the client certificate can also be requested and administered via SCEP. See Network/SCEP (page 220) and our Certificate Enrollment and Renewal with SCEP (NDES) (http://edocs.igel.com/#10200572.htm) How-To.

The connections defined under Additional Wi-Fi networks have the same value as the connection entered under Default Wi-Fi network. Here, you can pre-configure wireless connections which are available for selection by the user in the Wireless Manager (page 209).

The connections configured in the Wireless Manager (page 209) are likewise shown in the Additional Wi-Fi networks list and are automatically flagged as User-defined.

Connection to Hidden Networks

Hidden wireless networks (WLAN without SSID broadcasting) can also be connected to. Pre-defined connections can be used without disclosing the network name to the user. For user-defined connections, the user must however know the name of the hidden network.

To pre-configure connections to hidden networks, proceed as follows:

➢ In the IGEL Setup, go to Network > LAN Interfaces > Wireless > Default Wi-Fi network and set the AP Scan Mode parameter to No Broadcast.
Additional connections can be configured in the Other Additional Wi-Fi networks dialog.

**Wireless Regulatory Domain**

*Menu path: Setup > Network > LAN Interfaces > Wireless > Wireless Regulatory Domain*

In this area, you can configure your location:

![Wireless Regulatory Domain](image)

**Figure 60: WiFi frequency ranges**

Ensure that the Wireless regulatory domain is configured correctly in order to prevent your device making unauthorized transmissions.

### 10.3. DHCP Options

*Menu path: Setup > Network > DHCP Client > Standard Options / Custom Options*

Configure the client's use of DHCP options - a number of standard options are already set out in a list and can be enabled. User-defined options can be set up in a list of your own and managed there.

### 10.4. Virtual Private Network - VPN

*Menu path: Setup > Network > VPN*

Remote users securely access company networks via virtual private network protocols (VPN). You can set up your client accordingly for this purpose.
10.4.1. **PPTP**

Menu path: Setup > Network > VPN > PPTP

PPTP (point-to-point tunneling protocol) is one of the most common virtual private network (VPN) protocols allowing remote users to securely access company networks.

**Automatically establishing a connection during the boot procedure**

In order to set up a client which is fully configured to automatically establish a connection, you may need to dial up first.

1. Enable this option before the desktop is launched.
   
The client connects to the host.
2. Click on Add to set up new connections.
3. Configure the necessary settings in order to dial up the RAS server on the desired remote station.
4. Select the network device and specify whether a dial-up connection is to be used.
5. Specify on the Options tab the name service and the IP configuration for the PPTP connection.

These data will normally be transferred from the remote station's RAS server. This means that both DNS and IP address will be set to automatic by default.

You can set up additional network routes on the next three setup pages (Routing).

10.4.2. **OpenVPN**

Menu path: Setup > Network > VPN > OpenVPN

The OpenVPN client puts in place a virtual private network using TLS encryption and requires OpenVPN 2.x as a VPN server.

It supports the following authentication methods:

- TLS certificates
- Name/password
- Name/password and certificates
- Static key
- Certificate on eToken or smartcard

➢ Click on the star symbol to set up a new OpenVPN connection.

10.4.3. NCP

Menu path: Setup > Network > VPN > NCP

The configuration parameters for the NCP Client are configured exclusively via the client program interface itself.

You will find the documentation regarding the NCP Secure Enterprise Client at ncp-e.com (https://www.ncp-e.com/en/resources/library/manuals.html).

10.4.4. genucard

Menu path: Setup > Network > VPN > genucard

The genucard VPN hardware offers a choice of pre-configured Internet and VPN connections. The Connections window opens as soon as the genucard session is launched.

![genucard configuration](image)

Figure 61: genucard configuration

- **File:**
  - Change PIN
  - Rekeying
- **WiFi:** Opens the WiFi dialog which allows you to configure the genucard's wireless access.
- **Log:** Allows you to view the log
- **Network connection:** Select one of the network connections pre-configured on the genucard, for example LAN or WLAN.
- **VPN connection:** Select one of the VPN connections pre-configured on the genucard.
WiFi Configuration

Menu path: Setup > Network > VPN > genucard

In this dialog, you can configure how the genucard connects to wireless networks.

Figure 62: genucard WiFi Configuration

- **WiFi**: Here, you can set the wireless access that the genucard uses.

  Unencrypted networks and networks secured with WEP, WPA or WPA2 are supported.

  - **Search**: Searches for available wireless networks. This can take up to a minute.
  - **Password**: The password for the wireless network set
  - **Show**: If this option is enabled, the password will be visible.

  Passwords are saved in encrypted form in the IGEL setup.

- **Saved connections**
  - **Delete**: Deletes the selected connection.
  - **Edit**: Opens the selected connection for editing.
Options

Menu path: Setup > Network > VPN > genucard > Options

A valid combination of connection and user data can be pre-populated in the IGEL setup: Network > VPN > genucard > Options.

![Options settings](image)

Figure 63: Automatically establishing connections

A facility for automatically establishing a connection during the boot procedure can also be enabled. This is necessary when updating the IGEL firmware via the VPN for example.

Administrator Session

The GeNUCard is configured and administered centrally via the genucenter management station. Further information is available from www.genua.de (https://www.genua.de/en.html).

Optionally, an administrator session allowing the GeNUCard Internet connection to be configured can be set up:

1. Click on Add instance under System > Registry > genucard%.
   The GeNUCard icon will appear on the desktop.
2. Click on the GeNUCard icon.
   The GeNUCard logon window will open.
3. Enter a user name and password.
4. Click on Logon.

The Internet/VPN window will open.

![Internet/VPN window](image)

Figure 64: Internet/VPN window

5. In the Internet area, configure the connection with the help of the Create, Edit, Delete buttons.

### 10.5. Simple Certificate Enrollment Protocol - SCEP

**Menu path: Setup > Network > SCEP Client (NDES)**

SCEP allows the automatic provision of client certificates via a SCEP server and a certification authority. This type of certificate is automatically renewed before it expires and can be used for purposes such as network authentication (e.g. IEEE 802.1x).

A Microsoft Windows 2008 Server (MSCEP, NDES) for example can serve as a queried counterpart (SCEP server and certification authority).

- More information can be found at Microsoft Technet, e.g. in the comprehensive article *Network Device Enrollment Service (NDES) in Active Directory Certificate Services (AD CS)* (http://social.technet.microsoft.com/wiki/contents/articles/9063.network-device-enrollment-service-n des-in-active-directory-certificate-services-ad-cs.aspx).

- Enable certificate management via SCEP client (NDES) and then make the necessary configuration settings.
10.5.1. Certificate

Menu path: Setup > Network > SCEP Client (NDES) > Certificate

➢ Under Certificate, specify the basic date for the certificate to be issued by the certification authority.

<table>
<thead>
<tr>
<th>Type of CommonName</th>
<th>If the client automatically obtains its network name, DNS Name (auto) is a good type of thin client certificate.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizational unit</td>
<td>Stipulated by the certification authority.</td>
</tr>
<tr>
<td>Organization</td>
<td>A freely definable designation for the organization to which the client belongs.</td>
</tr>
<tr>
<td>City, state, country</td>
<td>Enter the location of the client here.</td>
</tr>
<tr>
<td>RSA key length</td>
<td>Select a key length (one able to be used by the certification authority) for the certificate that is to be issued.</td>
</tr>
</tbody>
</table>

10.5.2. Certification Authority

Menu path: Setup > Network > SCEP Client (NDES) > Certification Authority

➢ Enter the name of the certification authority (CA) and the hash value of the root certificate.
   You will receive both of these from the certification authority.

10.5.3. SCEP

Menu path: Setup > Network > SCEP Client (NDES) > SCEP

In addition to a certification authority, an SCEP server must also be defined.

➢ Enter the address and query password for the SCEP server here.

The SCEP server generates the password as a one-time password. It is needed when a certificate is requested for the first time. New certificates will be requested before the old ones expire. In this case, the still-valid certificate will serve as a means of authentication.

➢ For the purpose of checking validity, define an interval (checking frequency) and a period of time in which certificate renewal must occur.
   Example:

A certificate is valid until 31.12 in any one year. The period for renewal is 10 days. This means that a new certificate will first be requested on 21.12 of the same year.
Because of the need to enter a fingerprint (root certificate of the certification authority) and the query password (SCEP server), the configuration process is somewhat awkward. Ideally, it should be set up in the UMS as a profile and distributed to the clients. At the same time, the certificate still cannot be used for communication purposes.

10.5.4. Checking the Client Certificate

If a certificate from the certification authority has been forwarded from the SCEP server to the client, it is then stored there in the /wfs/scep_certificates folder.

The data for the certificate (e.g. its validity, creation date and hash value) can be displayed by using the shell command `cert_show_status`.

10.5.5. Example

Certificates issued and managed via SCEP can be used for purposes such as network authentication. Relevant options can be found when

- configuring IEEE 802.1x authentication
  
  Network>LAN Interfaces>Interface 1>Authentication

- or when setting up the wireless network
  
  Network>LAN Interfaces>Wireless>Authentication, WPA Enterprise Encryption, EAP Type TLS.

One problem when the client certificate is distributed via the network is that the same certificate is needed for communication. The use of the SCEP in conjunction with 802.1x authentication presents no problems to the extent that the initial request for the certificate should also be possible without a certificate.

➢ Enable the 802.1x authentication method after the SCEP has been configured.

When requesting the certificate, the client will attempt to establish a connection to the SCEP server without using any authentication. It will use the authentication only after having received the certificate.

For WLAN connections, a method of certificate-less PSK encryption must first be set up. The client will then use this connection to obtain the certificate. After this, the WLAN connection can be reconfigured once again.

While the above-mentioned method for Ethernet connections will also function via the UMS, the initial configuration of the WLAN can only be performed on the client as the WLAN is disabled by default.

10.6. Routing

Menu path: Setup > Network > Routing

This setup page allows you to specify additional network routes if necessary.

➢ In the Interface field, specify "eth0", "eth1" or "wlan0", i.e. Interface 1+2 or Wireless LAN.

You can specify up to five additional network routes.
10.7. Hosts

Menu path: Setup > Network > Hosts

If no DNS (Domain Name Service) is used, you can specify a list with hosts in order to allow translation between your IP address, the fully qualified host name and the short host name.

1. Click on Add to open the dialog window.
2. Enter the IP address of the host you would like to add.
3. Give the fully qualified host name (e.g. <mailserver.igel.de>).
4. Give the short host name of the host (e.g. <mailserver>).
5. Confirm the details you have entered by clicking on OK.

The specified host will now be added to the computer list.

10.8. Network Drives

Menu path: Setup > Network > Network Drives

Under Network Drives, you determine both the drives that are to be connected during booting and the associated logon data.

You can allocate a drive letter for each drive:

If no letter is entered, the drive will need to be connected manually later on.

If the logon data for the relevant server were saved in the IGEL setup, no further logon data will be requested.

If the letter allocated is already reserved, only the drive connected first will be shown. An error entry for the second will appear in the event log.

10.8.1. NFS

Menu path: Setup > Network > Network Drives > NFS

With NFS (Network File System), you can share files via the network. The NFS server exports a system file, and the NFS client (your thin client) links this file to a mount point within its own file system. The exported file system then becomes a logical part of the thin client file system although, in physical terms, it remains on the server.

In order to set up an NFS mount, the server must first be configured. You will find detailed information on NFS on the relevant pages of the manual for your server operating system.
The procedure for sharing files via the NFS server is as follows:

➢ Click on Add to open the dialog window for NFS.

You can then enter the following:

<table>
<thead>
<tr>
<th>Enabled</th>
<th>The NFS mount is enabled by default and is mounted each time the system boots. Disable this entry if the shared file system is not universally needed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local directory</td>
<td>Details of the local directory onto which the shared items are to be mounted on the local thin client file system.</td>
</tr>
<tr>
<td>Server</td>
<td>The name or IP address of the NFS server which provides the shared files.</td>
</tr>
<tr>
<td>Path name</td>
<td>Details of the path name as exported by the NFS server.</td>
</tr>
</tbody>
</table>

10.8.2. Windows Drive - SMB

Menu path: Setup > Network > Network Drives > Windows Drive

SMB is used by Microsoft Windows NT, Windows 95/98, Windows 2000 and Windows XP etc. to share hard drives and printers. As Unix (including Linux) can process this protocol with Samba Suite tools, hard drives and printers can be used along with Windows hosts. Consequently, items shared via SMB can be integrated into the thin client by Windows or Unix Samba hosts.

The SMB protocol is used only to share files via the network (not for printers). Shared items which are to be mounted must first be created on the Windows or Unix host.

You can find a sample configuration at the end of this page.

To manage the drive list, proceed as follows:

• Click + to create a new entry.
• Click - to remove the selected entry.
• Click ✏️ to edit the selected entry.
• Click 📡 to copy the selected entry.

Clicking + will bring up the Add dialogue, where you can define the following settings:

• Enabled: Defines whether the configuration entry will be applied.
  ✔️ The network drive will be integrated.
• Local Mount Point: The local directory under which the server directory is to be visible (default: /smbmount)
• Server: The IP address, Fully-Qualified Domain Name (FQDN) or NetBIOS name of the server.
• Share Name: Path name as exported by the Windows or Unix Samba host.
• User name: User name for your user account on the Windows or Unix Samba host.
• Password: Password for your user account on the Windows or Unix Samba host.
• User writable

  ✅ The user can not only read but also write directory contents. Otherwise, only the local root user is able to do this.

  ❌ The user can only read directory contents. (default)

Sample configuration entry

The following picture shows a sample configuration entry.

If a NetBios name is provided for Server, make sure it is not preceded by slashes, e.g. `\myComputer` (wrong) vs. `myComputer` (correct).

For Local Mount Point, only `/` (Linux/Unix-style forward slash) can be used as a path separator. Note that if you enter, for example, `smbmount` as a mount point, a directory called `/smbmount` will be created, because `\` is a legal character in Linux directory names.

For Share Name, however, `/` (Linux/Unix-style forward slash) or `\` (Windows-style backward slash) can be used as a path separator.
10.9. Proxy

Menu path: Setup > Network > Proxy

Select the communication protocols for which a system-wide proxy is to be used.

![System-wide proxy configuration](image)

Figure 65: System-wide proxy
11. Devices

Menu path: Setup > Devices > Hardware info

➢ Click on Hardware Information for an overview of your IGEL thin client device.

11.1. Printers

Menu path: Setup > Devices > Printer

With the Enable client printer function, the locally connected thin client printer is made available for your ICA sessions, provided that it was not disabled on the server side.

The printers must be set up on the Devices > Printers > CUPS > Printers page and must be enabled there for mapping in ICA sessions, see ICA sessions (page 45).

Because the thin client merely places incoming print jobs in a queue, you need to install the printer on the server. Proceed in the usual way: Start > Settings > Printers etc.

Please note that you will need to be logged on as administrator to the terminal to which the printer is connected.

11.1.1. CUPS - Common UNIX Printing System

Menu path: Setup > Devices > Printers > CUPS

The Common UNIX Printing System™ (or CUPS) is the software which allows you to print from within applications, e.g. from this web browser.

CUPS converts the page descriptions produced by the application, e.g. "Insert Paragraph", "Draw Line" etc., into data which can be read by the printer, and then sends this information to the printer.

With the appropriate configuration, CUPS can use printing devices via the following connections:

- Parallel (LPT 1, LPT 2)
- Serial (COM1, COM2, USB COM1, USB COM2 – with USB serial adapter)
- USB (1st and 2nd USB printer)
- Network (TCP/IP, LPD, IPP)

Printers

Printers can be created and edited here.

➢ In the edit dialog, specify a printer name which begins with a letter.
General

- Under Printer Connection, select the interface type for locally connected printers or the network protocol for network printers.
- Depending on the above, enter the relevant configuration data for the interface or network printer.
- Select the local printer driver under Manufacturer and Printer Name.

Mapping in sessions

- Map printer in NX sessions: Makes the printer available in NX sessions.
- Map printer in ICA sessions: Makes the printer available in ICA sessions.
- Map printer in RDP sessions: Makes the printer available in RDP sessions.

The remaining parameters are used to select the printer driver in ICA and RDP sessions on Windows servers.

- Give the name of the driver under Windows which is to be used.
  If it does not feature in the list, it can be specified under Use user-defined windows driver name.

When printing in ICA and RDP sessions, the print data are normally prepared for the printer model by the Windows printer driver and are passed unchanged from the thin client to the printer.

An exception is encountered when using the Windows driver in ICA sessions: Manufacturer: Generic, model: Generic PostScript. In this case, the print data are prepared on the thin client with the help of the printer driver defined above under Printers for the printer model. This requires thin client resources depending on the size of the print job.

IPP printer sharing

The IPP (Internet Printing Protocol) offers the following configuration options:

- Network or host for sharing local printers: Allows printing on the local device from either the local or the global network.
- Enable IPP printer browsing: Allows you to search for shared printers in the local or global network and show your shared printers within the network. A shared printer is visible within the network but it may not be possible to print from the network if you do not have the necessary authorization.
11.1.2. LPD - Line Printer Daemon

Menu path: Setup > Devices > Printer > LPD

LPD printers are used by the BSD printing system and are also supported by Windows servers.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable LPD print server</td>
<td>Makes the thin client an LPD print server. The CUPS printers defined under 11.2.1.1 can be addressed under their printer name as a queue name via the LPD protocol.</td>
</tr>
<tr>
<td>Print data conversion</td>
<td>Attempts to automatically recognize whether or not the print data need to be prepared by the local printer driver. The None option always forwards the print data unchanged to the printer.</td>
</tr>
<tr>
<td>Max. simultaneous connections</td>
<td>Limits the number of print jobs that can be accepted at the same time.</td>
</tr>
<tr>
<td>Restrict LPD access</td>
<td>Specifies the sub-networks or hosts from which print jobs can be accepted.</td>
</tr>
</tbody>
</table>

11.1.3. TCP/IP

Menu path: Setup > Devices > Printer > TCP/IP

You can assign printers connected to your device to a TCP/IP port. The LPT1 (TCP/IP port 3003) is enabled by default. The printer can be connected to one of the following connections, provided that they are available on the device:

- Serial connection (COM 1 or COM 2)
- Parallel connection (LPT 1)
- USB (USBLP 1)
- Additional serial connections: USB adapter or Perle expansion card

Data are forwarded bidirectionally at serial interfaces. This means that other serial devices such as barcode scanners or scales can be operated too.
11.1.4. ThinPrint

Menu path: Setup > Devices > Printer > ThinPrint

ThinPrint allows the bandwidth provided for the transfer of print jobs to be reduced depending on the resources available. The ThinPrint client prints either on printers connected to a local interface (serial, parallel or USB), on an LPD network printer or on a CUPS printer defined on the thin client.

The following parameters can be found on the ThinPrint setup page:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port number</td>
<td>Specify the port number via which the ThinPrint daemon is to communicate. Make sure that the port number on the ThinPrint client and the ThinPrint server is the same (communication will otherwise not be possible).</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>Enter a bandwidth value (in bits per second) which is lower than or equal to the value specified on the ThinPrint server. A higher value, the disabling of client control or no entry at all means that the ThinPrint server values will be used.</td>
</tr>
<tr>
<td>Waiting time between print attempts</td>
<td>Maximum waiting time (in seconds) if a printer is unavailable</td>
</tr>
<tr>
<td>Number of print attempts</td>
<td>Number of attempts to contact a printer in order to start a print job.</td>
</tr>
</tbody>
</table>

The list of ThinPrint printers is shown on the Printer page.

- Here you can manage printer configurations by adding, editing or deleting printers.

The page provides an overview of pre-configured ThinPrint printers:

<table>
<thead>
<tr>
<th>Active</th>
<th>Indicates whether or not the printer is visible.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the printer</td>
<td>Name under which the printer can be addressed.</td>
</tr>
<tr>
<td>Printer class</td>
<td>Name of the printer class - optional, max. 7 characters without spaces</td>
</tr>
</tbody>
</table>

Device:
- The following options are available here:
  - + /dev/ttyS0, /dev/ttyS1, ... serial interface
  - + /dev/lp0, /dev/lp1, ... parallel interface
  - + /dev/usblp0, /dev/usblp1, ... USB printer
  - + Name of a CUPS printer with LPD network printer connection: ThinPrint client prints via the network to the LPD network printer.
  - + Name of another CUPS printer: ThinPrint client forwards print jobs to the appropriate printer in the CUPS printing system.

Standard:
- Defines the selected device as the standard printer.
11.2. USB Storage Devices

Menu path: Setup > Devices > Storage Devices

USB storage devices can be configured here.

11.2.1. Hotplug storage devices

Menu path: Setup > Devices > Storage Devices > Storage Hotplug

In this area, you can set up the connection of hotplug storage devices. These can be USB mass storage devices or MMC card readers for example.

You can change the following settings:

• Default permission: Default access permissions for hotplug storage devices.
  Possible values:
  - Read/Write
  - Read only

• Enable dynamic client drive mapping. If this option is enabled, hotplug storage devices are automatically added and removed during ICA sessions and RDP sessions.

Before you mechanically disconnect the hotplug storage device from the thin client, you must remove it safely. To do this, click on the taskbar.
If the following warning is shown: The device is still in use! Do NOT disconnect the device., the hotplug storage device must not be removed. Close either the named program or close all open files or directories within a session that are located on the hotplug storage device.

• Number of storage hotplug devices: The number of hotplug storage devices that can be used in the session.
• Private drive letter for storage drives: If this option is enabled, each hotplug storage device will be assigned an individual drive letter. If this option is disabled, a single drive letter will be generated for all hotplug storage devices and each hotplug storage device will be assigned a sub-directory.
• Start storage drives with this drive letter: Letter that is assigned to the first hotplug storage device if automatic drive mapping is enabled. Further hotplug storage devices are assigned the next letter alphabetically.
• ICA read access to hotplug storage devices: Specifies whether read access to hotplug storage devices is allowed in an ICA session.

This setting is only effective if Enable dynamic drive mapping is disabled.

Possible values:
- Yes: Read access is allowed.
- No: Read access is not allowed.
- Ask user: Read access can be allowed on request.
ICA write access to storage hotplug devices: Specifies whether write access to hotplug storage devices is allowed in an ICA session.

This setting is only effective if Enable dynamic drive mapping is disabled.

Possible values:
- Yes: Write access is allowed.
- No: Write access is not allowed.
- Ask user: Write access can be allowed on request.

Use storage hotplug beep: If this option is enabled, a signal tone will be heard when connecting and disconnecting hotplug storage devices.

Show storage hotplug message: If this option is enabled, hotplug messages will be shown when connecting and disconnecting hotplug storage devices.

Message timeout: Period of time after which the window with the hotplug messages is hidden. If the time period is set to 0, the window will be shown until it is closed manually.

Further settings options can be found under Drive Mapping (Citrix) (page 31), Drive Mapping (RDP) (page 59) and USB Access Control (page 232).

### 11.2.2. Automount Devices

**Menu path:** Setup > Devices > Storage Devices > Automount

Here you can define the devices which are to be mounted automatically when accessed:

<table>
<thead>
<tr>
<th>List of automount devices</th>
<th>Overview of the automount devices - The most commonly used devices such as the disk drive, CD-ROM etc. are pre-configured.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Opens and enables one of the pre-defined devices</td>
</tr>
<tr>
<td>Add</td>
<td>Manual configuration of devices not pre-defined in the automount device list.</td>
</tr>
<tr>
<td>Name</td>
<td>Name given to a device - This name is also used for the sub-directory created in /autofs/.</td>
</tr>
<tr>
<td>Device</td>
<td>Allows you to select a suitable device synonym - This can also be entered manually.</td>
</tr>
<tr>
<td>File system type</td>
<td>Definition of the file system - The auto option should normally be used. If, however, you use ext2 or a problem occurs, you should clearly indicate the file system that you use.</td>
</tr>
<tr>
<td>Automount time-out</td>
<td>Regulates the time-out period - Specify in seconds how long the system should wait before the devices accessed are unmounted. The time period ranges from 0 to 600 seconds (10 minutes).</td>
</tr>
</tbody>
</table>

Do not set the time-out period to zero! This may result in data loss.
11.3. Bluetooth

Menu path: Setup > Devices > Bluetooth

- Activate Bluetooth
  - ✔ The Bluetooth service is active. The Bluetooth Tool (page 164) can be used.
  - ❌ The Bluetooth service is inactive. The Bluetooth Tool (page 164) cannot be used.
- Tray Icon
  - ✔ A Bluetooth symbol will be shown in the system tray. You can launch the Bluetooth Tool (page 164) by double-clicking on the Bluetooth symbol. Right-clicking on the Bluetooth symbol will bring up an overview as to which Bluetooth devices are connected to the thin client and you can enable or disable Bluetooth.

11.4. USB access control

Menu path: Setup > Devices > USB Access Control

You can allow and prohibit the use of USB devices on your thin client. Specific rules for individual devices or device classes are possible.

To enable USB access control, proceed as follows:

1. Enable the option Enable.
2. Select the Default Rule. The default rule specifies whether the use of USB devices is generally allowed or prohibited.
3. Create one or more rules for classes of devices or individual devices.

To create a Class Rule, proceed as follows:

1. To create a new rule, click ✭ in the Class Rules area.
2. Choose a rule. The rule specifies whether use of the device class defined here is allowed or prohibited.
3. Under Class ID, select the class of device for which the rule should apply. Examples: Audio, Printer, Mass Storage.
4. Under Subclass, select the subclass for which the rule should apply or All [device class] for all subclasses.
5. Under Name, give a name for the rule.
6. Click OK or Cancel.

The rule is active.

To create a Device Rule, proceed as follows:

When a rule is defined, at least one of the properties Vendor ID or Product ID or Uuid must be given.

1. To create a new rule, click ✭ in the Device Rules area.
2. Choose a rule. The rule specifies whether use of the device defined here is allowed or prohibited.
3. Give the Vendor ID of the device as a hexadecimal value.
4. Give the Product ID of the device as a hexadecimal value.
5. Give the Device Uuid (Universal Unique Identifier) of the device.
6. Specify Permissions for the device.
   Possible values:
   - Global setting: The default setting for hotplug storage devices is used; see Default Permission parameter under *Hotplug Storage Devices* (page 230).
   - Read only
   - Read/Write
7. Under Name, give a name for the rule.
8. Click on Next.
9. Click on Ok or Cancel. The rule is active.

Example:
- The set rule prohibits the use of USB devices on the thin client.
- A class rule allows the use of all entry devices (HID = Human Interface Devices).
- A device rule allows the use of the USB storage device with the UUID 07FC-FDC6.
- The use of all other USB devices, for example storage devices or printers, is prohibited.

![USB access control]

Figure 66: USB access control

Further settings can be found under *Storage Hotplug* (page 230).
12. Security

Menu path: Setup > Security

In order to prevent unauthorized access to the thin client setup which could allow deeper penetration into your network, it is essential that you set up an administrator password following the initial configuration.

➢ You can also use an additional user password which offers various options for permitting restricted configuration by users.

12.1. Password

Menu path: Setup > Security > Password

➢ Under Password, set up an administrator password and a user password.

Administrator and user password

Sets passwords for the administrator and user accounts. The setup will be protected by the administrator password unless the user has been granted access to specific areas.

By enabling this password, the IGEL setup, shell access to Xterm and access to the console will be restricted to the administrator. The Reset to Factory Defaults option may only be used with this password. If the setup is locked by an administrator password single setup pages can be enabled for the user - see Enable Setup Pages for User (page 24).

Remote user password

Sets a password for the remote session user (SSH).

Setup user

Allows the user to access the local setup.

When you enter a password, ensure that the correct keyboard layout is enabled. After all, you will only see stars instead of characters when entering the password and will not be able to see why the password was not accepted.
12.2. Login Options

Menu path: Setup > Devices > Security > Logon

➢ Here you can configure the local login procedure for the thin client. You can login via the IGEL smartcard or via the Kerberos protocol, e.g. in a Windows domain.

12.2.1. IGEL Smartcard

Menu path: Setup > Devices > Security > Logon > IGEL Smartcard

<table>
<thead>
<tr>
<th>Logging in with IGEL smartcard</th>
<th>Enables local login to the thin client with the IGEL smartcard. Sessions stored on the smartcard become available. The thin client is locked without the smartcard and optional password.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable IGEL smartcard without locking the desktop</td>
<td>Enables sessions stored on the smartcard after entering an optional password. The thin client is not locked – even without a smartcard.</td>
</tr>
<tr>
<td>Company key</td>
<td>Shared key for smartcards and thin clients. For more details see smartcard personalization (<a href="https://www.youtube.com/watch?v=pxwOB8lKyU8">https://www.youtube.com/watch?v=pxwOB8lKyU8</a>).</td>
</tr>
</tbody>
</table>

You can use the optional IGEL smartcard for local authentication and personalized session configuration ("Flying Doctor Scenario").

The procedure when using the IGEL smartcard with the internal card reader or an external reading device (USB) is as follows:

1. Enable the IGEL smartcard solution under Security→ Login→ Smartcard in the setup application.
2. Enter a company key to describe your IGEL smartcard.
3. Save your settings before you start personalizing the card.
4. In the Personalization window, you can set a login password and add sessions to the card.
    Session configurations are stored on the card’s IC (integrated circuit) and the session can be used on
    any IGEL thin client which reads the card.

![Smart Card Personalization](image)

**Figure 68: Smartcard personalization**

**Company Key**

The IGEL smartcard solution also contains a company key. This is an additional code which is written to the
    card and which must match the code of the terminal used. If the two codes do not match, the smartcard
    cannot be used on that particular terminal. This additional security feature ensures that your terminals
    cannot be accessed from outside your company. It can also be used within the company in order to restrict
    employees' access to specific terminals.
Save User and Password

The procedure for saving users and passwords for authentication is as follows:

➢ Enter the first name and surname of the user.
   You will then be prompted to enter the password for this name.

If the Demand Password option is enabled, a pop-up window will always open when a smartcard is inserted. If the wrong password is entered, access to the terminal will be denied.

If the smartcard is merely used to control access to the terminal, the procedure is as follows:
1. Insert a suitable smartcard.
2. Click on Write to Card in order to write the data to the card.
3. Remove the smartcard once the writing operation is complete.

You can now program the next smartcard.

Save Sessions

Saving sessions on the smartcard

If an employee uses a number of different terminals or the terminals are used by many different employees, it may be a good idea to save the sessions used by an employee on his smartcard instead of on the terminal. In this way, the user only needs to call up the applications he requires in order to perform his duties.

The procedure for saving sessions on the smartcard is as follows:
1. Insert the employee's smartcard into the terminal.
   The applications used by the employee are shown on the terminal.
2. Create the sessions you would like to add to the smartcard on the terminal (including an autostart option and personalization of login information).
   On addition to the first name/surname of the card user and an optional password, you can also add to the smartcard the sessions shown in the Available Sessions area.
3. Once you have added all the required sessions, click on Write to Card in order to save the data on the smartcard.

Test Smartcard

➢ Test the card you have created.
After performing a warm start and inserting the smartcard, the sessions will be shown immediately on the desktop. Every session which is set to start automatically when you insert the smartcard will be launched.
12.2.2. AD/Kerberos

Menu path: Setup > Devices > Security > Logon > Active Directory / Kerberos

These setup pages allow you to enable local login to the thin client via the Kerberos protocol.

AD/Kerberos must also be configured (page 238) for this purpose.

The login can be used for single sign-on in a number of session types (ICA, RDP).

- Login to Active Directory Domain: Connects the login method with the Active Directory.
- Login methods:
  - Explicit: Expects login with username and password.
  - Remember last user name: Initializes the login mask with the username of the last known user. Therefore the option Explicit has to be enabled.
  - Smartcard: Expects login with smartcard.
  - Smartcard Removal Action: Choose which action is to be performed when a user logged in via smartcard removes the card:
    - Log Off
    - Lock Thin Client

Select the type of smartcard under Active Directory / Kerberos > Smartcard and decide which Smartcard Removal Action shall be executed.

- Logoff shortcut locations: Defines the logoff method; for further information, see Desktop Integration (page 27).

12.3. AD/Kerberos Configuration

Menu path: Setup > Security > Active Directory / Kerberos

- Enable
  - The Kerberos basic configuration will be carried out.
  - The Kerberos basic configuration will not be carried out. (default)

- Default domain (Fully Qualified Domain Name): This value must match the Windows domain on which the logon is to take place, e.g. EXAMPLE.COM.
  - The value must be entered in upper case letters.

- DNS lookup for domain controller
  - In order to find the key distribution centers (KDCs, domain controllers) and other servers for a realm, DNS SRV records are used if they are not explicitly indicated. (default)
  - The key distribution centers entered under Setup > Security > Active Directory/Kerberos > Domain 1 ... Domain 4 will be used.
• DNS lookup for domain
  ✔ In order to determine the Kerberos realm of a host, DNS TXT records are used. (default)
  ☐ The details under Setup > Security > Active Directory / Kerberos > Domain Realm Mapping are used.
• Obtain addressless tickets
  ✔ The first Kerberos ticket is addressless. This may be necessary if the client is located behind an NAT device (Network Address Translation). (default)

12.3.1. Realm 1-4

Menu path: Setup > Security > Active Directory/Kerberos > Domain 1 ... Domain 4

Up to 4 domains where a login is possible can be configured here.

To configure a domain, proceed as follows:
1. Under Domain name, give the name of the domain (Kerberos realm).
2. Click to create a new entry.
3. Under Domain controller, give the name or IP address of the domain controller (Kerberos key distribution center). A port number can be added to the host name; the port name must be preceded by a colon.
4. Click on Continue.
   The domain controller will be added to the Domain controller list.

12.3.2. Domain-Realm Mapping

Menu path: Setup > Security > Active Directory / Kerberos > Domain Realm Mapping

With domain realm assignment, a host name is translated into the corresponding Kerberos realm name.

• Use default DNS domain - Active Directory domain mapping
  ✔ The DNS name and Active Directory domain name match. (default)
  ☐ DNS name and Active Directory domain name assignments must be set up.

To set up a DNS name to Active Directory domain name assignment proceed as follows:
1. Click to create a new entry.
2. Under DNS host or domain name, enter the host name that is to be assigned to an Active Directory domain name.
3. Under Active Directory domain name, enter the Active Directory domain name that is to be assigned to the host name.
4. Click on Continue.
   The data entered will be added to the Domain realm mapping list.
12.4. Smartcard

Menu path: Setup > Security > Smartcard

In this area, you can define settings for authenticating using a smartcard. You can activate the PC/SC daemon (page 240) and select a custom PKCS#11 module (page 241).

12.4.1. Services

Menu path: Setup > Security > Smartcard > Services

The PC/SC service makes the smartcard reader connected to the thin client and thus the smartcard inserted available to an application. This can be a server-side application where the data are forwarded via an RDP or ICA connection or a local application, e.g. the browser.

- Enable PC/SC daemon
  - ☑ The PC/SC service is enabled. The card reader is available for applications. (default)
  - ☐ The PC/SC service is disabled. The card reader is not available.
- Currently active PC/SC devices: List of smartcard readers currently connected to the thin client. Internal smartcard readers and a variety of USB smartcard readers are supported.

You will find a list of supported smartcard readers in the IGEL Hardware Database (https://www.igel.com/linux-3rd-party-hardware-database/).

- Cherry USB2LAN proxy
  - ☑ The Cherry USB2LAN proxy is active and makes Cherry electronic health card devices available in the network via SICCT.
  - ☐ The Cherry USB2LAN proxy is disabled. (default)
- Network interface (if the Cherry USB2LAN proxy is enabled)
  - auto: The first network interface with IPv4 address will be used for the proxy. (default)
  - eth0: The Ethernet interface will be used.
  - wlan0: The WLAN interface will be used.
12.4.2. Middleware

Menu path: Setup > Security > Smartcard > Middleware

Select the library which matches your card or your token from the following PKCS#11 modules:

- Gemalto/SafeNet eToken
- cryptovision sc/interface
- Gemalto IDPrime
- Athena IDProtect
- A.E.T. SafeSign
- Secmaker Net iD
- TCOS 3 NetKey
- TCOS 3 SigG
- TCOS 3 Elster
- TCOS 3 SD
- Custom

To use the CoolKey cryptographic library, refer to the FAQ Using the Coolkey Cryptographic Library (http://edocs.igel.com/index.htm#12400.htm)
13. System Settings

Menu path: Setup > System

As previously explained under Quick installation (page 14), various basic system settings can be configured in this sub-structure.

13.1. Time and Date

Menu path: Setup > System > Time and Date

1. Go to System > Time and Date

![Image of Time and Date settings]

2. Make your changes.

3. Click Set time and date to save your settings.

You can use a time server within your network (via Network Time Protocol (NTP)) to set time and date automatically during system boot and with periodic update. Make sure the time zone is configured correctly. Choose the region from the drop-down-menus.

Make sure the time zone is configured correctly. Choose the region from the drop-down-menus.

Note: If choosing General as Time Zone Area you have to set your GMT time zone (Location) following the POSIX standard (as usual in Linux) - which means you have to invert the offset of your common UTC time zone! (See tool tip for Location as well.) Therefore it is preferable to set the system's time zone by choosing the corresponding area and location instead of defining the GMT offset. Example for America/New York: In POSIX standard GMT+5 is the time zone 5 hours west of Greenwich and corresponds to UTC-5.

See also the FAQ: Updating Timezone Information (Daylight Saving Time, DST) (http://edocs.igel.com/index.htm#10202723_1.htm)
13.2. Update

Menu path: Setup > System > Update > Firmware Update

Here, you can specify how the thin client obtains updates for its own firmware.

- **Protocol**: Select the method for accessing the updates.
  - HTTP: Download from a web server.
  - HTTPS: Download from a TLS/SSL-secured web server.
  - FTP: Download from an FTP server.
  - Secure FTP: Download via SSH-secured FTP.
  - FTPS: Download from a TLS/SSL-secured FTP server.
  - FILE: The update lies in the thin client file system, possibly as a shared NFS or Windows update. You can choose the location by selecting a file below.

- **Server Name**: Name or IP address of the server.
- **Port**: Port of the server on which the service is provided.
- **Server Path**: The path to the directory with the update files on the server.
- **User Name**: User name on the server.
- **Password**: Password for the user account on the server.
- **Automatic Update Check on Boot**
  - The thin client will automatically search for and install an updated firmware version each time that it boots.
  - The thin client will not automatically search for an updated firmware version. (default)

- **Automatic Update Check on Shutdown**
  - The thin client will automatically search for and install an updated firmware version each time that it shuts down.
  - The thin client will not automatically search for an updated firmware version. (default)

- **Allow firmware upgrade to IGEL Linux 10**
  - The thin client allows an upgrade to IGEL Linux 10. For further information, see the How-To Upgrading from IGEL Linux v5 to IGEL Linux 10 (http://edocs.igel.com/index.htm#12642).
  - The client does not allow an upgrade to IGEL Linux 10.

- **Retry upgrade to IGEL Linux 10 despite upgrade failure**
  - If the last attempt to upgrade the thin client to IGEL Linux 10 has failed, another attempt is made. For further information, see the Best Practice Upgrading from IGEL Linux v5 to IGEL Linux 10 (http://edocs.igel.com/index.htm#12642).
  - After a failed upgrade to IGEL Linux 10, no further attempt is made.

- **Automatic Buddy Server detection**
  - The thin client will automatically search for further thin clients in the local network that offer firmware updates as buddy servers.
  - The thin client will not automatically search for buddy servers. (default)

- **Update firmware**: Launches the update process. If you have made changes on this setup page earlier on, click on Apply first.
13.3. Buddy Update

Under Buddy Update, you can specify your thin client as an update server for other IGEL thin clients. If you use a thin client as an update server, only the FTP protocol can be used to update the firmware. A number of thin clients can be set up as buddy update servers within the network.

Thin clients without a specified update server search for available servers during the update. The first update server contacted then provides the update.

- Enable Update Server
  - ✔ This thin client serves as an FTP firmware update server for other thin clients.
  - ☐ This thin client does not serve as an FTP firmware update server for other thin clients. (default)
- User Name: User name for FTP access (default: anonymous)
- Password: Password for FTP access. The asterisk * allows any password.
- Max. Concurrent Logins: Maximum number of simultaneous logons on the FTP server. (default: 10)

For further information, please see the How-To Buddy Update (http://edocs.igel.com/index.htm#10200495.htm).

13.4. Remote management

Menu path: Setup > System > Remote management

This Setup page contains settings for managing the thin client remotely via Universal Management Suite (UMS).

- Enable Remote Management: If this option is enabled, the thin client can be managed via UMS.
- Universal Management Suite: If this client is already registered with a UMS, the UMS server is found in the list. Alternatively, enter a host name or IP address in UMS Server along with a Port Number in order to make the client register with the specified UMS server.

The list may contain more than one UMS server. If the client cannot reach a UMS Server under the name igelrmserver and the DHCP option 244 is not set either, the client will try the list entries until it reaches a UMS server.

- Enable User Information: If this option is enabled, the user will be informed via a message window when the thin client receives new settings or a shutdown command.
- User Information Message Timeout: Time in seconds for which the user message window is displayed.
- Structural directory tag: This tag makes the UMS server put the client into the specified thin client directory.
- UMS Registering: This button opens the UMS Registering (page 158) utility from the System menu.

Find more information about using structural tags in the How-To Using Structure Tags (http://edocs.igel.com/index.htm#10202089.htm).
13.4.1. Legacy 'setup.ini' transfer

Menu path: Setup > System > Remote management > Legacy 'setup.ini' transfer

You can also set up the thin client by directly transferring the setup.ini configuration file:

1. In System > Remote Administration, disable the Allow remote management option in order to disable the IGEL remote management service.

2. Click on Transfer the setup.ini configuration file to load the configuration needed for the thin client directly via DHCP.

   The setup.ini file will then be administered manually without the graphical setup, e.g. of the IGEL UMS.

Two transfer protocols are available – TFTP and FTP. The corresponding DHCP tags are:

<table>
<thead>
<tr>
<th>TFTP (disabled by default)</th>
<th>FTP (enabled by default)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID 66</td>
<td>Name or IP of the server</td>
</tr>
<tr>
<td>ID 67</td>
<td>File path on the server</td>
</tr>
<tr>
<td></td>
<td>The setup.ini file will be searched for in &lt;File path&gt;/.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

It is recommended that you set the Disable when updating option at the same time. This will ensure that the setup.ini and the update data are transferred separately.
13.4.2. Logging

Menu path: Setup > System > Remote management > Logging

- Log login and logoff events
  - If a user logs on or off via Citrix or Kerberos, details of this event will be sent to the UMS and can be used there, e.g. to process support queries.
  - Logoffs from the Shared Workplace will also be logged (logons take place via the UMS anyway).

The event logs can be found under the system information for the thin clients in the UMS.

- Events are not transferred.

13.5. Remote Access

Menu path: Setup > System > Remote Access

In order to allow central administration, the thin client can be configured in such a way that it can be accessed via the WAN.

13.5.1. RSH Access

Menu path: Setup > System > Remote Access > RSH Access

Here you can enable and configure remote access to the thin client via RSH.

- Access and password settings for various users can be made under Security > Password (page 234).

- Allow remote access to applications: Enables access via RSH.
- Predefined List of Remotely Accessible Applications: By default access is allowed to Setup and Local Terminal. Use the Modify button to change the settings for these items:
  - Allow remote access to [application]: Activate this option to allow access.
  - Enable access restriction: Restrict access to a specific Remote-Host (FQDN) and/or Remote User.
- User Defined List of Remotely Accessible Applications: Here you can register your own applications that will have remote access enabled.

  ➢ Click + to create a new entry.

  ➢ Click to change the settings of an existing entry:
    - Application: Enter the absolute Linux path to the executable, e.g. /bin/bash for Bash.
    - Allow remote access: Activate this option in order to allow remote access.
    - Enable access restriction: Restrict access to a specific Remote-Host (FQDN) and/or Remote User.
    - Enable root access: If you restrict access root will be denied access unless you allow it explicitly.
13.5.2. SSH Access

Menu path: Setup > System > Remote Access > SSH Access

SSH access is enabled by default. Here you can limit SSH access to specific users and hosts.

- **Enable**
  - ✔ SSH access is enabled. (default)

- **Permit empty passwords**
  - ✔ Logging in with an empty password is permitted.
  - □ Logging in with an empty password is forbidden. (default)

- **Permit administrator login:**
  - ✔ Logging in as root is permitted.
  - □ Logging in as root is forbidden (default)

- **Port:** Port number for SSH service (default: 22)

**User access**

- **Username:** Permitted user
  
  Values:
  - root
  - user
  - ruser

- **Hostname:** Name of the host that tries to gain SSH access (e.g. xterm.igel.de)

- **Deny**
  - ✔ Access is denied.
  - □ Access is permitted. (default)

**Applications access for remote user 'ruser'**

- **Command line:** The command allowed or forbidden for ruser
- **Enable application**
  - ✔ The program specified in Command line may be executed by ruser. (default)
  - □ The program specified in Command line may not be executed by ruser.

To learn how to configure SSH Access with keys refer to the How-To Secure Shell (SSH) Access to IGEL Linux with Keys.
13.5.3. **Shadowing**

Menu path: Setup > System > Shadowing

For helpdesk purposes, you can observe the client through shadowing. This is possible via the IGEL UMS or another VNC client (e.g. TightVNC).

The user can terminate the VNC connection at any time by clicking on the End shadowing button.

- **Allow Remote Shadowing:**
  - Makes desktop contents viewable from remote computers via VNC

You can change the following settings:

- **Enable IGEL secure VNC mode:**
  - Communication will be secured via SSL/TLS and shadowing will only be possible for UMS administrators.

Further information regarding secure shadowing can be found in the Secure Shadowing (http://edocs.igel.com/index.htm#10205076.htm) How-To.

- **Use password:**
  - The remote user must enter a password before they can begin shadowing.

- **Prompt user to allow remote session:**
  - The user is asked for permission before shadowing.

  In a number of countries, unannounced shadowing is prohibited by law. Do not disable this option if you are in one of these countries!

- **Allow input from remote:**
  - The remote user may make keyboard and mouse entries as if they were the local user.

- **Maintenance screen: Show Image to hide Desktop (Windows):**
  - An image hides what is happening on the desktop during the VNC session
    - Path to image file: Local file path, for example F:\\verzeichnis\\bild.png

You can transfer the required image file to the thin client using the UMS. (http://edocs.igel.com/manuals/de/de_ums5/index.htm#2274.htm)

  - Drawing mode for the overlay image: Determines how the image is adapted to the screen size:
    - original
    - ignore aspect ratio
    - keep aspect ratio
    - keep aspect ratio by expanding
• Scale image window (Linux):

☐ The screen content of the shadowed client is reduced or enlarged by a factor before being transferred.

Further parameters for the VNC server on the client are accessible in the IGEL registry (Setup > System > Registry > network.vncserver).

13.5.4. Secure Terminal

Menu path: Setup > System > Remote Access > Secure Terminal

Here you can allow UMS users to remotely open a secure terminal (Telnet encrypted with TLS/SSL) on the thin client.

• Secure Terminal: Activate this option in order to allow secure terminal access.

13.6. Power Options

Menu path: Setup > System > Power Options

Under System > Power Options, you will find numerous settings for energy management.

13.6.1. System

Menu path: Setup > System > Power Options > System

<table>
<thead>
<tr>
<th>System standby</th>
<th>Never</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CPU power plan</th>
<th>On battery</th>
<th>Plugged in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balanced (recommended)</td>
<td>High Performance</td>
<td></td>
</tr>
</tbody>
</table>

Tray icon

Figure 70: Energy Options System
### System standby

Specify how long the user can be inactive before the system switches to standby mode – from Never or 10 Mins to 24 Hours.

<table>
<thead>
<tr>
<th>CPU power plan</th>
<th>Specify here which CPU power plan (CPU Governor) the device is to use in AC mode. Explanation of the settings:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• High Performance - full performance with maximum processor speed</td>
</tr>
<tr>
<td></td>
<td>• Balanced (smooth) - slower regulation of performance in a balanced manner according to the demands of programs. Suitable for users who are bothered by the fan frequently running at high speed.</td>
</tr>
<tr>
<td></td>
<td>• Balanced (recommended) - rapid regulation of performance according to the demands of programs (recommended).</td>
</tr>
<tr>
<td></td>
<td>• Power Saver - lowest processor speed</td>
</tr>
</tbody>
</table>

The standard settings are High Performance in AC mode and Balanced (recommended) in battery mode.

| Tray icon | Enable this setting in order to display a CPU tray icon which allows you to switch quickly between the power plans. |

#### 13.6.2. Battery

Menu path: Setup > System > Power Options > Battery

**Battery Notification**

- Critical battery level (percentage): 5
- Critical battery action: Show warning
- Critical command: Shutdown

- Low battery level (percentage): 10
- Low battery action: Show warning
- Low command: Shutdown

**Battery Tray Icon**

- Display percentage
- Display time

Figure 71: Energy Options Battery
Critical battery level (percentage) | Here you can configure the battery level percentage below which the battery level is regarded as critical. You can configure two different scenarios.

Critical battery action | Here you can specify what action is to be taken in the event of a critical battery level: No Action, Warning, Execute Command or Execute Command in Console.

Critical command | Enter a valid command here. The standard command `user_shutdown -f` shuts down the system in the proper manner.

Display percentage | Shows the battery level percentage in the tray.

Display time | Shows the remaining battery running time / charging time in the tray.

13.6.3. **Display**

Menu path: Setup > System > Power Options > Display

**Display power management settings**

- Handle display power management

<table>
<thead>
<tr>
<th></th>
<th>On battery</th>
<th>Plugged in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby Time</td>
<td>6 Minutes</td>
<td>1.0 Minutes</td>
</tr>
<tr>
<td>Suspend Time</td>
<td>8 Minutes</td>
<td>1.2 Minutes</td>
</tr>
<tr>
<td>Off Time</td>
<td>10 Minutes</td>
<td>1.5 Minutes</td>
</tr>
</tbody>
</table>

**Brightness reduction**

| On inactivity reduce to | 20 % | 80 % |
| Reduce after            | Never | Never |

Figure 72: Energy Options Display
Set the screen energy options

| Handle display power management | Enable this checkbox in order to be able to make the following settings. In older firmware versions, this option was called DPMS (Display Power Management Signaling). |
| Standby time | Specify how many minutes the user can be inactive before the screen switches to standby mode. |
| Suspend time | Specify the number of minutes before the screen switches to suspend mode. |
| Off time | Specify the number of minutes before the screen switches off. |

Brightness reduction

| On inactivity, reduce to | Specify to how many percent the screen brightness should be reduced if you are not using the device. |
| Reduce after | Specify a time between 10 and 120 seconds after which the screen brightness will be reduced. |

13.6.4. Shutdown

Menu path: Setup > System > Power Options > Shutdown

This setup page contains settings for shutting down the system.

- Allow system shutdown:
  - ☑ Allows the user to shut down the device.
- Allow system suspend:
  - ☑ Allows the user to place the device in standby mode.
- Allow canceling of shutdown process
  - ☑ Allows the user to cancel the shutdown or standby process.
- Default action: Defines which action is pre-selected in the dialog shown:
  - Shutdown
  - Suspend
  - Cancel
  - Nothing
- Dialog Timeout: Time span in seconds after which the option pre-selected in the dialog is executed.
- Disable dialog:
  - ☑ When shutting down the device, no dialog which with the user can interact is shown.

13.7. Firmware Customization

Menu path: Setup > System > Firmware Customization

Configure the firmware to create your own personal workstation.
13.7.1. Custom partition

Menu path: Setup > System > Firmware Customization > Custom Partition

IGEL Linux offers users a data partition on the storage medium. A download/update function which loads data from a server and, where appropriate, updates them can be set up for this dedicated storage area.

⚠️ If the thin client is reset to the default settings, the custom partition and all data stored on it will be deleted.

With IGEL Linux Version 5.12.100, it is possible to securely wipe the partition. You can activate or deactivate the secure wipe under System > Registry > system > security > secure_wipe. By default, secure wipe is activated.

Enabling the partition

Menu path: Setup > System > Firmware Customization > Custom Partition > Partition

The custom partition is disabled by default.

➢ Click on System > Firmware Customization > Custom Partition, in the setup to enable the custom partition in the IGEL setup for the thin client (or with the IGEL Universal Management Suite) via the setup path.

The size of the partition is shown in the form of a numerical value (bytes) followed by a multiplier.

Sensible figures are for example 100 K (for 100 KiB = 100 * 1024 bytes) or 100 M (for 100 MiB = 100 * 1024 * 1024 bytes).

![Partition](image)

**Figure 73: Enable Partition**
The size of the partition should be set to at least 100 KiB. However, no more than 300 MiB should be reserved for the custom partition (based on the 1 GB standard CF used in IGEL Linux thin clients). This is because subsequent firmware updates may require more storage space than the current version.

Figure 74: Creating Partition

➢ Click Apply or OK in order to confirm your settings.
The partition will be created and mounted at the specified location.

A status window provides information on the process and gives details of any errors when creating the partition. If for example there is insufficient space on the storage medium, it will not be possible to create the partition.

Figure 75: Error Message

If you attempt to change the size of a previously created custom partition, you may find that you are unable to do so if a process is still accessing the partition, e.g. if its content is still being shown in the terminal window.

**Defining download source**

Menu path: Setup > System > Firmware Customization > Custom Partition > Download

In order to load data onto the custom partition, at least one source for partition data must be specified in the Download area.
➢ Click on Add.

![Add](image)

Figure 76: Setting the Download URL.

The transfer protocols are the same as the ones for updating the firmware, e.g. HTTP, HTTPS, FTP. An INF file which in turn references a tar archive zipped using bzip2 must be given as the target.

The structure of the INF file is as follows:

<table>
<thead>
<tr>
<th>INFO, PART</th>
<th>Header informationen</th>
</tr>
</thead>
<tbody>
<tr>
<td>file=&quot;test.tar.bz2&quot;</td>
<td>Zipped tar archive</td>
</tr>
<tr>
<td>version=&quot;1&quot;</td>
<td>Version of the file</td>
</tr>
</tbody>
</table>

The files to be transferred must therefore be zipped in a tar archive which is then compressed using bzip2. This file is referenced in the INF file which is the target of the URL.

The tar archive can be created under Windows, e.g. with the open source program 7-Zip (www.7-zip.org (http://www.7-zip.org/ - http://www.7-zip.de)). This program also allows bzip2 compression. Under Linux, tar- and bz2- files can often be created using onboard resources.

The procedure makes it possible to replace the file(s) on the server with a new version which the thin client loads the next time it is booted. The version parameter in the INF file must be increased for this purpose.

Carrying out actions

Menu path: Setup > System > Firmware Customization > Custom Partition > Download

Once the custom partition has been mounted or unmounted, commands (Shellscript) can automatically be executed. For example, a program loaded to the partition can be launched or closed upon shutdown (the partition will be unmounted again in the process).
Example

A custom background image is to be used. The image named igel.jpg is zipped into the referenced test.tar.bz2 file using 7-Zip (see INF file above).

The INF file and the zipped archive are moved to an IGEL UMS web resource. This can be accessed from the thin client via HTTP.

Make the following settings in the UMS thin client configuration:

1. Enable Customr Partition (size e.g. 1 M) and have it mounted on /custom.
   Under Download, a new URL whose target is the test.inf file on the UMS server is created:
   http://[ums-server:9080]/webressource/test.inf

2. Enter the access data for the web server and enable Automatic Updates if the image is to be replaced later on.

3. Enter the following copy command as an initialization action in order to copy the unzipped image to the correct location:
   cp /custom/igel.jpg /usr/share/pixmaps/IGEL_UD_4x3_blue.jpg

4. Under User Interface > Screen > Desktop, select the entry Igel blue (4x3) as the background image.
   The associated file will be replaced by your own file.

5. Save your changes in the IGEL setup and restart the thin client so that it takes the modified settings from the UMS Server.
   The custom partition is created and mounted.
   The zipped file is transferred, unzipped and copied to the target directory.
   The new background image is loaded and displayed:
To replace this image with a new one:

1. Change the JPG in the test.tar.bz2 file.
2. Increase the version number in the test.inf file.

   The new version will be downloaded and used the next time you restart the client.

Executable files can also be loaded to the custom partition and called after mounting.

### 13.7.2. Custom Application

**Menu path:** Setup > System > Firmware Customization > Custom Application

Applications which were loaded onto a custom partition for example can be launched via the Application Launcher or an icon on the desktop once they have been defined as own applications. In order for this to be possible, a command to call up the application must be entered under Settings.

### 13.7.3. Custom Commands

**Menu path:** Setup > System > Firmware Configuration > Custom Commands

You can define custom commands for specific points in time when the system is starting. You can use configured environment variables (page 263) in the commands.

**Post Session**

**Menu path:** Setup > System > Firmware Configuration > Custom Commands > Post Session

For a specific session type, you can define an action that is performed when the last session of this type is ended.

- **Session type:** Session type for which the action is performed

  Possible values:
  - No Post Session Command
  - Citrix
  - Citrix StoreFront/XenApp Webportal
  - RDP
  - VMware Horizon
  - Browser
  - Java based (Webstart/Leostream Connect)
  - vWorkspace
  - NoMachine NX
  - Parallels Client
  - PowerTerm Terminal Emulation
  - ThinLinc
  - X Session
  - IBM iSeriesAccess
  - Media Player
- VNC Viewer

- Post Session Command: Action performed after the end of the session

Possible options:

- Logoff: The user is automatically logged off; a logon method must be defined for this purpose. Further information can be found under IGEL Smartcard (page 235), Active Directory / Kerberos (page 238) and Smartcard (page 240).

  The Logoff option cannot be used if the Appliance Mode is in use. Further information can be found under Appliance Mode (page 87).

- Shutdown/Suspend (System default action): The thin client will be shut down or placed in suspend mode depending on the setting under System > Power Options > Shutdown > Selection Default Action. A dialog allowing the user to cancel the procedure will be shown in the process. Further information can be found under Shutdown (page 252).

- Shutdown/Suspend mode (system default action without dialog): The thin client will be shut down or placed in suspend mode depending on the setting under System > Power Options > Shutdown > Selection Default Action. The user cannot cancel the procedure. Further information can be found under Shutdown (page 252).

- Reboot (with dialog time limit): The thin client will be shut down. A dialog allowing the user to cancel the procedure will be shown in the process.

- Reboot (without dialog): The thin client will be shut down. The user cannot cancel the procedure.

- Enter custom command here: Command to be executed

Base

Menu path: Setup > System > Firmware Configuration > Custom Commands > Basis

The commands defined here are executed on a one-off basis during the boot procedure. You can define commands for the execution times described below:

- Initialization
  - Not all drivers loaded, not all devices available
  - Network scripts not launched, network not available
  - Partitions available except firefox profile, scim data, ncp data, custom partition

- Before Session Configuration
  - Not all drivers loaded, not all devices available
  - Network scripts launched, network not available
  - Partitions available except firefox profile, scim data, ncp data, custom partition
  - Sessions not configured

- After Session Configuration
  - All drivers loaded, all devices available
  - Network available
  - Partitions available except custom partition
  - System daemons not launched (CUPS, ThinPrint etc.)
  - Sessions configured
  - UMS settings retrieved but not effective yet

- Final Initialization Command
  - All partitions available
  - All system daemons launched
  - UMS settings effective
Network

Menu path: Setup > System > Firmware Configuration > Custom Commands > Network

The commands defined here are executed each time that the relevant network interface (default: eth0) starts. The network interface can be selected with the $INTERFACE environment variables (eth0, eth1, wlan0). You can define commands for the execution times described below:

- **Network Initialization**
  - Network authentication successful (802.1x or WPA)
  - No further network settings used

- **After Network DNS**
  - Runs after each change in the IP address or host name
  - IP address / name server settings used (e.g. via DHCP)

- **Before Network Services**
  - IP address / name server settings used
  - VPN connected (if VPN autostart was enabled in the setup)
  - No network / host routing settings used

- **Final Network Command**
  - Network / host routing settings used
  - NFS and SMB drives available
  - System time synchronized with time server
  - UMS settings retrieved but not effective yet

Desktop

Menu path: Setup > System > Firmware Configuration > Custom Commands > Desktop Commands

The commands defined here are executed when the X server is launched. You can define commands for the execution times described below:

- **Desktop Initialization**
  - Runs once during the boot procedure
  - Desktop environment configured but not launched
  - User not logged on (Kerberos, smartcard etc.)

- **Before Desktop Start**
  - Runs once during the boot procedure
  - Desktop environment launched
  - Message service launched
  - Session D-Bus launched
  - User not logged on (Kerberos, smartcard etc.)

- **Final Desktop Command**
  - Runs after each user logon and desktop restart
  - User logged on (Kerberos, smartcard etc.)
  - User desktop launched
After Reconfiguration

Menu path: Setup > System > Firmware Configuration > Custom Commands > After Reconfiguration

The commands defined here are executed after settings relating to the local setup or the UMS have been changed. You can define commands for the execution time described below:

- After Reconfiguration
  - Runs after an effective change in the thin client settings (local setup, UMS)

13.7.4. Corporate design

Menu path: Setup > System > Firmware Customization > Corporate Design

In this area, settings allowing you to adapt the user interface to your corporate design are grouped together.

You can place your own logo in the following places:

- In the bootsplash (page 260)
- As a background image (page 261)
- As a screensaver (page 262)
- As a start button icon (page 262)
- As a company logo in the start menu (page 262)
- In the taskbar (page 185)

Custom bootsplash

Menu path: Setup > System > Firmware Customization > Corporate Design > Custom Bootsplash

With a bootsplash, you can show your company logo or a specific image during the boot procedure in order to hide the console output from the user.

Requirements: You need to provide an image file for your custom bootsplash on a download server.

Information regarding the image: The file types BMP, JPG, GIF, TIF, PNG and SVG are supported for a bootsplash. A total storage area of 25 MB is available for all user-specific images.

The image is 800 x 600 pixels in size (aspect ratio remains unchanged). It can be positioned vertically and horizontally by changing the position values.

To set up a custom bootsplash, proceed as follows:

1. Enable Custom Bootsplash.
2. Specify your download server.

If you have already defined a server for the system update files, you can use the same server settings for downloading the boot image.
3. Configure the following further settings:
   - Custom Bootsplash file: Give the name of the file that you want to display here.
   - Horizontal/Vertical Position of the bootsplash image: Give the horizontal and vertical position of the displayed image.
   - Horizontal/Vertical Position of the progress indicator: Give the horizontal and vertical position of the progress bar.
     0 means left-justified, 50 centered and 100 right-justified.

The user-specific bootsplash will be downloaded from the given server if you
• enable Custom Bootsplash - see Step 1
  or
• click on Bootsplash update if you previously assigned and saved another image during the setup
  or
• you execute a scheduled Job in the IGEL Universal Management Suite with the command Update Desktop Customization.

After changing the image file or any setting of an existing custom bootsplash, make sure to execute one of the above actions in order to update the bootsplash.

Background
Menu path: Setup > System > Firmware Customization > Corporate Design > Background
Decorate the desktop background with pre-defined IGEL backgrounds, a fill color or a color gradient, or define your own background image.

You can set up a separate background image for each monitor that is connected to the thin client.

Requirements: You need to provide your own background image on a download server.
Information regarding the image: The file types BMP, JPG, GIF, TIF, PNG and SVG are supported for a custom background image. A total storage area of 25 MB is available for all user-specific images.

To set up a custom background image, proceed as follows:
1. Go to Corporate Design > Background (1st Monitor):
2. Enable Custom Wallpaper Download.
3. Give a name for the background image file.
4. Go to Corporate Design > Background (1st Monitor) > Background Image Server.
5. Specify the download server.
   If you have already defined a server for the system update files, you can use the same server settings for downloading the background image.
6. Click on Wallpaper Update to download the user-specific background image from the given server.
Company logos

Menu path: Setup > System > Firmware Customization > Corporate Design > Company Logos

Other areas where you can show your company logo in the firmware are the screensaver and the start menu.

To define an image for the screensaver, proceed as follows:

1. Activate Enable Image display.
2. Under Image File/Directory, give the full path for an image file or a directory containing a number of image files.
   - If you enter a folder instead of a single image file as the source, all images in the folder will be displayed as a slide show, the display time for the images can be configured.
   - If you do not specify a file of your own, the IGEL logo will be used.
3. Enable One Image per Monitor if you would like to see the image (the images) on each individual monitor rather than one image across all monitors.
4. Specify the Image duration in seconds.
5. Select the Image display mode:
   - Small-sized hopping - small image that jumps across the screen
   - Medium-sized hopping - larger image that jumps across the screen
   - Full screen center cut out - image is displayed across whole screen, edges can be cut off.
   - Full screen letterbox - image is shown in full, with black edge where the format does not match that of the screen.

To define logos for the start menu, proceed as follows:

- Under Start Button Icon, give the file name of the logo with a full path in order to select your logo as a symbol for the start menu at the bottom left of the taskbar.
- Under Company logo in start menu, give the file name of the logo with a full path in order to display your company logo in the start menu window.
In order to see the company logo in the start menu window, you must set the start menu type to Advanced. To do this, click on User Interface > Desktop > Start Menu.

Figure 78: Start menu

13.7.5. Environment variables

Menu path: Setup > System > Firmware Customization > Environment Variables

Environment variables allow you to use dynamic parameter content for a number of session types, e.g. so as not to have to enter ICA or RDP servers for every session. Within the IGEL Setup, the variables can be found under: System→Firmware Configuration→Environment Variables

Predefined variables can also be supplied and distributed via the IGEL UMS. Additional defined variables can only be used locally and may be overwritten by a UMS configuration.

The environment variables are available in Custom Commands (page 257).

In addition, the following session parameters can be updated with variables:

- ICA - User name (ICA sessions→[Session name]→Logon)
- ICA - Citrix server or Published Application (ICA sessions→[Session name]→Server)
- XenApp - User name (Citrix XenApp/Program Neighborhood→Logon)
- RDP - User name (RDP sessions→[Session name]→Logon)
- RDP - Server (RDP sessions→[Session name]→Server)
Use in sessions

1. Enable environment variables under Enable variable substitution in session.
2. Specify the variable name and content (e.g. Variable Name = SERVER NAME | Value = test server)
3. Enter the variable name in the session parameter field. The name is preceded by a $ sign (e.g. $SERVERNAME)

In the case of RDP and ICA sessions, the setting is implemented after being saved and is entered into the session file. With XenApp, the setting is not implemented until a session starts and is running.

13.7.6. Features

Menu path: Setup > System > Firmware Customization > Features

Using this list of available services, you can quickly enable or disable firmware components such as Powerterm, Media Player etc.

If a service was disabled, the associated session type will no longer be available after a reboot. Existing sessions will not be shown but will not be deleted either.

See also the FAQ Disabling Features to reduce Firmware Size.
(http://edocs.igel.com/index.htm#10202437.htm)

A disabled session type will not be updated during a firmware update. You should therefore disable unused services in order to speed up update processes.

As of version 5.06.100 IGEL Linux offers hardware-accelerated multimedia playback. Up to and including IGEL Linux version 5.08.100 it is deactivated by default and can be activated in the Features list. You can find further information on hardware acceleration in an FAQ document (http://edocs.igel.com/#10201440.htm).
13.8. IGEL System Registry

Menu path: Setup > System > Registry

You can change virtually every firmware parameter in the Registry. You will find information on the individual items in the tool tips.

However, changes to the thin client configuration via the Registry should only be made by experienced administrators. Incorrect parameter settings can easily destroy the configuration and cause the system to crash. In cases like these, the only way to restore the thin client is to reset it to the factory defaults!

You can search for setup parameters within the IGEL Registry by clicking on the Parameter Search button. If you would like to find the FTP settings for updating the Linux firmware, you can search for the parameter name `ftp`. The parameter found in the Registry structure is highlighted:

![Parameter search in the IGEL Registry](image)

Figure 79: Parameter search in the IGEL Registry
K
Keyboard...........................................30, 58, 99, 194

L
LAN Interfaces ......................................204
Language.............................................189
Legacy ICA Sessions ..............................45
Legacy 'setup.ini' transfer.........................245
Leostream...........................................97
License................................................18
Local Logon ...........................................29, 56, 79
Local Resources .................................102
Local Terminal .................................146
Log off.............................................52
Logging.............................................246
Login Options..................................235
Logoff / Desktop Integration .................77
Logon...............................................46, 50
Look-up..........................................168
LPD - Line Printer Daemon ...................228

M
Mapping.............................................31, 59, 84
Media Player .......................................135
Media Player Global ..........................136
Media Player Sessions .........................138
Menus and symbol bars ......................131
Middleware......................................241
Mobile Broadband Network .........203
Monitor Calibration ............................166
Mouse..............................................195
Mouse and keyboard.........................84
Multimedia .....................................68, 81, 85

N
Native USB Redirection ..........................39, 64
NCP .................................................216
Netstat.............................................167
Network..........................................104, 203, 259
Network Drives .................................222
Network Information..........................18
Network Integration .........................21
Network Tools....................................166
NFS.............................................222
NFS Font Service................................202
NoMachine NX.................................99
Nuance channel for dictation.............36

O
On-Screen Keyboard............................163
OpenVPN ........................................215
Optimization..................................110, 114
Optionen.........................................95
Options 37, 48, 51, 54, 63, 85, 110, 113, 137, 138, 149, 155, 179, 191, 218

P
Pager..................................................187
Parallels Client .................................100
Parallels Client Global .........................99
Password..........................................234
Password Change...............................52
PDF viewer........................................135
Performance ......................................62, 82, 84
Performance and Options .................72
Phone Book........................................144
Ping....................................................167
Playback..............................136, 138
Post Session ....................................257
Power Options..................................176, 249
PowerTerm selection ..........................107
PowerTerm Terminal Emulation ............106
PowerTerm WebConnect .................106
PPTP .............................................215
Pre-defined configuration ..................73
Print ..................................................118
Printers ...........................................32, 60, 226
Printing.............................................128

IGEL Technology GmbH
Universal Desktop Linux v5
5.12.100
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>228</td>
</tr>
<tr>
<td>Test Smartcard</td>
<td>237</td>
</tr>
<tr>
<td>The IGEL Linux desktop</td>
<td>15</td>
</tr>
<tr>
<td>ThinLinc</td>
<td>108</td>
</tr>
<tr>
<td>ThinLinc Global</td>
<td>109</td>
</tr>
<tr>
<td>ThinLinc Sessions</td>
<td>111</td>
</tr>
<tr>
<td>ThinPrint</td>
<td>229</td>
</tr>
<tr>
<td>Time and Date</td>
<td>242</td>
</tr>
<tr>
<td>Touchpad</td>
<td>197</td>
</tr>
<tr>
<td>Touchpad Advanced</td>
<td>198</td>
</tr>
<tr>
<td>Touchpad General</td>
<td>197</td>
</tr>
<tr>
<td>Touchpad Scrolling</td>
<td>198</td>
</tr>
<tr>
<td>Touchscreen</td>
<td>195</td>
</tr>
<tr>
<td>Touchscreen Calibration</td>
<td>159</td>
</tr>
<tr>
<td>Traceroute</td>
<td>167</td>
</tr>
<tr>
<td>U</td>
<td></td>
</tr>
<tr>
<td>UMS Registration</td>
<td>158</td>
</tr>
<tr>
<td>Unified Communications</td>
<td>44</td>
</tr>
<tr>
<td>Universal MultiDisplay</td>
<td>180</td>
</tr>
<tr>
<td>Update</td>
<td>243</td>
</tr>
<tr>
<td>Upgrade License</td>
<td>171</td>
</tr>
<tr>
<td>USB access control</td>
<td>232</td>
</tr>
<tr>
<td>USB redirection</td>
<td>80</td>
</tr>
<tr>
<td>USB Storage Devices</td>
<td>230</td>
</tr>
<tr>
<td>User Account</td>
<td>142</td>
</tr>
<tr>
<td>User Interface</td>
<td>114, 175</td>
</tr>
<tr>
<td>User Page Permissions</td>
<td>147</td>
</tr>
<tr>
<td>Using</td>
<td>150, 157, 170</td>
</tr>
<tr>
<td>Using the Task Manager</td>
<td>160</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Verbindung</td>
<td>94</td>
</tr>
<tr>
<td>Verbose Boot</td>
<td>19</td>
</tr>
<tr>
<td>VERDE session</td>
<td>116</td>
</tr>
<tr>
<td>Via Browser</td>
<td>75</td>
</tr>
<tr>
<td>Video</td>
<td>137</td>
</tr>
<tr>
<td>Virtual Private Network - VPN</td>
<td>214</td>
</tr>
<tr>
<td>VMware Horizon</td>
<td>87</td>
</tr>
<tr>
<td>VNC Optimization</td>
<td>111, 114</td>
</tr>
<tr>
<td>VNC Viewer</td>
<td>116</td>
</tr>
<tr>
<td>VoIP Client</td>
<td>140</td>
</tr>
<tr>
<td>vWorkspace Client and AppPortal</td>
<td>86</td>
</tr>
<tr>
<td>W</td>
<td></td>
</tr>
<tr>
<td>Wake-on-LAN</td>
<td>207</td>
</tr>
<tr>
<td>Webcam Information</td>
<td>172</td>
</tr>
<tr>
<td>What is new in 5.13.100?</td>
<td>11</td>
</tr>
<tr>
<td>WiFi Configuration</td>
<td>217</td>
</tr>
<tr>
<td>Window</td>
<td>30, 46, 57, 71, 83, 109, 113, 136</td>
</tr>
<tr>
<td>Window settings</td>
<td>130</td>
</tr>
<tr>
<td>Windows Drive - SMB</td>
<td>223</td>
</tr>
<tr>
<td>Wireless</td>
<td>208</td>
</tr>
<tr>
<td>Wireless Manager</td>
<td>209</td>
</tr>
<tr>
<td>Wireless Regulatory Domain</td>
<td>214</td>
</tr>
<tr>
<td>X</td>
<td></td>
</tr>
<tr>
<td>X Session</td>
<td>99</td>
</tr>
<tr>
<td>XC Font Service</td>
<td>201</td>
</tr>
<tr>
<td>XDMCP</td>
<td>92</td>
</tr>
<tr>
<td>X-Server</td>
<td>21</td>
</tr>
</tbody>
</table>